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All the fancy GUIs aside, computers are still, primarily, tools for manipu-
lating text. Most current office and Internet usage is plain text-e-mail, Web
pages, chat sessions and documents. Text is no longer the primary way to

interact with a PC, but manipulating text is still the primary application for PCs.
The name ‘computer’ underscores its origin as a pure number crunching

machine. Computers would really become useful to those of us non-mathemati-
cally inclined when text-capture hardware, or keyboards, became a common and
affordable add-on. Keyboards, for all practical purposes, remain indispensable
‘human interface devices’. Humans are, of course, far more comfortable working
with visual and audible representations of information than with typing 
and reading. 

Now, two fundamental shifts are on the verge—images have an affordable,
convenient channel into the PC, thanks to the unstoppable rise of digital cameras.
Audio recording has been feasible for a while, but until recently, computers simply
didn’t have the muscle to transform and wield audio in any meaningful way. More
importantly, as communication devices proliferate, we are approaching the band-
width to move acceptable quality audio and video around almost as conveniently
as text—witness the explosive growth of Internet telephony combined with the
Web cam. 

We naturally interact better with audio and visual cues than with creating and
using text. As it becomes easier to channel audio, video and images through the
PC, it becomes imperative that we have the same level of control over it as we cur-
rently do over text.

When you have a terabyte of ‘folders’ filled with conversation, packaged com-
munications, presentations and video-mails on your 400 GB hard disk, how do
you find what you need, repurpose it for other people or situations, reformat it
and so on? Where is the Word for video documents? Laptops have audio/visual
recording capabilities. Why, for example, are minutes of meetings not recorded?
Where is the indexing service for spoken language? How do you find the meeting
note where your priorities were discussed?

Communicating out of such a repository is a challenge. Finding interlinks
between all that information is a challenge. Simply finding the bit you want out
of it is a challenge. Many of these challenges could be fixed by simply throwing
a bucketful of CPUs at them. We can’t find what we want instantly on our own
PCs, because running the software to do that imposes a resource overhead—and
that overhead we would currently classify only as luxury. 

Processing power needs to significantly outstrip what we have at hand today
before this digital age can be real, and it will. To paraphrase James Gosling, the
acknowledged father of the Java programming language, “If Moore’s Law holds
true, and you have a problem that will take current computers a 1,000 years to
solve, you might as well go away to a beach for 14 years, come back and solve the
problem in one year.”

Time to hit that beach.

sumod_hajela@jasubhai.com

“Many of
these
challenges
could be fixed
by simply
throwing a
bucketful of
CPUs at
them.”

Text to Speech?

Sumod Hajela
Assistant Editor
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marks and Newsletters.

Bookmarks contain sites on a particular
subject, along with a detailed description
of the sites.  This month, we bring you
some sites to keep track of live cricket
match scores.

The Newsletters section brings you a
collection of newsletters on different
topics each every month. This month
we have some newsletters that keep you
updated on breaking news from the
sports front.

So, if some light and interesting reading
is what you’re looking for, this is one sec-
tion you’d definitely want to browse.
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My Mix 1.0 will make smooth transit-
ing audio CDs
Team@Work Professional Edition 1.9
will help your team get organised
WhereIsIt? 3.58 will help you catalogue
your CD collection.

Mindware
MUST TRY SOFTWARE

A compilation of useful software across various categories and genres. Something
for everybody.
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your Windows installation

Playware

Look for these products on the CDs



Spam celebrated a decade
in April, and we thought

we’d tell you 10 things about
the 10-year old:
n The term ‘spam’ originated
in 1937, when Kenneth
Daigneau won $100 for
coming up with a name
to replace Hormel Foods’
canned meat-based
product, then known as
Hormel Spiced Ham.
n Laurence Canter and
Martha Siegel, a lawyer
pair, take the credit for
sending the first spam
mail in 1994, creating
what many call the
second biggest bane of
the Net, after child
pornography.
n The spam business is valued
at $20 billion (Rs 90,000
crore) per year.

n New York became the first
state in the USA to prosecute
a spammer with
imprisonment.
n The Nigerian spam e-mail
(people actually responded to

it), is believed to have
defrauded Internet users of up
to $19.8 million.
n The first national spam law
in US is called the Controlling

the Assault of Non-Solicited
Pornography and Marketing
Act (Can-Spam).
n The most popular spam
pitches include—Viagra, debt,
insurance rates, porn sites

and online degrees.
n There are numerous
estimates about how much
of all mail is spam, but
several estimates say that
one in six mails is.
n There is a 16,500 sq ft
Spam Museum in Austin,
Minnesota, US.
n Howard Carmack, a US-
based professional
spammer, sent more than
857 million messages last

year. He’s been found liable
for $16.4 million in
damages, along with charges
of criminal fraud in 
New York.

16 MAY 2004

Gmail
n What is it?
Gmail is Google’s free e-mail
offering. It’s not yet publically
available, but selected
customers have been given
accounts for testing and
reviewing purposes.

n How does it work?
When you use Gmail, the
text of your e-mails is read
by computers, and ads
relevant to the subject
matter are displayed with
your incoming mail. 

Google assures us that
no humans will read the e-
mail, and that nothing that
can identify, the sender or
the receiver, is given out to
the advertisers.

n What does it do?
Gmail gives an unbelievable
1,000 MB of space. Currently,
POP3 and automatic
forwarding are not offered. 

A sophisticated search
engine will help search within
archived e-mails. All e-mails
and replies are grouped as
conversations. 

Customers get a spam
filter, as well as mail filters. 

hypethesis

And if McDonald’s has its
way, maybe mayoan-

naise, tomato ketchup and a
little bit of Georgia coffee too
could suddenly find residence
in the crevices of your laptop’s
keyboard.

And so dear readers, join
your hands in welcoming Wi-
Fi connectivity at more than
3000 McDonald’s outlets across
the US by the end of the year,
a trend that we hope find its
way into Asia, and also India.

Wayport, an Austin (Texas)-
based company, has already
provided wireless access to 300

McDonalds outlets as part of a
pilot project. It will eventually
Wi-Fi all of the 10,000-odd Mac
outlets across USA.

McDonalds will charge
$2.95 (approx Rs 140) for two-
hour access, while regulars can
opt for a monthly plan priced

at $29.95 (approx Rs 1,350).
Of course, McDonald's is

not the first food chain to offer
Wi-Fi access. Last year, Star-
bucks Coffee added Wi-Fi to its
already bloated 45-kinds-of-
coffee-menu.

Our worry, though, is not
about McDonalds or Star-
bucks making enough money
out of renting Wi-Fi services,
or the resulting rise in burger
and coffee sales. Our worry is
how would the users keep the
laptop clean as they eat and
work simultaneously. 

Any ideas?

n VMWare to soon support the 64-bit editions of Windows XP and Linux  n 3Com opens up engineering design centre in Hyderabad

Waiter, there’s mustard on my
laptop…

RFID applications

deployed will increase

450% in 2005,

and a further 96%
in 2006

snapshot

Source: www.evansdata.com

Ü

Happy birthday, spam! 

Illustrations: Farzana Cooper
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20 Vulnerabilities in
Windows 
Microsoft has identified 20
new vulnerabilities across
various versions of Windows,
some of them highly critical.

Most of these can cause
execution of arbitrary code.
Apart from this, a weakness
in LDT—Local Descriptor
Table—and an error in
Virtual DOS Machine (VDM)
can be exploited to access
protected memory. 

In another vulnerability,
an attacker may send a
specially-crafted reply to
messages forwarded over
HTTP Proxy components, and
cause a Denial of Service.

Outlook Express, too, is
vulnerable. Outlook and
Internet Explorer can also be
used as attack vectors.
Microsoft Jet Database Engine
has also been found to have a
vulnerability that can be
exploited to execute arbitrary
code with the privileges of an
affected application.

Patches for are available
through Windows Update.

Another ActiveX
Vulnerability
When someone visits
www.pandasoftware.com for
online virus-scanning for the
first time, the Panda
ActiveScan Control gets
installed by Panda ActiveScan
on the user’s system. This
ActiveX control has a
boundary error in the
‘ReportHebrew’ object.
Following this, a heap
overflow can occur.

Exploitation of this can
allow execution of arbitrary
code on the user’s system.

The vulnerability has
been corrected by Panda
Software in an updated
version of this ActiveX
control.

redalert

Source: Nielsen/NetRatings and ITU

Total Cost of Ownership of computers in
mature and emerging markets

US Consumer satisfaction levels with portals

statattack

n SP2P service Morpheus parent company StreamCast Networks  offers subscription-based VoIP services, and hardware to make landlines into VoIP phones

Father of the
Web entangled
in a million
Euros 

Thirteen years after he created
the World Wide Web, Tim

Berners-Lee was awarded the
Millennium Technology Prize by
the Finnish Technology Awards
Foundation. 

Berners-Lee, voted as one of
the top 100 minds of the 20th

century by Time magazine, won
the 1 million Euros (Rs 5.3 crore)
award for devising a system to
organise, link and browse Net
pages—a development that revo-
lutionised the Internet.

Surprisingly, when Sir Tim
(he was knighted in 2003),
created the hypertext program,
he never commercialised his
work. Instead, he worked on
expanding the use of the Net as
a channel for free expression and
collaboration. 

Pardon the cliché, but the
rest is now history.

Sir Tim currently heads up
the World Wide Web Consor-
tium (W3C) at the Massachusetts
Institute of Technology in
Boston, where he is now based as
an academic.

Well, better late than never,
we say!

28: average 
number of items of
spyware in
one PC

snapshot

Source: www.theregister.co.uk

There was kingdom,
somewhere far away,

which had a troubled king. He
was increasingly nagged by a
suspicion that his country folk
were lacking in civic duty. To
put his mind to rest, he placed
a rock in the middle of their
mainstreet. Days passed by as
he watched citizens stumble
upon, jump over, swerved
from  and curse the wretched
stone (and the authorities).
Everyone thought someone
else would move the stone. 

Harvard’s Greg Barron and
Indiana University’s Eldad
Yechiam are in a similar state
of thought, after a study of
theirs showed that most online
requests get ignored because
everybody thought somebody
else would reply to them.

They have traced this
problem to what they call the
“volunteer dilemma”, because
of which response levels

decrease with an increasing
group size. The key, according
to the researchers, lies in
delegating the responsibility
to respond. They suggest
sending personalised e-mails
instead of multiple recipients. 

And in a result that may
not surprise many, the duo
also found out that requests
under a female name had a
significantly higher response
ratio, than those from men. 

It would seem that this
study would greatly help the
booming call centre and IT
helpdesks industry, which are
often inundated with e-mail
requests. But we have a
question: Have spammers
already perfected this art?

Incidentally, have you
ever had a bad experience
with IT helpdesks not
responding to your queries?
Send us your experiences at
noreply@thinkdigit.com.

I’ve got mail. Now what?

ÜSource: Forrester Research

Desktops

Laptops
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n  Nokia plans to  release the N-Gage QD which has a sleeker design and offers better gaming support n  Iomega releases Rev, a 35GB successor to the Jaz removable drive

The Truman Show is truly a
Peter Weir masterpiece. It

has Jim Carrey as the subject of
a never-ending movie on his
life where cameras follow his
every move, and all the people
around him—his friends, his
wife and the rest of the city—
are nothing but actors. The
movie was released in 1998,
and almost earned Carrey an
Oscar nomination.

We will never be able to tell
you whether the nameless wild
boar family on the Web site

www.wildtiere-live.de is ever
nominated for any recogni-
tion, but if popularity is any
indicator, then its 56 family
members—six grown-ups and
50 offspring—are nothing
short of superstars. Just two
weeks after the German Hunt-
ing Protection League
launched the Pig Brother Web
site, the porcine family has
attracted more than 1.5
million visitors, and over 400
guest book entries.

The site records each and

every moment of their lives
using a web cam in an enclo-
sure in their natural habitat of
the Eifel Mountains in western
Germany. 

We’re glad that the Internet
cannot transmit smell as yet!

And you thought the geeks
at the Massachusetts

Institute of Technology had
no heart! A team of
young, imagina-
tive scientists
have developed a
service that
would help you
find your ideal
partner if he or she
is somewhere in
your vicinity.

All you have to do is
subscribe to a service called

Serendipity,
which then
puts you in
the database
for mobile

phone dating.
The service
stores in their
phones, a

personal profile and
information on what they

want from a partner. 
If the people whose profiles

match are in the vicinity of
each other, the service prompts
their phones to communicate
with the other.

One problem: what
happens if there are multiple
matches? Now that would be
some position to be in! If you
believe mobile dating actually
works, write in to us at mobile-
cupid@thinkdigit.com.

heroes

Spam fighting
Spam received by
businesses has doubled
over the last two years.
Analysts say 32 per cent of
all e-mail sent per day in
North America in 2003 was
spam. The effect of spam is
measured in lost worker
productivity and wasted IT
resources, and comes to
millions of dollars annually
for larger organisations.

Sun Microsystems
Sun Microsystems’ woes
are compounding: a third-
quarter net loss of $760
million, and the laying off
of 9 per cent of its
workforce. There’s also the
fierce competition from
Dell and HP to reckon with.

zeroes

Linux
Steven Spielberg’s
DreamWorks Animation
will be using Linux for its
upcoming films—Shrek 2,
Shark Tale and Madagascar.
A thousand computers will
comprise the HP Utility
Rendering Service (URS),
which will be used for off-
site animation rendering
and remote collaboration.
The URS is based on HP
servers running Linux.

Broadband
One-third of all adult
Americans now have access
to high-speed Internet
connections. A UK ISP has
begun a new entry-level
ADSL service that costs the
same as many dial-up
services. 

British Telecom is
stretching the reach of its
current service, and will
start a 2 MB service later
this year.

Was it just another speech, or did Bill Gates
really mean it? It so happened that at the

recent Gartner Symposium Itxpo in San Diego,
the high priest of the IT world, Bill Gates III
predicted that in the next 10 years or so, hard-
ware prices will fall to the point where wide-
spread computing with speech and handwriting
won’t be limited by expensive technology.

If indeed this turns out to be true, it would
have far-reaching implications on the hardware
industry. Microsoft, already the world’s largest
software maker, is now also a big hardware
manufacturer, leading the way in tablet PCs and
SPOT watches. Gates is betting on the premise
that all devices in the future will be tablet-size.
Advances in programming will allow software
developers to create applications in less time,
using visual representations of the inner work-
ings of software, rather than writing lines of
programming code.

We think he should have a fair idea about
what he is talking, specially since his company
spends $6.8 billion (approx Rs 3,000 crore) a
year on research. 

We have an issue with his statement,
though. Leading lights have always promised
fall in prices, and that has actually happened,
but the digital divide is growing wider than
ever before. 

We see only one reason for this: when prices
fall for on product, it so happens that the rest
of the world moves to a new standard, and the
cheap product becomes obsolete. Take the
VCR, for instance. By the time it was affordable
to the masses, we had moved to VCDs, and by
the time VCD players were with in budget, in
came the DVD, and so on.

What are your views? Will the digital divide
ever be bridged, especially with hardware? Let
us know your opinion at billgates@thinkdigit.com.

… And hardware falls down!

Not at all bo(a)ring!

Stupid Cupid just went mobile
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ex.com battle finally ends; rightful owner paid undisclosed amount  n Creative's pulls back ad featuring a laptop used in a bathtub for fear of people electrocuting themselves

Trust Nokia to stretch the
boundaries of imagina-

tion. The Finnish telecom
giant has tied up with HP,
along with who they plan to
launch a Visual Radio service
later this year. 

Nokia will supply the
content, while HP will provide
computing equipment to store
the artist and title information
as well as promotional infor-
mation. The service may be
subscription based.  

Users of the service will be

able to view artists, songs, and
concerts. Nokia plans to sell
both high and low end
phones that will connect to
the Visual  Radio service, and
perhaps, at a later date, make
available the service to other
handset makers.

Well this reminds us of the
time when people asked those
with mobile phones for cricket
scores thinking they have a
radio they are hearing near
their ears. That age has just
come full circle.

Before you read the piece on
Radio Frequency IDentifi-

cation (see Beyond Barcodes,
Page 124), here is something
to start you off. 

Retail giant Wal-Mart, and
the US Defense Department
have mandated the usage of
RFID from their suppliers.
Incidentally, a recent Forrester
Research showed study

showed that RFID suppliers
may not be able to meet the
January 2005 mandate; Wal-
Mart though, refutes the
study. Analysts talk of lack of
clarity at implementation
levels, but many feel that
there are going to be rigorous
implementation trials over the
span of this year. We are wait-
ing for it to happen here, too!

It's radio and it's visual

RFID is coming 

XXX to be brown-
paper-bagged
If the US Federal Trade
Commission has its way, you
won’t be embarrassed the next
time you open a mail inviting
you to visit a porn site. Starting
May 19th, sexually explicit e-
mail will have to bear a label
reading "Sexually-Explicit:", and
the messages themselves cannot
contain graphic material.

This step is sure to reduce
cases of total embarrassment,
such as happen when you
inadvertently open porn 
spam just when your boss is
behind you.

Howard Carmack of Buffalo,
New York, also known as the
‘Buffalo Spammer’, became the
first spammer ever to be tried in
court. He’s been convicted on
charges of identity theft and
falsifying business records,
according to the New York State
Attorney General. He sent more
than 800 million messages using
Earthlink accounts.

EarthLink accused Carmack
of using e-mail accounts
belonging to other people, to
send out floods of spam that
advertised get-rich-quick
schemes, herbal stimulants and
cable TV descramblers.
Carmack will appear in court
on May 27, and faces three to
seven years in prison.

Could this precedent act as
a deterrent to spammers
world-wide?

Spam
Beware, Spammer
—the Law's here!

Ü

Friend, or foe? It would
seem ‘friend’, but that’s

what they said about the
British East India Company!
Amazon’s latest search service
A9 incorporates search results
from Google, and allows users
to search Amazon’s digital
database of published book
content. 

It works with a simple
premise, but as a technology,
it is highly complex, with
millions of algorithms
running in the background. 

Amazon’s business unit—
A9.com Inc of Palo Alto, Cali-
fornia—built the service that
remembers users’ searches,
and offers a toolbar that
allows them to make and save
notes on a Web page—much
like a reader might scribble in
the margins of a book. 

The service, located at
www.a9.com, also incorporates
lucrative paid-search adver-
tisements from Google,
which has been providing
search and advertising serv-
ices to Amazon for a little
over a year.

Web search is already a
cut-throat Internet business,
with dominant players such
as Google and Yahoo! now
being challenged by
Microsoft. With Amazon, we
believe, the slice just got a
little thinner.

In the Internet
rainforest,
search the
Amazon

Germans send

200 million
sms and e-mail mes-

sages a day

snapshot

Source: www.theregister.co.uk

So the paperless office is a
myth, after all. Sony Corp,

the world’s leading electronics
firm, and Toppan Printing Co
of Japan, have developed a
new optical disc made mostly
out of—hold your collective
breaths—paper!

In fact, the two companies

even claim that the disc will
be compatible with next-
generation DVD players, and
is capable of storing up to five

times more information than
current discs, thanks to blue-
laser DVD—a technology
expected to replace current
red-laser DVD players soon. 

The paper disc is based on a
technology called Blu-Ray, and
is supported by a consortium
of electronics makers, includ-

ing Sony, Matsushita
Elec-

tric,
and the

Dutch firm, Philips. 
In which case, will copy-

ing on discs now be called
paper recycling?

And now, bits on paper 

For every US$1
spent on offshore

jobs, the US
economy gets

back $1.12

snapshot

Source: www.theregister.co.uk
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“Despite assertions
made by Linux
vendors, a Linux
cluster is not a high
performance
computer. At best,
clusters are a loose
collection of
unmanaged,
individual,
microprocessor-
based computers”

Dr Paul Terry, CTO, Cray
Canada, at the ClusterWorld
Conference & Expo 2004, at
San Jose, California, USA. 

“…That was just
poor wording on
our part…stuff
that's on tapes, and
those are offline –
we’d eventually
delete it, but we
can't guarantee an
instantaneous
deletion.” 

Google co-founder Sergey
Brin in eWeek, referring to
fears about Gmail, Google's
1000 MB free email service,
where deleted emails would
remain archived on servers. 

“I doubt you’d see
them settle any
frivolous lawsuits,
but it looks
inevitable that there
will be more suits
based on the
position of Windows
in the market” 

Richard Donovan, chairman,
Antitrust unit, Kelley Drye &
Warren, a US law firm.
Microsoft had agreed to a
presettlement in an antitrust
suit regarding overcharging
for for Windows and Office

quoteworthy

Xerox, the company
whose research labs gave

us the computer mouse, is
now working on the future of
silicon-based transistors—and
their vision of the future isn’t
silicon, but plastics. 

US-based TDA research has
come up with something
similar—they’re looking at
conductive polymers. Both
systems work with technol-
ogy that has, up until now,
seemed impractical, but have
come up with workable solu-
tions that could be used in,
say, low-quality displays.

The Xerox project works
using a molecule that can be
used as a semiconductor, and
remains stable under normal
conditions. Once printed into
place, the molecules can
orient themselves into the
bigger structure. Xerox has
also developed two other
molecules: one that acts as a
metal-like conductor, and
another that acts as a dielec-

tric. These form the basic parts
of semiconductors, and can be
used to make printable chips.

Xerox’s PARC been work-
ing on an electronic array that
can be used as the back-pane
for a display, and the plastic
semi-conductors could be
integrated for low-perform-
ance displays.

TDA’s solution works on a
polymer called Pedot. Pedot
can act as a conductor, but
gets corrupted by water. TDA
re-engineered this by adding
two more molecules, and calls
this Oligotron. TDA also
created a solvent bath that lets
users work with the material.
The resultant material could
be used to make soda bottles
that talk straight to inventory
management devices.

It’s a big market for non-
silicon low-cost solutions,
and both Xerox and TDA  are
working towards getting
their plastics and polymers to
edge out silicon.

Beyond Silicon: Plastic

The Red Hat Indian Open
has just been declared

open, and the prize money is
Rs 10 lakh. Jointly sponsored
by Open Source leader Red Hat,
and IIT Bombay’s Kanwal
Rekhi School of Information
Technology (KReSIT), April
marks the start of the Red Hat
scholarship programme.

Evangelised by KReSIT’s
Prof. Deepak Phatak, the
scholarship will try to attract
the programming prowess of
engineering students across
India. The Indian Institute of
Information Technology
Bangalore’s Prof S Sadagopan
is also involved in it. 

If you want to win Rs 10
lakh, you will have to create
“world-class” applications in
Open Source that will benefit
the team at large. These will be
judged by a team of experts
from KReSIT, IIT Bombay. Red
Hat and Prof Phatak, mean-
while, say that all the code
submitted would have to be
covered by the GPL, LGPL or
BSD licenses.

Red Hat India will then
fund the winning team to the
tune of Rs 10 lakh. A team of
mentors from the software
industry will guide the
students, and the participants
will be offered internships at
Red Hat. 

Wanna be an
Open Source
lakhpati? Open your eyes wide. Really

wide. OK, now we will first
give the background..kkrieger is
a first person shooter game,
complete with all the effects
you’d expect. 

There are guns, monsters
with detail, different levels, the
works. When you fire at the
monsters, the weapons light up
your enemies to reveal more
details. There are shadows, and
your ammunition even
bounces off floors.  

Now comes the time to
pop your eyes out as you read
this: the size of the game is 96
KB. Not 96 MB, 96 KB!

Surely, then, there is a
catch? Yes, you got that right.

There are two, in fact. 
Firstly, the beta version

crashes, there are clipping and
collision problems. Second—
and listen closely—you need
the at least the following: 512
MB of RAM, a 1.5 GHz Pentium
3 or Athlon, a Geforce4Ti or
ATI  Radeon8500 graphics card
supporting pixel shaders 1.3,
preferably with 128 MB of
VRAM and DirectX 9.0b.

So what do you think?
How come a 96 KB game
shows all these effects, and
why is it so demanding on
system resources? If you can
figure out how exactly
.kkrieger does it, write in to
smallgame@thinkdigit.com.

How small can you get?

n Cisco fixes security holes arising from vulnerabilities in LEAP (Lightweight Extensible Authentication Protocol), in their wireless networking products centre

One in six US

Internet users have

logged on using Wi-
Fi or another

wireless
technology

snapshot

Source: www.washingtonpost.com

tomorrow’s technology
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Your vote counts
This month’s question...
Google has announced a 1 GB free mailbox. Who among the fol-
lowing biggies, if they offer a free 1 GB mailbox, would you pre-
fer the most?
¨ Hotmail ¨ Yahoo! ¨ GMail
¨Rediffmail¨ Indiatimes

Log on to www.thinkdigit.com and vote

I own a
DVD-ROM    

49.7%

42.6

I plan to buy a
DVD/DVD-R soon 

What's the
point? I'll never

buy one

Responses: 7046

Dear Himadri,
Thank you for your kind words. They keep us moti-
vated. Maybe we can time other products too so that
the articles are published just in time for you to buy.

Dear Ketan,
We hope it does not come to that, but your sentiments are
echoed by thousands of Indians across the world. Maybe
Americans should now stop complaining of outsourcing and
actually do what they do best—innovate.

Dear K S V Menon
Rest assured, we do not have a genius of the likes of Bill Gates
with us. At least he is not visible to us right now. 

We will be happy, however, to be proved wrong, as so many
people have been in history.

pulse n
n letters

How DVD 
savvy are you?

Dear Ashish,
We have sent you the e-mail ID of
the reader from Patna who, we are
sure, would love to see that mail.

1.3%
I own a DVD-writer 

6.3%

ILLUSTRATIONS: Farzana Cooper
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E-mail: readersletters@jasubhai.com
Send your letters marked ‘Readers Letters’ to the Digit office: 

D-222/2, Om Sagar Building, MIDC, TTC Industrial Estate,  Nerul, Navi Mumbai 400 706 
Phone: 022-27629191/9200  Fax: 022-27629224

n The price for the Canon
i225 was mentioned as Rs
3,995 in the Scoreboard on
page 53. The correct price
is Rs 4,500, after taxes. 
n The picture of the
graphics card in the A-List
on page 76 should have
been the Ennyah GeForce
FX 5700, instead of the
Compro card shown.
n The Ennyah GeForce FX
5700 was also the cause of
a Expensive-Cheap
confusion. As a value
performer in the A-list, the
card is expensive. But
compared for pure
performance with other
cards in that range, it’s cost
is justified.

Notice any goof-ups? 
Write to goof@jasubhai.com

Dear Prof Panickar
We loved your idea. We hope adventure
enthusiasts actually use it, and god forbid if
some calamity strikes, they can saved
thanks to the information on the USB stick! 

Deep
Joined:
23 Jan 2004
Posts: 341
Location:
Mumbai, India 

Dexter 
Joined:
24 Dec 2003
Posts: 317
Location:
Mumbai, India

Yes, I haven’t made any mistake here... it’s 1 GB and that too FREE. I think this
shall answer the questions asked before regarding Bigger free mail storage 
Quote:  
"Google plans to use its search technology and a large amount of data storage to
launch a free e-mail service that lets customers keep about 1GB of messages, the
Internet search giant announced Wednesday." 
Website : www.GMail.com
This is super HOT… amazing.

That’s an April Fools Day prank. I don't think Google is offering 1 GB... In fact,
hours after Google’s press release, came the news that Microsoft was gonna
give 1 TB of free space. Why? Because it’s 1,000 times more than Google!

OK, so there’s a correction: Gmail is not an April Fools Day prank. Actually I
learnt about it right after I posted it here, but it seems that actual prank that
Google pulled off was that it was offering a job on the moon...

Posted: Mon Mar 15, 2004 3:06 pm  Post Subject: GMail

Posted: Wed Mar 17, 2004 10:03 am  Post Subject: 

Posted: Wed Mar 17, 2004 10:03 am  Post Subject: 

Dear Praveen, 
You have touched upon several pertinent points. It is surprising the
company’s service engineer could not aid you with the install. Yes, companies must
make the effort to train their engineers on Linux, and also offer users the necessary
skills to get started on the Linux desktop. It’s also sad to note that for a quality
product such as Linux, software support outside of the distribution is severely
limited to a few applications, and updates and patches on magazine CDs.

The Winner of the ‘Post your best Planet Digit Experience’ contest is...
Goof Ups

Dexter 
Joined:
24 Dec 2003
Posts: 317
Location:
Mumbai, India

MAY 2004
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UUppggrraaddee  ffrroomm  BBrrooaaddbbaanndd
ttoo  DDiiaall--uupp

India was
probably the
only country
where
downloading
pirated MP3s
was more
expensive than
buying the
original CD”

“
VIPUL SHAH 

Vipul Shah is a chartered accountant who writes and consults on Internet, e-commerce, banking and finance tech-
nologies. He can be reached at digit@vipulshah.com

Pre-1995, the Internet was not offi-
cially available to most mortals in
India. You’d have to cheat your way

through NCST disguised as a Unix student,
and get access to their HP-9000 connected
to the Internet.

VSNL made the Internet available in 1995
via the UNIX shell, and later on, in 1996
through TCP/IP dial-up accounts, operating
at 9,600 bps. Up until 1999, we used dial-up
Internet, operating at 56 Kbps. The cost was
exorbitant: the phone call charges, coupled
with the ISP’s charges, made for Rs 30 per
hour of Internet usage. 

In 2000, Internet access via cable
modem, became available through the local
cable mafia. These services proved popular:
33 Kbps always-on unlimited Net usage for
about Rs 300 per month, and 64 Kbps for
Rs 900. The service was not perfect, and
there were downtimes; but this was, any
day, better than the phone bills that ran
into thousands.

The year 2002 saw such corporate
national ISPs as Hathway and Sify emerge as
major broadband providers. Sify started
branding and managing cable-owned ISP
operations. Cable operators became resellers
for these ISPs, and the ISPs got the go-ahead
from the cable mafia to operate in their areas.

And then, suddenly, they informed you
of the good news: instead of paying a flat
monthly rate, you’d pay for only what you
use—and that would be like Rs 2 or 3 per MB
of data transfer.

People now began using their always-on
broadband connections very carefully, to just
read e-mail or news, and avoided all band-
width-hungry applications—contrary to the
concept of broadband.

Since the only alternative was very expen-
sive dial-up, this Rs 2-3 per MB racket con-
tinued until late 2003. India was probably
the only country where downloading pirated
MP3s was more expensive than buying the
original CD: a 72-minute MP3 file download
would cost in the region of Rs 170, whereas
the original CD sells for much less.

Then, out of nowhere, MTNL (Mumbai)
announced phone lines for Rs 500 per month

for unlimited calls to any ISP. If you used
Rolta’s unlimited plan, it would cost Rs 500
for the MTNL line, plus Rs 170 for the Rolta
plan, totalling Rs 670 a month for a 24-hour
56 Kbps connection. Compare this with Sify’s
best offer of Rs 999 per month for 32 Kbps
unlimited; Or you could opt for Sify’s 128
Kbps packages, where it’s still more than Rs
2 per MB of usage. Looks like it’s time for
people to abandon their ‘Broadband 32 kbps’
connection, and upgrade to 56 Kbps dial-up.

When I spoke to Sify for this column,
the response I got was, "Sify’s focus is pro-
viding broadband services at 64 kbps and
above. Sify’s rate of Rs 2 to Rs 3 per MB is
appropriate given the quality of service and
user experience."

Broadband ISPs in India have their prob-
lems. They don’t like the cable mafia through
whom they operate, but they don’t have a
choice. The government has been sitting over
proposals to open up phone lines for DSL to
ISPs like it is all over the world. And that
leaves cable as the only viable mode of deliv-
ering bandwidth to residences. International
connectivity for these ISPs is still a duopoly,
which keeps bandwidth prices many times
what it costs in other Asian countries. Peering
of traffic by national exchange is strongly
resisted by the largest ISPs, and so data from
one Indian ISP to another usually travels via
the USA or Europe. 

India is the only country where cable
monopolies are created and encouraged
because of government inaction. As the
world moves from dial-up to cable internet,
the exact opposite is happening in India.
Every minister in this country takes a keen
interest in changing or manipulating the
voice traffic infrastructure, but data traffic
infrastructure has received step-motherly
treatment from the government and
from TRAI (Telecom Regulatory Authority
of India)

In the US, AOL executives have spent
years of sleepless nights over the erosion of
their dial-up connectivity market share to
the competition—cable internet. No such
fear in India.

Did I hear someone say “India Shining”?
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Michael Eisner, the celebrated CEO of Walt
Disney Inc, may be in trouble these days
with his shareholders, but his record is

impeccable. He made his company from a faltering
legend, to a dominating entertainment giant, more
than quadrupled revenues and profits, and brought
the magic back in the Disney name.

One of his revolutionary moves was, however,
not related to his money-making ability. It was coin-
ing a different name for the immensely-talented
people at Disney—Imagineers.

It will not be incorrect to call Mumbai-based
Vivekananda Education Society’s Institute of Technol-
ogy-trained Tejas Shah, Jyotsna Rathore, Sailesh
Ganesh and Abhijeet Akhawe imagineers. They are
the only four to represent India at the world finals of
the Microsoft Imagine Cup this July in São Paulo,
Brazil—an annual competition where college students
from all over the world display their .NET applications
to vie for the top prize—$ 25,000 (Rs 11,25,000).

For the national finals in Bangalore last month,
the quartet came up with Gurukul, an e-learning
application that aims to “simplify lives of students”. 

Just a couple of months before they embark
on a tour that could make their career, Digit met
up with the Geek4 at the holiest of all college envi-
ronments—the canteen. Excerpts from a free-
wheeling interview:

n So how did Geek4 form?
Tejas: Abhijeet and I had participated in last year’s
Imagine Cup; we were the runners up in
Barcelona, Spain. (Smiles) We thought people

might be bored of seeing the same faces, so we
roped in Jyotsna and Sailesh.
Sailesh: I was interested the moment I heard
Brazil!

n What is Gurukul all about?
Jyotsna: Gurukul is a sort of virtual university—an
interface between students, teachers, industry and
universities. It tries to simplify the lives of students.
Tejas: You could access your university sitting in a
cyber café, talk to professors and students, and find
mentors. It’s the right place to clear doubts.

n What differentiates Gurukul from other 
e-learning software?
Jyotsna: Gurukul has some good features; search,
for instance. The Idea Search prompts a user to
look for more than the usual. For instance, a stu-
dent interested in a diode might be interested in
transmitters, too. It’s smart enough to pick up on
behaviour, and provide results accordingly… it’s a
wrapper around the sort of search technology that
Google uses. 
Tejas: Other features include workspaces for stu-
dents and tutors. The spaces allow students to work
on their projects, chat for reference, and also seek
guidance from lecturers or the industry. Another
feature is mentoring. A student can approach any
industry professional or an academic who could be
the mentor.
Abhijeet: The application will bridge the gap
between what is taught in institutions and what
the real industry is all about.

Let’s say you would like to have access to cer-
tain hardware, such as the upcoming (Intel) Tejas
architecture. With the terminal services feature built
into Gurukul, students can log into the remote
machine and access it.
Sailesh: There is also localisation in addition to its
bilingual nature. Since equal importance is
given to both Hindi and English, it has the
potential of mass reach.

Gurukul will allow students to refer to e-books
within the portal. Our application supports the
tablet interface too.

n E-books? Won’t that create copyright
issues?
Tejas: Microsoft is working on Digital Rights
Management (DRM) controls for distribution
of e-books. The (legally available) e-books that
we have within Gurukul, allow the user to
highlight, add comments, and annotate all over.
There are copies of the textbooks always available
for reference. 

Imagine, all the coders

The appli-
cation will
bridge  the gap
between what
is taught in insti-
tutions and
what the real
industry is all
about

“

Ü

The Geek4: (left to right) Tejas Shah, Sailesh Ganesh, Abhijeet Akhawe and Jyotsna
Rathore, when we caught up with them on their college campus in April 2004
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n Did your lecturers, or anyone from
Microsoft, help you?
(All laugh) Jyotsna: This year, the college gave
us 17 days of attendance, and that was the
biggest help!
Abhijeet: Well, the lecturers could not help us
much in this regard. The syllabus covers C and C++,
and I guess we needed much more than that!
Tejas: Hardware! The college lent us an O2 XDA!
Microsoft was helpful too.

Last year, Homi Bhadra (a software architect
with Microsoft) mentored us. We have been in
touch with him over the past year, and this year we
continue to seek his guidance.

n Who does what in Geek4?
Jyotsna: Abhijeet and Tejas are the core coders.
Tejas: Sailesh and Jyotsna worked on the
presentation.

n Surely there were some hurdles?
Tejas: Administrative! (They all smile) Last year, we
informed the college pretty late and had to run
around a bit to get the paperwork in place. Oh
yes, they confiscated my cell phone too! (He still
hasn’t got it back!)
Jyotsna: The entire project took shape at Sailesh’s
home.
Abhijeet: Thanks to Sailesh’s folks, we got the
whole place to ourselves.
Jyotsna: And I was allowed to come home by 10
pm or later!

n How were you judged?
Tejas: We are marked on five parameters—smart-
ness, innovation, commercial value, social respon-
sibility and presentation.

n How were the Bangalore finals?
Jyotsna: We won on the smartness and innova-
tive quotient, but not before Tejas’ laptop
crashed.
Tejas: (Laughing away) Have you ever heard of
a Pentium 4 laptop with 512 MB of RAM crash-
ing? This one did! 

n How were you guys rewarded?
Tejas: We all won pocket PCs. Microsoft has
promised to give us Longhorn when it is
launched!
Sailesh: Microsoft gave us licensed copies 
of their operating system, Visual Studio, Office...
all of that! We have no pirated copies of any 
software!

nSo what’s the agenda for Brazil? Any more
tweaking or fine-tuning?
Tejas: We have to refine our Idea Search and
make it customisable. A mouse for a medical stu-
dent and a computer professional would hold dif-
ferent meanings. There are some really good
teams and this time, we have to win, or come
back and face a thrashing! 

n What else will happen at Brazil?
Abhijeet: Well, the competition is going to be
held at São Paulo…
Tejas: …which is just 200-odd Km away from
Rio…
Sailesh: Oh yes, Brazil, Rio…

n Post-Brazil, what do you plan to do?
Tejas: We’ve all got jobs…

n And the big picture…what do you folks
have in mind?
Abhijeet: Coding… 
Tejas: Coding, of course…Longhorn!
Jyotsna: Thinking about taking an MBA…
Sailesh: Well, not thought too much…love
maths, thinking of studying that.

n Open Source, anyone?
Abhijeet: No particular preference, I am com-
fortable with anything.
Jyotsna: Ditto.
Tejas: Closed source. I was (emphasises on ‘was’)
playing around a bit with Linux, but now its .NET.
So yes, totally closed source.
Sailesh: Same here.

n Why closed source?
Tejas: I get to hide my bugs!

APARNA KRISHNAKUMAR

aparna_krishnakumar@thinkdigit.com

SRINIVASAN RAMAKRISHNAN

srinivasan_ramakrishnan@thinkdigit.com

... we have
to win, or come
back and face a
thrashing!
“
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The terms
A nanometre is a billionth of a
metre—about five atoms wide. Nan-
otechnology brings together physics,
chemistry, electronics, computer sci-
ence and biotechnology. It refers to
the technology that designs and fabri-
cates nanosytems—systems on the
nanoscale, that is, on a scale of
nanometres. A nanocomputer is one
that uses components only a few
nanometres large.

How do you build a nanocomputer?
There are four differ-
ent approaches to
building them. The
first is electronic:
Keep shrinking tran-
sistors, and then do
something different
when they reach the nanoscale.

The second employs quantum physics:
A desktop quan-
tum computer
would be millions of times faster than your desktop,
and might even operate in other universes. The third
approach is mechanical—imagine tiny gears, tiny
robotic arms and so forth, floating around, doing
computations and other things. 

The fourth kind is the weirdest: The cells in your
body are probably doing some computing to stay alive,

so someone thought of using cellular material to build
a computer.

Gray Goo
“Gray goo: n. A hypothetical substance composed of large numbers of sub-micron-sized, self-replicating robots

programmed to make copies of themselves out of whatever is available. The image that goes with the term is
that of the Earth’s entire biosphere being eventually converted to robot goo. This is the simplest of the nan-
otechnology disaster scenarios ...” (from ‘The Jargon Dictionary,’ http://info.astrian.net/jargon/)

After some scientists began looking seriously at the idea of building nanobots that would manipulate
nanothings, Sun co-founder, Bill Joy, came up with this: “An immediate consequence of the … bargain in
obtaining the great power of nanotechnology is that we run a grave risk—
the risk that we might destroy the biosphere on which all life depends.” Joy
also said that left unchecked, self-replicating molecular machines could
endlessly copy themselves, engulfing the globe in a nanotechnological
‘gray goo.’

Gray goo has been a worry to some peo-
ple. Doomsday theories about nanobots are

rife. But D-day apart, there are scientists
who believe that nanobots can’t ever be

built. Some, such as Caltech physicist
Stephen Quake, simply dismiss nanobots

as science fiction. Others quote quantum
mechanical principles to prove that we
can never have control at the atomic
level. However, the strongest argument

against the possibility of nanobots comes
from Richard Smalley, a Nobel prize-win-

ning chemist. In 1999, he was a proponent
of nanotechnology, but in 2001, he wrote in
an article in Scientific American that such control
would not be possible.

Inventions such as the DNA hand at LMU (see
‘Recent Developments’) will heat up the debate.
Remember, the DNA hand, according to its creators,

will be capable of building nanothings a couple of
years from now!
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DNA computing
DNA molecules can compute, as Dr Leonard Adleman,
theoretical computer scientist and professor of computer
science and molecular biology at University of Southern
California, discovered in 1994. His experiment involved

finding the answer to a graph theory problem: The
vertices of the graph were encoded as DNA

sequences in a test tube, and massively parallel
bio-chemical reactions resulted in  combina-
tions of these sequences. These combina-

tions translated to the huge number of
paths through the graph. The problem was

to find a particular, ‘correct’ path. 
Adleman was actually able to find it, by

decoding the resulting sequences according to the
laws of biochemistry. The DNA strands had

behaved like a parallel-processing computer.
Research expanded the scope of DNA

computers to a broad class of problems. The
strands in a DNA molecule are much more

densely packed than the processing units in a
regular computer. In fact, one millilitre of DNA

can theoretically perform 1022 operations per
second. And that’s where the potential of DNA
computing lies—massive parallelism. 

Here’s how it works: In a living cell, DNA is operated
upon by enzymes that are made up of pro-

teins that ‘understand’
DNA. These proteins

can operate on
DNA—cut a
strand away,
make a copy,

paste a strand
somewhere else, and

so on. The trick is to manipulate
these operations. So, just as regular computers or calcula-
tors add, subtract and so on, DNA computers have their
own set of operations—cutting, copying, etc. Thousands
of these operations occur at the same time in a test tube,

and so the computation is massively parallel.
Here’s Artificial Intelligence from

natural resources: Dr David Stenger
of the US Naval Research Laboratory,

and Dr James Hickman of Science Appli-
cations International Cor-
poration, are linking
actual, living neurons
into a bio-electronic computer. 

Drs Stenger and Hickman believe
that this bio-electronic mutant

might solve pattern-recognition
problems. Humans are good at
pattern recognition, and it’s their

neurons that do the job—
so why not get them to
do something on their
own?

Recent, incredible
developments
Nanodroplets: Researchers from
the University of Texas M.D.
Anderson Cancer Center
created a programmable

bio-chip that uses
an array of electrodes to place water droplets on a surface, insert

substances into them, and move and merge them as well.
That doesn’t sound great, but the ‘droplets’ can be 0.5

to 65 ‘nano’litres in volume. Applications are chemical
and biological: The droplets can serve as carriers for
cells, genes, and viruses.

Molecular Logic Gates: Researchers from the
French National Center for Scientific Research

(CNRS) and University College, London, devised a
scheme to design logic circuits within individual

molecules. It includes connecting a pair of
benzene molecules to two gold electrodes,
and the setup would be a real logic gate

comprising two inputs and an output.
The 1s and 0s here would be

the rotational positions of the
nitrogen and oxygen atoms in the

benzene molecule.
Timeframe: 10 years

Magnetic
Tweezers: Scientists

at National Institute of
Standards and Technology,

based in Gaithersburg,
Maryland, have demonstrat-
ed magnetic tweezers that

can stretch, twist and uncoil
individual bio-molecules such

as strands of DNA. These work in
conjunction with a special microscope.

Imagine what manipulating individual molecules can do for bio-
medical and forensic research!

The DNA Hand: In March this year, researchers from
Ludwig Maximilians University (LMU) in Germany
built a DNA molecular machine that binds to, and
releases, single molecules of a specific type of pro-

tein. The DNA ‘hand’ can be made to select one of
many types of protein, and at some point later on, be

used to construct materials or machines, molecule by
molecule. According to these researchers, the hand can

be used in simple nano-construction applications in two
to five years. This is reminiscent of the nanobots sce-

nario—see the next section, ‘Nanobots’—auto-
mated building of things molecule by mole-
cule. Trust German engineering!

Experience is the best teacher, but not in technology, until
recently. Find out how a 250-year-old theorem is being employed

in today's systems to make use of the knowledge of the past
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Nanobots
Nobel prize-winning physicist Richard Feynman said in 1959,
“The principles of physics, as far as I can see, do not speak
against the possibility of manoeuvring things atom by atom.”
This is essentially the principle behind molecular robotics, or
molecular nanotechnology, which might ultimately produce
nanobots. Dr Ralph Merkle, one of the pioneers of nanotech-
nology, says that the engineering we do today—grinding

objects, or building bicycles, or even lithogra-
phy, is like trying to build something out

of LEGO blocks with boxing gloves on.
“Yes, you can push the LEGO blocks into

great heaps and pile them
up, but you can’t really snap
them together the way you’d
like.” With nanotechnology, he says, we will be able to fabri-
cate “an entire new generation of products that are cleaner,
stronger, lighter and more precise.” Molecular nano aims at no
less than controlling the assimilation of things—computing
machines, robots, or whatever—atom by atom. Here is where
nanobots come in—if someone or something has to fabricate a
device at the atomic level, it would have to be something really
small, something measurable in nanometres. Also, it would be
essential for fabricated devices to self-replicate to keep costs
down: The nanobot will manufacture one device, which will
self-replicate as many times as one wanted it to, thereby creat-
ing a collection of those devices. Here’s where the gray goo
comes in.

Merkle, along with Eric Drexler—the author and
researcher who pioneered the field of nanotech—envisioned a
long time ago that a mechanical nanocomputer would oper-
ate somewhat like a vastly scaled down and programmable
version of a mechanical calculator. But why do we need
nanomanufacturing? What would its impact on the comput-
ing industry be? Smaller, faster computers, of course. Merkle
says that molecular manufacturing “should let us make com-
puters at a manufacturing cost that’s less than a dollar per
pound, operating at frequencies of tens of gigahertz or more,
with linear dimensions for a single device of roughly 10
nanometres, high reliability, …”

The mechanical approach to nanocomputing has been
severely criticized by many. It also happens to be reminiscent of
Charles Babbage’s famous Analytical Engine, which many call
the first computer.

Today’s transistors
Today’s computers represent, and manipulate, 1s and 0s using
physical devices measured in microns. (So we’re still in the
‘microworld’, as opposed to the ‘nanoworld’) These devices are
transistors, and the trick involved in shrinking computers has
been, mostly, to make transistors smaller and smaller, and pack
them more closely together. 

What is fundamental and useful about transistors is the fact
that they can be put in one of two states—a ‘0’ or a ‘1’. Most
transistors used in modern computers are MOSFETs—a MOSFET
is basically like a gate that’s either open or closed. See figure
below: when no volt-
age is applied to the
gate (in green), elec-
trons do not flow
between the two ‘N’
regions, there’s no
current, and the tran-
sistor is ‘off’—repre-
senting a 0. 

When a voltage is
applied to the gate,
the ‘electron carriers’
in the ‘P’ region allow
a current to flow
between the two ‘N’
regions, and the
MOSFET 
is ‘on’—representing
a 1.

The MOSFET
keeps getting smaller over the years, but there’s a limit on how
small it can get for this mechanism to work. Three things—ther-
mal voltage, heat and tunnelling—impose these limitations. Ther-
mal voltage refers to the voltage that’s around us all the time—
25mV at room temperature, to be precise. As the transistor gets
smaller, this thermal voltage effectively acts at a shorter distance,
resulting in an increased electric field. When the electric field
becomes high enough, the transistor can suffer an avalanche
breakdown—a huge surge of electrons that cannot be controlled.
And once that happens, the transistor goes kaput.

The second limitation on the transistor size is heat dissipa-
tion—that’s what you use heat sinks for. The smaller the surface
on which you apply, say, five volts, the more the heat generated. If
it’s not dissipated, it melts the chip. And there’s no way to dissi-
pate the kind of heat that will be generated by today’s transistors
if they were packed together on the nanoscale. The third problem
is tunnelling, the quantum-mechanical process by which electrons
flow between two adjacent transistors. If this happens, the transis-
tors will no longer hold the bits they’re supposed to.

If the problem is how to go about miniaturizing circuits fur-
ther, down to the nanoscale, new methods must be used. Two of
these are the resonance tunnelling diode (RTD), and the single-
electron transistor (SET). Both operate using the tunnelling effect,
and so, cannot suffer from the limitations imposed by the tun-
nelling effect. The RTD and the SET can therefore be built on a
smaller scale than a regular MOSFET.
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Stringed Quantum Dot Cells
An more interesting approach towards shrinkage is using quantum dot cells (QDCs): A
quantum dot (QD), is like a tiny box that contains a certain number of electrons, and a
QDC is a box that contains, say, five quantum dots, as below. Electrons repel each other,
and the QDs that contain electrons move to opposite corners of the cell. This means they
can be in one of two states, as below. When two QDCs of different states are placed next
to each other, they are in a high energy state, because of their polarization properties.
They tend to get into the low energy state by becoming of the same ‘type’, that is, with
both of them having their electron-containing QDs at the same corners. The high and low
energy states of pairs of QDCs can be 1s and 0s. 

Using this property,  a circuit without any ‘real’ current can be made by stringing QDCs
together: polarize one in a particular way, and the oth-
ers, like dominoes, become polarized the same way.

It turns out that logic gates, such as AND and OR,
can be built using stringed QDCs, without the need
for transistors. These gates can be very small: A single
logic gate made of transistors, as they would be in
2010, would take up forty times the space than one
made of QDCs would.

Nanotubes and NRAM
Applications of QDCs are still some time
away. Closer to today, Nano RAM (NRAM),
being developed by a company called Nan-
tero, based in Woburn, Massachusetts, may
be out any time now. 

NRAM is non-volatile, like Flash memory,
so your computer can boot up within a sec-
ond. The chips would run at 2 GHz, and last
virtually forever. The concept behind NRAM is
simple: combine carbon nanotubes—a mole-
cule of carbon atoms connected like a tube
and sealed at both ends (see figure below)—
with traditional semiconductor techniques.
Ones and zeroes revisited: A nanotube is bent
using electrostatic forces so that the top
touches the bottom. Bent nanotubes can be
unbent, too. Bent means a 1, and unbent
means a 0. And billions of nanotubes can be
squeezed into a four-inch wafer. 

Nanotubes will find their application in
high-resolution flat displays too—it’s been dis-
covered that nan-
otubes can emit
ring-shaped elec-
tron spurts under
certain condi-
tions, and elec-
tron emission is
basically what’s
required for a dis-
play device.

We’ll live to see it happen
If the last century was the century of the computer, this
one could well be the century of nanotechnology. Some
people say nanotechnology is ‘the’ technology of the
future.

Advances are happening so rapidly, one can’t tell when
a major breakthrough is just round the corner. Keep an
eye out for developments at sites such as kurzweilai.com,
eetimes.com and nanotech.org.

Quantum computing is something else altogeth-
er: when it becomes a reality, it will change the
way we look at reality forever. Closer to today,
nanoelectronics is already promising to
extend Moore’s Law. Of course, there are
nano-naysayers, but research dollars are
pouring in by the barrel.

Nanotech promises a lot of things, but
above all, it promises to make faster com-
puting machines—a promise we’ll probably
live to see fulfilled.

RAM MOHAN RAO

ram_mohan@thinkdigit.com

The Nanofuture now
Alan Seabaugh, and his colleagues, of the Nanoelectronics Laboratory at Santa Clara
University, USA, came up with an idea that could thrust us into the nanofuture right
now—a hybrid transistor that belongs both in the micro and nano worlds. It’s the
Resonant Tunnelling Transistor (RTT) (see figure ‘Resonant Tunnelling Transistor’). The
RTDs increase the number of logic states that the transistor can be in, and this
increases the ‘logic density’ on a chip. The RTT may be employed in commercial ter-
abyte DRAM chips as early as 2007. Terabytes, not gigabytes.

With the shrinkage made possible by the RTT and other resonant tunnelling
devices, we can expect Moore’s law to continue unhindered for another generation!

MAY 2004



Panasonic SV-AV100 D-snap SD
camcorder
PThe smallest of them all 
The SV-AV100 claims to be the world’s smallest MPEG2
camcorder, but we don’t know if there’s a Guinness
entry for that yet. At 1.25 x 2.125 x 3.5 inches, it’s
possible! You get DVD-quality video, and a remote! 
Price: US$ 700 (approx)

MAY 2004
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Logitech Pocket Digital
Is it just me, or is that a credit card?

This credit-card-sized pocket digicam slips into your shirt pocket.
It stores up to 52 pictures at 1.3 megapixels. The Autobrite image-

processing feature ensures good snaps in bright, as well as dim light.
Price: US$ 99

▲ ▲

Lens High

▲▲

Here’s a clique
that promises to
delight your
ocular senses
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The Digital Dream JB1 Camera

Mr Bond would approve
A pocket spycam, the JB1 digital camera masquerades as a Zippo lighter, in

typical 007 fashion. It holds up to 150 pictures at a resolution of 640 x 480,
and records up to 30 seconds of video and 12 minutes of audio. You can even

send live undercover video over the Internet. 
Price: US$ 99.99

Sony DCR-IP1 MICROMV Handycam
Camcorder 

Tape lives!
The lightest of tape-based camcorders, the DCR-IP1 has

high-precision digital zoom. It weighs a mere 8 ounces and is
about the size of an extended palm. A Hole Accumulation

Diode CCD imager with 6,90,000 pixels yields excellent detail,
and the MICROMV format delivers digital pictures. Sound

quality is comparable to that of MiniDV, but with much smaller
tapes. 

Price: US$ 1,200 (approx)

Sony Qualia 016
A pricey click

Measuring only 2.7 x 0.66 x 0.94
inches, the Qualia 016 is armed

with telephoto and wide angle
lenses. It eliminates blur by
combining four successively
shot pictures into one image!
4X digital zoom, and 2

megapixels at a resolution of
1,600 x 1,200 are just more

features to drool over.
Price: US$ 4,780 (approx)

Philips Key 019
A design marvel

An award winner at the Consumer Electronics Show (CES) 2004 held at Las Vegas, the
wearable Key 019 from Philips is probably the smallest camcorder around. You get 80
minutes of video using MPEG-4, or 25 minutes in Quarter Video Graphics Array
(QVGA) at 30 fps, or 200 two-megapixel images. The device functions as an MP3
player too, with 128 MB of USB storage.
Price: NA

▲ ▲

▲ ▲

▲▲

▲▲

©2004 Digital Dream.Com Ltd
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Wi-Fi, as the IEEE 802.11
wireless networking pro-
tocol family is commonly
called, is certainly going

places. Walk out of an airplane at the Delhi
airport, whip open your laptop and get
online. Stroll down the leisurely sur-
roundings of Delhi’s business class hotels,
and stay connected. Pop in for a quick

swim at Mumbai’s hotels—
still connected. 

A coffee break isn’t an
excuse to go offline anymore—Bangalore’s
Java City range of coffee pubs, and many
other popular hangout spots, are only too
glad to offer you wireless
Internet access.
Chances are that
your company

might be considering
Wi-Fi too. 

The need of a
burgeoning laptop

population to stay con-
nected is making much of corporate
India look at this wireless option. 

Junk the wires, suits
Wi-Fi stands for Wireless Fidelity, and it’s
the promise of wireless access that makes
it sound so attractive. Wi-Fi setups within
a corporate environment make you truly
mobile, and you don’t have to connect a
CAT5 cable to your laptop. 

Ask Exel India Assistant General Man-
ager, IT, Suresh Subramaniam, who wants
to get the large laptop base within his com-
pany networked without wires over this
year. Or talk to Anil Shankar, Team Leader,
Information Systems, Shoppers’ Stop, who
is all excited about it. Pathways Interna-
tional School, Delhi, also has a Wi-Fi net-
work running on campus. The hotspots at
the Delhi and Chennai airports, and those
at Bangalore’s hangout joints and cyber
cafés, are courtesy Sify. Suburban Mumbai’s
Le Royal Meridien (LRM) hotel also has a
Wi-Fi network in place for its guests. 

The advantages over wired LANs are
obvious. Once the access points (APs) are

ILLUSTRATION: Mahesh Benkar
PHOTOGRAPH: Mexy Xavier

W(hy)i-Fi?

Laptop users
have junked
CAT5 cables.
Airports,
coffee bars
and your
company,
are probably
doing the
same
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wired up, just prop the laptop at an
appropriate place and power it up to
access the network. You can work from
where you get a spot to sit! The corporates
we spoke to were impressed by this, and
considered their business requirements
that demanded access to the LAN and the
Internet at all possible places. 

It’s not that expensive either—with
laptop prices crashing and Wi-Fi
hardware becoming affordable, implemen-
tation costs have reduced drastically. 

How they did it
LRM got Convergent Communications, a
systems integrator, to set the network up.
Both, Harish Chandra, Area Information
Systems Manager, LRM, and Rajiv Giri,
Deputy General Manager, Convergent
Communications have an interesting anec-
dote. “We charged in the same time as the
housekeeping people, and stayed there as
long they did!”, says Giri. He goes on to say,
“It’s not difficult to set up a Wi-Fi network,
but doing that without tearing apart the
furnishings, while the hotel is running with
guests all over, was quite a challenge!” 

Other problems also cropped up.
“The window panes at LRM have a
metallic coating to reflect sunlight and so,
signals kept dropping when connecting
to an AP located on the other side of the
glass”, says Giri. Convergent worked
around this by using more access points.

Chandra recounts, “We couldn’t give
them the run of the place, and the guests
couldn’t have the sound of drills and
hammers disturbing them, so it was done
very discreetly”. 

Discreet is the word here—if you walk
around LRM looking at the decorated
walls, you can’t see any APs. The only
ones you can, are those kept in the open
near the poolside. 

Setting up a WLAN in other environ-
ments isn’t that troublesome, since most of
the cabling exists due to wired LANs. When
asked about any installation problems,

Prashant Jain, Director, Path-
ways International School
said that they weren’t any. He
says that they tied up with
IBM Global Services for the
network’s design and imple-
mentation. Shoppers’ Stop
implemented their WLAN
alongside their existing LAN. 

Anand Mehta, Marketing
Manager, D-Link India, says
that initially, APs gave them a
less-than optimal throughput
when they set up their
WLANs in 2001. Mehta says,
“During the first few days,
users were unhappy with the
range.”  However, the techs
quickly figured out that
raising the height of the AP
to seven ft solved the
problem. They then recalcu-
lated the optimal number of
APs on each floor. Today, the
users are more than satisfied
and their head office, and several other
branches are Wi-Fi enabled.  

“Setting up Wi-Fi networks,” says
Giri, “starts with a full-scale site survey,
where the entire structure and environ-
ment are studied, after which we design
and implement the solution”.

The people we spoke to pointed out
that the actual network setup, including
locating an ideal site for the APs was a
breeze—just walk around with laptops,
check signal strengths from different loca-
tions and then fix upon a good location. 

Getting the associated infrastructure
in place was, of course, dependant on

whether the office already had it. If it
didn’t, it meant additional work. 

In terms of hardware, laptops need an
add-on Wi-Fi PCMCIA card, while desktops
need a PCI Wi-Fi card. Centrino laptops
come with inbuilt Wi-Fi networking capa-
bilities. The existing infrastructure in most
corporate environments makes it easier to
add the cabling needed to connect APs.

Sify Chief Communication Officer,
David Appasamy, says that while putting up
hotspots at key locations in Bangalore, they
used the infrastructure existing in iWay
cyber cafés that were connected to their
nationwide wired backbone. Direct line-of-

We have had a lot more
customers, ever since we

started offering Wi-Fi connectivity
to our guests
“

HARISH CHANDRA, Area Information Systems Manager,
Le Royal Meridien, Mumbai “

Security is a big issue. Both D-Link and
Cisco—networking giants—have
underscored the need to secure corporate
wireless networks. 

D-Link’s Shridhar Kadam points out that
since radio waves reach out everywhere, and
travel through ceilings, floors and walls,
“Without stringent security in place,
installing a WLAN is the equivalent of
putting up Ethernet ports everywhere”.
Both, D-Link and Cisco agree that the
relatively static encryption keys of Wireless
Equivalent Privacy (WEP) are not that secure,
and urge using Wi-Fi Protected Access (WPA)
for corporate networks. 

Cisco’s Devendra Kamtekar says that it’s
possible to secure a Wi-Fi network  with WPA.

There’s also the emerging WPA2 standard
that’s expected to give still better security. 

Appasamy talks of ‘sophisticated security
practices’ being used for the company’s
hotspots. He says that accessing the hotspot,
and getting online through Sify will be
possible only through a stringent user-
authentication procedure.

Isolating the wired and wireless networks,
based on the requirement, may also help. In
LRM, Chandra and Giri worked out the
network in such a way that the wired
internal staff network is totally isolated from
the WLAN used by guests.

Pathways hasn’t had any such security
incidents, and Jain quips, “Until now, we
have been fortunate!”

Secure Those Radio Waves
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sight isn’t necessary, and an AP should
give you access up to 60-100 metres.
Mehta affirms that, “Placement of the
access point is critical… The thing to
keep in mind is less obstruction and
greater coverage area”. 

Typically, as the signal strength
drops, so does the throughput, which
is a rudimentary way of finding out
what sort of ‘spread’ an AP has. 

To a certain extent, government
regulations have played their part in
easing the transition to Wi-Fi. Cur-
rently, within a building or closed
environment, a WLAN is de-licensed
on the 2.4 GHz frequency spectrum.
As far as IEEE networking standards
go, the Indian government’s Wireless
Planning Commission (WPC) has
permitted unlicensed usage of the
IEEE 802.11b wireless networking
protocol that allows for Wi-Fi con-
nectivity at 11 Mbps. 

Cisco’s Network Consultant,
Devendra M Kamtekar, says that the
802.11g standard regulations right
now aren’t very clear, and users may
need clearance or licenses from the WPC
for implementing the same—802.11g
allows for a throughput of 54 Mbps. Both
work on the 2.4 GHz frequency spectrum. 

Vendors privately admit that 802.11g
implementations within a closed envi-
ronment are possible. However, before
implementing the 802.11g standard, we
strongly urge you to check the current
regulations regarding this. At this point
of time, outdoor usage in public areas
requires licenses from the appropriate
governing bodies such as the WPC. 

What do they think? 
With their campus WLAN up and running,
the Jains of Pathways are pretty upbeat
about it. “The whole school, in a way,
becomes a learning centre,” says Prashant
Jain. Students from standard VI upward
carry laptops around the campus and in the
classrooms. “Many a time, a thought or an
idea comes to a person’s mind, but by the
time he gets back to the classroom or hostel
room, the idea is lost. In a WLAN, this
handicap is not at all there.” This, as Jain

points out, means that an idea is
not limited to the classroom.  Sify’s
clientele will agree with him—they
can access the Internet within Ban-
galore’s Java City chain of coffee
bars, or the Casa Picola restaurant
chain, or at any of the locations
provided with hotspots. 

Whether it’s a chat with the
boss as you sip coffee, or checking
mail while snacking, wireless con-
nectivity, in Appasamy’s words,
“Lets you get the job done, and get
on with it”. Their clientele is pri-
marily drawn from business trav-
ellers who enter the city with Wi-Fi
enabled laptops. Such globe-trot-
ters love staying connected, and in
IT-savvy Bangalore, Sify helps them
do so by signing up with its service,
right from the airport itself. Besides
the good subscriber feedback,
Appasamy goes on to state that Sify
often gets enquiries from cus-
tomers abroad who want to sub-

scribe to the service before they even
arrive in Bangalore. 

Business travellers are also big Wi-Fi
customers for LRM. Chandra says,
“With 90 per cent of our business trav-
ellers wanting to stay connected, we
have had more corporates booking the
business centre, since there’s wireless
connectivity all over”.  

Wi-Fi certainly holds good for the retail
segment as well. At Shoppers’ Stop, And-
heri, a Mumbai suburb, Anil Shankar says
that with their Wi-Fi setup in place, they
can change the store layout and decor,
without having to worry about the net-
working infrastructure.

Problems… or are they?
Configuring the individual network nodes
is pretty simple—in Windows, for instance,
it’s a matter of making the necessary
changes in the network settings. Jain says
that at Pathways, “The in-house systems
administrator does this 2-minute job.” 

Service outages are an issue, though the
people we spoke to didn’t seem to be
wrestling with too many of them. Chandra
says, “LRM has yet to suffer any outages or
network congestion.” At present, their
11 Mbps Wi-Fi network is connected via a
512 Kbps pipe to their ISP. They were
lucky—even the Blaster attack didn’t clog
their network. “We got the alert from the
ISP,” say Chandra and Giri, “and immedi-
ately contacted those with infected lap-
tops”. Their 24/7 technical support

Wi-Fi networks have risen from IEEE
networking standards. The 802.11 IEEE
covers the wireless networking standard.
Commercial wireless access points were
promoted in early 1995.

Wayport, a pioneering organisation in
the Wi-Fi space, based in Austin, Texas, set
up wireless networks in early 1997. The
same year also saw the IEEE 802.11
standards being finalised. 

Back in 1999, Apple offered Wi-Fi
support along with the necessary hardware.
2001 saw the emergence of many
companies that worked on public Wi-Fi, but
several have since disappeared. In October
2002, the emergence of WPA, which has
now replaced WEP, ensured better security.

Intel worked on the Banias CPU
architecture that led to the development of
the Centrino platform in 2003. This
platform works with a Pentium M CPU, the
855 chipset family, and a wireless network
adapter that conforms to the 802.11b
standard. 

In the US, public Wi-Fi access has
boomed. Starbucks, the coffee chain offers
Wi-Fi services, as does McDonald’s.
Internationally, college campuses, hotels,
airports and bookstores, such as the Barnes
and Noble bookstore chain, are getting Wi-
Fi enabled as well. There’s a large laptop
population in the student and white-collar
community who actively use these services,
both for work as well as  leisure.

Around the World in a Wi-Fi

The performance may not be
the greatest, as compared to a

traditional LAN…but Wi-Fi will let
laptop users get truly mobile and
connect without wires

“
ANAND MEHTA, Marketing Manager, D-Link india Ltd “



instantly provided the necessary fixes. Giri
says, “A service outage could mean a faulty
AP, or problems in the wired infrastructure,
or lack of connectivity at the ISP’s end.” 

Convergent’s technical team checks the
LRM APs on a daily basis for all quality-of-
service parameters, and confirms that the
bandwidth available is upto the mark. Path-
ways didn’t have any major service outages
either. In Jain’s words, their network is up,
“working fine, without any congestion”. 

Maintenance, too, is not a problem
per se. Jain says that their in-house tech
staff, though “not experts”, can easily
field small problems. Shankar points out,
“Wi-Fi is new technology around here,
and everyone is eager to push it. Still, for
a really crowded network, the 11 Mbps
throughput may not be quite adequate,
and never as good as a wired LAN”. 

Wired LANs still give you higher
throughput than a Wi-Fi LAN. The max-
imum speeds on a wired network are 100
Mbps, and 11 Mbps for a 802.11b Wi-Fi.
In practice, wired LANs give about 50-60
Mbps and about 5-6 Mbps is considered
fine for Wi-Fi networks. While normal
Internet access isn’t really affected by this,
heavy LAN usage, such as accessing large
files on the LAN, will be noticeably slower
on a Wi-Fi network.

D-Link’s General Manager for Devel-
opment and Product Support, Shridhar
Kadam lists the reliability and reach of

WLANs as important parameters that make
them popular, and goes on to say that with
both wired and wireless LAN generally co-
existing within the same environment, its
important to ensure that the two are com-
patible and manageable as one network. 

How far would they go
So impressed was Jain with the Wi-Fi net-
work at the Pathways campus, that he
implemented one at home. Exel’s Subra-
maniam says that eventually, he wants to
get entire new offices go to Wi-Fi. “It’s not
tough to set it up”, is the common refrain.
As of now, Wi-Fi adoption in India is driven
by corporate adoption and the recent fall in
laptop prices. Typically, laptop users are
those in higher management and well, you
do need to be that highly placed to shell
out Rs 70,000 to buy a decent laptop! 

Undoubtedly, Wi-Fi networks are
going to spread within a few years, and
will probably be commonplace within
the next five years. As hardware costs

keep coming down, expect more activity
on the wireless front. While Wi-Fi will
never replace conventional wired access,
it will provide access at places where we
couldn’t get connected earlier. 

Don’t bet too much on getting cheap
public hotspot access, though. Sify charges
about Rs 515 for 8 hours of Wi-Fi connec-
tivity in Bangalore.

Appasamy says very matter-of-factly,
that unlike in the US, “The average Joe who
walks into a coffee bar is not going to carry
a laptop”, indicating that wire-free Internet
access is still going to be firmly targeted at
the individuals who are willing to pay, for
it. At LRM, they discreetly tell us that guests
are charged Rs 500 for 24 hours of access,
or Rs 250 for every hour of connectivity. 

Nevertheless, the luxury of sitting by
the sunny poolside, sipping chilled water
and surfing the Internet makes it look rea-
sonable. Almost!

SRINIVASAN RAMAKRISHNAN

srinivasan_ramakrishnan@thinkdigit.com
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802.11 standards: The ‘b’ standard came
first, operating on the 2.4 GHz spectrum,
offering 11 Mbps throughput. Next up
was 802.11a that operated at 5 GHz, with
a 54 Mbps speed. This was quickly
superseded by the 802.11g that operates
on the 2.4 GHz band and gives 54 Mbps.
Access points: Wi-Fi enabled desktops
and laptops communicate via radio
frequency with the Access Point (AP).
The AP then connects to the backend
servers that provide the necessary
infrastructure to connect to the Internet. 
WPA: Wi-Fi Protected Access, a security
protocol suite that has replaced WEP,
using a complex, and until now, secure
system of authentication. 
WEP: Wireless Equivalent Privacy, 
an older security protocol that was 
used widely in older APs, to provide
security. WEP is now considered 
relatively insecure.

Jargon Buster

Cost per PC for setting up a wired and a wireless office LAN
WIRED WIRELESS
1 10/100 Mbps LAN card Rs 500 1 PCMCIA Wi-Fi card Rs 2,800
CAT5 cable 20m length Rs 200 1/20th access point Rs 250
1/24th Patch Panel port, Rs 200
information outlets,
& other hardware 
GRAND TOTAL: Rs 900 Rs 3,050

The cost of switches will be common to both; wireless LAN will be a 11/22 Mbps (using
standard 802.11b or proprietary 802.11b+ technology). The wired LAN will have a 100
Mbps throughput.  
All costs are approximate

Wi-Fi laptop

Wi-Fi enabled PDA
The Access Point (AP)

The Wi-Fi enabled 
laptop talks to the AP
via Radio Frequency

AP
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To ensure that our readers have all the infor-
mation they need to make an informed buy-
ing decision, reviewers at the Digit Test Cen-

tre conduct comprehensive tests to evaluate the lat-
est hardware, software and technology services in
accordance with international standard evaluation
processes and methodologies. 

Our test results may be presented either as
Comparison Tests, or as individual reviews in the
Bazaar section. The representation of the results is
different for each in the interests of clarity, but the
test process for both is identical in all respects. 

Of all the products we test, only the best make
it to the A-List.

Comparison Tests
In the comparison tests, we compare the perform-
ance of products within a particular category. Each
product is evaluated under different parameters
such as performance, value for money, features,
ergonomics, etc. 

Weightages are then applied to the various test
parameters according to their importance for that
particular category of products. These weightages
are then used to arrive at scores for features,
ergonomics and performance for each individual
product. A detailed test process is included with
each comparison test, and explains the parameters
that were taken into consideration, along with
weightage allocation and reasons for the same.

In Bazaar
The evaluation of products in Bazaar also covers the
same parameters such as performance, ease of use,
value for money, build quality and features of the
product. 

Here, each of these parameters is rated on a
scale of 5, which is represented by arrows (->). 

The greater the number of arrows, the better
the product. This simple five-point rating system is
designed to give you an easy-to-interpret assess-
ment of a product. For example, a product that

receives a value for money score of five arrows 
signifies an outstanding buy. 

The Awards
Digit awards outstanding products by selecting 
a Best Performance and Best Value winner in 
each comparison test. The winner of the Best 
Performance Award will be the product that scored
the highest in the performance segment combined
with rest of the package including features,
ergonomics, bundled accessories etc. This award
represents the best performing product in our tests
in terms of the complete package that is offered to
a customer. The winner of the Best Value Award will
be the product that scores the highest in our value
for money parameter which is derived taking into
account the ratio of a product's ergonomics, per-
formance and features to its price. The product
winning this award offers a good combination of
performance and features at a great price. Since
value for money takes into account all scores for all
parameters including the price, this score will be
used to arrive at a grade (e.g. A+) for each product.

How we Test
It looks good and the technology is glitzy, but does it do the job?

Excellent: A brilliant combination of price, performance and features—far beyond 
expectations
Good: A good buy, better than most products in its category
Average: Reasonably competent but nothing spectacular about the product
Mediocre: Does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be used for its target
application

The 5-point Rating System used in Bazaar
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You look at your monitor all the time—so a monitor purchase is

an important decision. We tested and lined up a bevy of 17- and

19-inch, CRT and LCD monitors for you to choose from.

MAY 2004
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Fifteeen-inchers are a thing of the past; the new monitor’s
minimum starts at 17 inches, thanks to the fall in hard-
ware prices. To go a-monitor shopping, all you need is
a little research, some market-browsing and the infor-

mation you get from the comparison tests that follow.

Features
We had quite a few competitors in the 17-inch category—16 to
be precise. The major categorisation here is regular monitors
and flat-screen monitors. Flat-screen monitors come in two
flavours—Aperture Grille and Shadow Mask. Generally, most of
the monitors we use have a picture tube based on Shadow Mask
technology. Aperture Grille is a special technology, invented

by Sony, and affords greater resolution and clarity.
None of the monitors we received
featured integrated speakers. The NEC

Multisync FE791SB and the Samsung
763MB had a special brightness
control feature, which adjusts bright-
ness when viewing different types of
content: there are preset modes for
Internet, text and movie viewing.

All the monitors we received
have Shadow Mask picture tubes,

except for the NEC Multisync
FE791SB, which has an Aperture Grille

tube. The video bandwidth of this monitor, at
145.92 MHz, was the highest amongst all the monitors in the
17-inch category. The NEC monitor also affords the highest
resolution, and goes as high as 1,600 x 1,200  at 76 Hz—equiv-
alent to the highest resolutions available on several 19-inch
monitors. 

Flicker-free viewing is one of the best things about the
NEC—the reduction in flicker is because of high refresh rates.
The next-best monitors in terms of video bandwidth and
features were the LG Flatron E700S and the Samsung 763MB.

Dot pitch is very important when you’re considering
purchasing a CRT monitor: the smaller the dot pitch, the
sharper the image, which translates to improved overall picture
quality. The diagonal dot pitch of the NEC is 0.25 mm;
however, the Samsung is the best of the lot, with a diagonal dot
pitch of 0.23 mm.

Other monitors were run-of-the-mill, with virtually no
difference in specifications. It’s clear from the features listings

that flat-screen monitors have an edge over regular monitors,
with their higher video bandwidth and refresh rates, not to
mention the flatness of screen.

Features-wise, the NEC beat the other monitors hands
down, but the real tussle was in the performance tests.

Performance
All the monitors we received had OSD (On Screen Display) con-
trols, and we assigned higher scores to those that were user-
friendly. The Microtek monitor was particularly so—it has an
intuitive interface, with just one knob for all monitor func-
tions. The LG and the Samsung were the other monitors that
had very easy-to-use OSD controls. Although the NEC is packed
with features, the OSD controls take time to get used to.

Geometry tests were performed to check for monitor
symmetry after all adjustments were done. The NEC MultiSync
FE791SB was the best of the lot, and scored the highest in the
geometry tests.  Pincushion distortion is more evident in flat-
screen monitors, so the NEC lost out here; however, in the
screen regulation tests, it did well.

The NEC monitor seemed to keep its cool where the other
monitors were jumpy. A series of ‘regulation tests’ guage the
monitor using different simulated situations. These are impor-

17-inch CRT Monitors

NEC MultiSync 791SB

The performance winner in this cate-
gory was hard to beat. Flat screen

monitors are better than regular
CRTs, and our test results just
reinforced the fact.

The NEC MultiSync
FE791SB was the only 17-
inch monitor in our tests to
feature an Aperture Grille
CRT. And the advantages are
clearly visible. Flicker-free
viewing at high resolutions
give it a more than enough
edge over the other monitors. The
diagonal dot pitch of the NEC monitor is also less than 0.26
mm, which, combined with the refresh rates and resolutions,
will definitely give you a crisper picture.

The OSD controls could have been more user-friendly,
though. The NEC MultiSync FE791SB retails for Rs 16,500,
which is way higher than the retail price of any other 17-
inch CRT we tested. But quality demands a price, and if
you’re finicky and won’t compromise, you can’t go wrong
with this monitor.

+ Aperture Grille, flicker-free viewing
– OSD controls not intuitive
Price: Rs 16,500



tant, because the first thing you need to get right is the display
on the monitor. The factory settings of all monitors are not the
same, and setting a monitor properly and symmetrically is the
first thing that needs to be done. Curved screen edges or
unsymmetrical sides are irritating. Any monitor that does this
to an acceptable level, even after adjustment, is okay, but if
this happens too much, you need to look further. The Microtek,
for example, was bad as far as curved edges etc. are concerned.

The next series of tests involved testing the sharpness and
resolution. Images shot at a particular resolution are displayed
with the same clarity on a monitor only at the same resolu-
tion. If the resolution is changed, the images tend to be
distorted and blocky; but this happens to a minimal extent on
a good monitor. This effect is more evident with CRT monitors
than flat-screen ones, and this is the point that manufacturers
make when they advertise flat-screen monitors. Surprisingly,
it turns out that all images we currently see at 640 x 480, are
at the best resolution they can be. Going above that resolu-
tion, even the best monitors have difficulties reproducing the
image—they lose out on the finer details. 

The above-mentioned tests test precisely this, by running
an image in coarse, fine and diagonal patterns. The fine images
were more blurred than the regular image.

The results of this test are important for people who are
into visual work such as CAD, CAM or DTP, since they need to

work with images all the time. For such users, a flat-screen
monitor is best. The LGE700H and the Philips 107C5 are both
flat-screen monitors that put up the best scores, beating the
NEC, while the HCL HCM785RFM scored the lowest. All the
other monitors, including the Samsung and the BenQ, gave
above-average scores.

We also conducted colour and greyscale tests on the moni-
tors. You can make out when colours have a more pronounced
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This monitor looks like a preview of the future. Its
humongous 23-inch widescreen offers an unforgettable

viewing experience. You’ll never have to scroll through
Excel sheets or long Web pages again. 

The monitor comes with an external control box, with

almost all possible connectivity options on the back panel.
There’s also an option for speakers on this monitor. The
cables provided include a SCART cable, S-Video cable, USB
cable and a regular DVI-D/15-pin D-Sub cable. You also get
a full-fledged remote, with enough controls to confuse you
initially. One of the available modes is the Spectacle func-
tion: this mode sets a varied aspect ratio—the central area
has an aspect ratio close to 4:3, and the edges exceed 16:9. 

The monitor  also has the PIP function, which allows
you to view a screen within a screen, but lacks an in-built
TV tuner. Get yourself an anamorphic 16:9 widescreen DVD
to play, pop some corn, get your favourite chair, dim the
lights and you’ll be convinced you’re sitting in a theatre.

If you can afford it, this beauty is a must-have.

+ Wide variety of connectivity options
– No in-built TV tuner
Price: Rs 1,85,000

Philips 107E5 

This is a wonderful package, and main-
tains a good balance between features

and performance, without being heavy on
the pocket.

The Philips 107E5 is a
flat-screen monitor, and
even with its great features
and performance, is one of
the lowest priced moni-
tors in this category. The
diagonal dot pitch is 
0.25 mm, and the highest
resolution supported is
1280 x 1024 at 60 Hz.
Compared to other monitors
in the same price range, the monitor
is flicker-free and the display is good. In fact, this monitor
scored very well in the colour and greyscale tests, leaving the
big guns behind. Features-wise, it packs in almost everything.
However, the OSD controls, again, could have been more
intuitive.

+ Low-priced, flicker-free viewing
– OSD controls not very intuitive
Price: Rs 6,300

LG 2320A 23-inch Widescreen Monitor
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Our test-bed comprised an Intel Pentium 4 3 GHz processor,
running on an Intel D875PBZ motherboard, with 512 MB of DDR
333 RAM, a Seagate Barracuda 120 GB SATA hard drive and an
Ennyah GeForce FX 5700 graphics card.

All the monitors were tested for performance and features. The
features and performance parameters are allotted 40 per cent and
60 per cent respectively. The performance and features scores were
added, and the sum was divided by cost. This gave us an index for
value for money.

Performance: We used the DisplayMate benchmarking
software to gauge performance. It uses images to test for
geometrical accuracy. This aspect is especially important for CAD
and CAM designers, and users of graphics applications.

Another important factor to consider is the ability of the
monitor to hold image shape in a stable manner. Sudden changes
in brightness levels can cause distortion, say, when you toggle
between an application and the desktop.

In the sharpness and resolution set of tests, we tested the image
sharpness offered by the monitor and the resolution at which it
displays pictures clearly. The Defocusing, Blooming and Halos tests
showed us how much thicker an image looks compared to its
darker counterpart: in this test, the image detail projected by the
CRT is measured.

The pixel persistence test was run specifically for the LCDs, to
check for jerks or image blurring. Another LCD-specific test was the
viewable angle test. Unlike CRT monitors, when you view an LCD
screen from an angle, things are not as bright and clear. We tested
to find the angles at which the screen still looked crisp.

Features: We looked for value-additions and other aspects that
aimed at increasing the user-friendliness of the display. The features
noted varied in their significance—from simple things such as ease
of use of the OSD, to power consumption for LCDs, and depth and
weight for CRTs.

We also looked for, and awarded points to, important
parameters such as pixel size and video bandwidth, in both LCD
and CRT monitors. A smaller pixel size and higher video bandwidth
was given preference, as it helps to make the display crisper and
the colours more vivid.

Even the monitor bases were tested, to see how much they
could be tilted—the more the better.

Wall-mounted LCDs are convenient, and earned more points.
Height adjustment was also considered. Interestingly, some could
be rotated from landscape to portrait mode. 

User manuals are often overlooked, as is the quick start guide.
We pored through them to see how helpful they’d be if we didn’t
already know how to set up a monitor.

How We Tested

CATEGORY CRT MONITORS 17”

Brand
Model

Size (Inches)
Viewable Area (Inches)
F&FST (Y/N)
Dot Pitch (mm) (Diagonal)
Vertical Scan Rate (Hz)
Horizontal Scan Rate (KHz)
Maximum  Resolution/Refresh Rate (Hz)
Video Bandwidth (MHz)
CRT type
W x H x D (mm)
Weight (Kg)
In-built Speakers (Y/N)
Anti-Glare Coating (Y/N)
Bundled Accessories (Manuals, Colour
Profile, Driver and Calibrating software,
etc.)
Performance 
OSD Usability (scale of 5)
DisplayMate Tests
Geometry test (scale of 25)
Sharpness and Resolution (scale of 35)
Screen Pixel Resolution (scale of 5)
Colour and Grey Scale (scale of 45)
Miscellaneous Effects (scale of 25)
Features
Performance
Overall (Features + Performance)
Value for Money
Price
Grade

BenQ
V773

17
16
N

0.27
50 - 120
30 - 72

1280 x 1024 @ 67
110

ShadowMask
406 x 422 x 412.5

15.4
N
N

User manual,
driver CD

3.5

8.5
22.5
3.75
30

15.5
10

33.85
43.85
2.53

6,500

HCL
HCM780M

17
16
N

0.27
50 - 160
30 - 70

1280 x 1024 @ 60
110

ShadowMask
410 x 402 x 420

15.5
N
Y

User manual

3.75

5.25
17

2.75
29

16.75
14

29.5
43.5
2.67
6,100

BenQ
G775

17
16
Y

0.25
50 - 120
30 - 72

1280 x 1024 @ 60
110

ShadowMask
406 x 422 x 417.5

16.4
N
Y

User manual,
driver CD

3.25

6.5
23
3.5
34

15.25
17

34.25
51.25
2.26

8,500

HCL
HCM785RFM

17
16
Y

0.21 (horizontal)
50 - 160
30 - 72

1280 x 1024 @ 60
110

ShadowMask
410 x 402 x 420

16
N
Y

User manual

4

4.25
22.5
3.5
28.5
16
19
31
50

2.39
7,850

LG
Flatron E700s

17
16
Y

0.25
51 - 160
31 - 71 

1280 x 1024 @ 60
110

ShadowMask
401 x 395 x 424

16
N
Y

User manual,
driver CD

3.5

7.75
23.5
3.75
31.5

16.25
21

34.7
55.7
2.49

8,400

LG
Studioworks 700S

17
16
N

0.23 (horizontal)
50 - 160
30 - 70

1280 x1024 @ 60
NA

ShadowMask
400 x 420 x 395

14.4
N
Y

User manual,
Driver CD

3.5

8.75
22.25
3.75
30.25
16.75

15
34.45
49.45
2.81

6,600

Microtek
Flatvision 43F1

17
16
N

0.28
50 - 120
30 - 70

1280 x 1024 @ 60
110

ShadowMask
406 x 404 x 423

15.5
N
Y

User manual

4.5

4
20.75
3.25
30.5

16
11

31.65
42.65
2.81

5,700

LG
Flatron E700BH

17
16
Y

0.25
50 - 160
30 - 71 

1280 x 1024 @ 60
110

ShadowMask
400 x 395 x 424

16
N
Y

User manual,
driver CD

3.5

6.5
24.5
3.75
28
15
21

32.4
53.4
2.25

8,900



effect, such as in bleeding, where the colour seems to go over
the border or frame of a photograph. Over all monitors, there’s
a definite variance in hue and tone. We also tested for streak-
ing and ghosting—generally, this happens with images that
have solid elements, such as geometrical shapes, or Windows
that are tiled one on the other. The lesser this effect, the better

the monitor. In these tests, the Philips 107C5 led the pack,
followed closely by the Samsung 563MB.

The last batch of tests checked for screen uniformity. There
were also miscellaneous tests that looked at other aspects of
the monitors. As expected, the NEC MultiSync FE791SB won on
these tests.
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The Samsung LS17E34C was one of the first
to offer a widescreen hybrid LCD-cum-TV.

This device can serve as your PC monitor when
you’re working, and as an entertainment cen-
tre when you’re not. With a glossy metallic
colour, it definitely adds aesthetic appeal to
any living room. Gaming on a widescreen LCD
monitor can be a bit irritating, however,
because the games tend to look stretched.

Watching a DVD movie on a wide-screen
monitor is a pleasure, and the Samsung
LS17E34C didn’t give us any cause for
complaint. It has a special surround sound
mode called Virtual Dolby Surround, which adds to the
movie experience. The monitor can be connected directly to
a stand-alone DVD player, and comes with a remote control
which can control all the functions of the monitor. It also
has an in-built TV tuner—all you need to do is plug in the

cable and scan through
channels.

The PIP (picture-in-
picture) is another handy
function—you can work
with an Excel sheet and
catch up with the latest
news simultaneously.
Imagine how useful this
could be for share-brokers:
they could check  the
latest share prices on
CNBC  and trade shares

on Web sites at the same time.

+Feature rich
– Display quality not up to the mark
Price: Rs 74,990

Samsung LS17E34C

NEC
MultiSync FE770

17
16
Y

0.21 - 0.25
50 - 120 
30 - 70 

1280 X 1024 @ 66
NA

ShadowMask
397 x 392 x 415.5

16
N
Y

User manual, colour
profile software, driver,

calibrating software 

2.25

7.25
19.5
3.5
29

15.75
19

31.05
50.05
1.63

11,500

NEC
MultiSync FE791SB

17
16
Y

0.25
50 - 160
30 - 96 

1600 X 1200 @ 76
NA

Aperture Grille
397 x 392 x 415.5

17.2
N
Y

User manual, colour
profile software, driver,

calibrating software 

2.5

15.25
21.5
3

30.5
18.75

27
38.35
65.35
1.49

16,500

Philips
107E5

17
16
N

0.27
50 - 160 
30 - 70

1280 x 1024 @ 60
NA

ShadowMask
397 x 333 x 419

14.5
N
Y

User manual, colour pro-
file software, driver, cali-

brating software 

2.75

5.25
21

2.75
28.25
16.25

20
30.3
50.3
2.99
6,300

Samsung
773DFx

17
16
Y

0.20 (horizontal)
50 - 160
30 - 70

1280 x 1024 @ 65
110

ShadowMask
398 x 412 x 400

15.9
N
Y

User manual, colour pro-
file software, driver

3.5

6.5
23

3.75
30.75
15.75

19
33.1
52.1
2.15

8,900

Viewsonic 
E70f

17
16

Yes
0.25

50-120
30-70

1280 x 1024 @ 66
120

ShadowMask
410 x 406 x 424

17.5
N
Y

User manual, Colour profile soft-
ware, Driver, Calibrating software 

3.25

6.5
19.5
3.5

28.5
15.5
17

31.15
48.15
2.43
7,900

Philips
107C5

17
15.9
Y

0.25
50-160
30-71

1280 X 1024 @ 60
NA

ShadowMask
397 x 383 x 424

15.5
N
Y

User manual, colour
profile software, driver

2.75

7
23.75
3.25
33.75

16
14

34.65
48.65
2.20
8,300

Samsung
763MB

17
16
Y

0.20 (horizontal)
50 - 160
30 - 70

1280 x 1024 @ 60
110

ShadowMask
398 x 412 x 400

16
N
Y

User manual, colour pro-
file software, driver

3.25

9.25
22.25

4
32.5
16.25

19
35.5
54.5
2.29

9,500

Samsung
773s

17
16
N

0.23 (horizontal)
50 - 160
30 - 70

1280 x 1024 @60
110

ShadowMask
398 x 412 x 400

16
N
Y

User manual, driver CD

4

7
20.75
3.75

28.75
15.5
16

32.05
48.05
2.20
7,400
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19-inch CRT Monitors

If 17-inchers are the standard, 19-inchers are prime real
estate. Priced just Rs 2,000 or 3,000 more than their 17-
inch counterparts, 19-inch monitors are fast becoming
popular. In fact, they are a standard with professional

users working with Photoshop, Corel Draw and
QuarkXPress. Even avid gamers and ‘videophiles’
have begun opting for them.

Features
The first thing you’ll notice about 19-inch CRT
monitors is that they have a much higher
bandwidth than the 17-inchers. This translates
to flicker-free viewing. Also, the resolutions
offered are higher.

Last year’s winner, the BenQ V991, was over-
shadowed by the slew of models this year. The Philips
109P4 had the best specs amongst all the monitors in both
dot pitch and video bandwidth. The maximum resolution
achievable by last year’s winner was 1,600 x 1,200 pixels at 78
Hz—here Hz is the vertical frequency scan rate of the moni-
tor. This year, that’s just average, and both this year’s Philips
models can  attain resolutions of 1,920 x 1,440 pixels at 60 Hz.
The NEC Diamondtron can go as high as 1,920 x 1,440 pixels
at 73 Hz. The entry level Philips monitors offer a dot pitch 
of 0.25 mm—something not seen in any of the other entry
level monitors.

The biggest drawback of 19-inch monitors is their bulki-
ness; compactness earned points.

The Philips 109P4 has a flat screen with Aperture Grille
technology. The only other monitor to offer this technology is
the NEC MultiSync 912SB. Here, SB stands for Smart Bright—
preset modes of brightness that you can choose between,
according to the applications you’re working on, such as ’Net
surfing, watching a movie or working on a text file. The Philips
109P4 is the only monitor to feature extra RGB inputs, other
than the regular D-Sub 15-pin connector.

The LG StudioWorks 910E was the lightest model, but it
suffered in terms of features—it didn’t even have a full flat
screen. The NEC FP912SB is one huge monitor, and has
cumbersome OSD controls. In terms of OSD, the BenQ V991 is
easy to use and access, and can be set up in no time.

None of the monitors featured any extras such as USB hubs,
which offer an option for external connectivity. Speakers were

missing, too. All the monitors came with the standard package
of manuals, drivers and warranties along with the necessary
cables.

Performance
In our performance tests, we ran the DisplayMate col-
lection of tests. The geometry test was very impor-
tant for all the 19-inch monitors, since the pin-
cushion and barrel distortion is comparatively less
than on a 17-inch monitor. Also, since 19-inch
CRTs are more popular amongst professionals, pre-
cision is a must—if the geometry of a monitor is
incorrect or unsymmetrical, it can cause problems

when used with engineering or design applications.
The Samsung 955DF fared poorly in the geometry

test—there was too much variation in the size and shape of the
images in the geometrical resolution tests. Even after adjusting
the monitor to give the maximum screen area, the Samsung

Philips 109P4
The battle for the performance title was
tight. The NEC MultiSync 912SB was
always on the heels of the Philips 109P4,
throughout the gruelling tests. The NEC
put in a very commendable performance, and

deserves special mention, but there’s
only one spot on the top.

The Philips 109P4 deserves our
crown of best performing 19-
inch CRT monitor, with fea-
tures and performance that
are  second to none. It has an
Aperture Grille picture tube,
which is FFST and guarantees
excellent image quality.
The 109P4 looks great. It’s

also the only monitor to offer external
RGB connectors, and is feature-packed, though more, such
as a USB hub would have been welcome.

This monitor zoomed through all our tests. The reso-
lution offered is one of the highest, and colours are sharp
and vivid. The contrast is very good, and the monitor is
suitable for any application you can think of. The only
grudge is the OSD controls, which need some effort to get
used to.

We suggest that you look no further if you want a
high-performing monitor at a decent price. Ideal for any
desktop!

+ Aperture Grille, looks great
– OSD controls take time to get used to
Price: Rs 18,500



still disappointed us. Based on the results of this test, it is fair
to say that this monitor should not be used for working with
CAD, CAM or design applications. The BenQ, however, posted
good scores, and was second only 
to the Philips 109P4.

In our sharpness and resolution tests, the BenQ and the
Philips 109P4 duelled right to the end. The BenQ lost to the
Philips in the resolution matrix and the fine resolution matrix
tests. Though the NEC MultiSync 912SB also posted good
results in these tests, it could only manage a close third. The
aim of these tests is to check the image sharpness with the least
distortion possible, and the Phillips 109P4 proved to be 
the best of the lot.

One of the most important tests is the colour test. A moni-

tor should display colours correctly with little or no bleeding,
and should have proper colour controls. Generally, all monitors
have the option to set a higher colour temperature—9500 K
(Kelvin)—for programs that need it: as mentioned in ‘Jargon
Buster’, lower temperatures are more suitable for viewing
images, movies and such, while documents and precise graphic
design demand higher temperatures.

The HCL 985RFM was not up to the mark in our colour
tests, as colour mixing was prevalent at some places on the
screen. Streaking and ghosting were other parts of the tests
where the HCL suffered. The Samsung 955DF and the NEC
MultiSync 920 and the Samsung 955DF posted the best scores
among all the monitors in the colour streaking subtest. Over-
all, the HCL monitor was disappointing, and we recommend
staying away from it.

Our last batch of tests consisted of tests that checked the
flicker and screen uniformity, and included the dark screen test.
The LG Studioworks 910E posted the best mix of scores here—
it did the best in the screen uniformity and flicker tests. The
Philips 109E5 disappointed us in the flicker test, where it posted
the lowest score of all.

All CRT monitors reflect light, but the amount of reflection
should not cause eye strain. Here, all the monitors posted rela-
tively low scores, but the BenQ was the worst of the lot, with
high dark screen reflection.
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Philips 109E5

With all the features that you’d
want, such as FFST and Aperture

Grille, the Philips 109E5’s low price and
good performance made an obvious Best Value winner.
This sleek white monitor is ideal for daily use, including

Web surfing, watching movies, playing
games and using office applications.

The Philips 109E5 posted the
third-highest scores in the
geometry test, leaving some
flat-screen monitors behind.
The dot pitch of this moni-
tor is 0.25 mm—pretty much
acceptable—but the best part
is the high resolution it

offers: 1,920 x 1,440 pixels at 60
Hz. This is the same resolution that our

performance winner offers, but the Philips 109E5 is a
whopping Rs 8,850 cheaper.

With the 109E5, Philips has struck the ideal balance
between price, performance and features. It’s the best
entry-level option we’ve seen so far. If you want a moni-
tor that’ll get your job done in a very decent way, and is
also eminently affordable, this one is your best bet.

+ Good video bandwidth, high resolutions, Aperture Grille
– None
Price: Rs 11,500

Another entrant in the widescreen LCD-TV segment is
the Philips 17-inch W 170T4 monitor. It’s better than

the Samsung in terms of performance as a monitor, as well
as in terms of display quality.

A TV tuner is built into the monitor, taking care of your
TV viewing needs. This monitor also supports HDTV, so,
as and when HDTV is available in India, you’ll be prepared.
There’s a screen mode that lets you switch between stan-
dard mode, 4:3 aspect ratio, HD and non-linear scaling
mode. Other features include NICAM stereo and a sleep

timer, making this device an excel-
lent replacement for your TV. 

There are sound controls for
everything, including bass,
treble and surround sound
mode. The monitor gave pretty
good results in our Display-
Mate battery of tests.

It does its job well, both as
a computer LCD and as a
TV/Video display device. The

Philips 17-inch W 170T4 Wide-
screen Multifunctional LCD monitor is

definitely a good buy, especially if you want your
monitor to be future-proof.

+ Good picture quality
– Very few features
Price: Rs 49,999

Philips 17-inch W 170T4 Wide-
screen Multifunctional LCD monitor
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CATEGORY CRT MONITORS 19”

Brand
Model

Size (Inches)
Viewable (Inches)
F&FST (Y/N)
Dot Pitch (mm) (Diagonal)
Vertical Scan Rate (Hz)
Horizontal Scan Rate (KHz)
Maximum  Resolution/Refresh Rate (Hz)
Video Bandwidth (MHz)
CRT type
W x H x D (mm)
Weight (KG)
RGB connector (Y/N)
Anti-Glare Coating (Y/N)
Bundled Accessories (Manuals, Colour
Profile, Driver and Calibrating soft-
ware…)

Perfromance
OSD Usability (Scale of 5)
Geometry test (Scale of 45)
Sharpness and Resolution (Scale of 35)
Screen Pixel Resolution (Scale of 5)
Color and Gray Scale (Scale of 45)
Miscellaneous Effects (Scale of 25)
Features
Performance
Overall
VFM
Price
Grade

LG
StudioWorks 910E

19
18
N

0.26
50 - 160
30 - 85

1600 x 1200 @ 65
NA

ShadowMask
435 x 439 x 460

17.3
N
NA

Manual, driver CD

3.5
10

21.25
3.5

31.25
17
13

26.4
39.4
1.63

14,500

HCL
HCM 985RFM

19
18
Y

0.25
50 - 160
30 - 98

1600 x 1200@75
200

ShadowMask
446 x 436 x 455

20
No
Yes

Manual

3.25
6.5

19.75
3.75

26.75
15.25

19
30.35
49.35
2.12

13995

BenQ
V991

19
18
N

0.25
50 - 160
30 - 110

1600 x 1200 @ 78
176

ShadowMask
454 x 464.82 x 462.8

23.58
N
Y

Manual

4
18.75
23.75

4
29.25
12.75

16
29.65
45.65
2.11

13,000

NEC 
MultiSync 912SB

19
18
Y

0.24
50 - 160
30 - 110

1920 x 1440 @ 73
NA

Aperture Grille
442 x 443 x 447.5

23.8
N
Y

Manual

3
20
23
4

29.75
17
25

40.95
65.95
1.62

24,500

Philips 
109E5

19
18
N

0.25
50 - 160 
30 - 92 

1920 x 1440 @ 60
158*

ShadowMask
440 x 443 x 437 

17.8
N
Y

Driver, manual

3.75
15.25
20.25
3.75
27.5

14
24

35.55
59.55
3.11

11,500

NEC 
MultiSync 920

19
18
N

0.26
55 - 160
31 - 96 

1600 x 1200 @ 76
NA

ShadowMask
442 x 453 x 455

20
N
Y

Manual

3.5
6.75
21.25

4
31.25
16.25

14
33.15
47.15
2.84

9,950

The Philips 15-inch 150T is the kid sibling of
the Philips 17-inch W, and is meant to be

a convergent solution. However, it’s not
widescreen like the Philips 17-inch. 

The display quality of this monitor is on
par with the others, but the lack of a
widescreen function takes the fun out of
watching movies.

The monitor will look nice on your desk-
top, and the in-built speakers are more than
adequate for music or games. It can take multi-
ple video inputs—PC, TV, HD, DVD and VCD,
and you can even hook your video 
camera to it.

The bundled remote is the identical to the one that
ships with the 17-inch model, and controls all
the functions of the monitor. Though you can
set the aspect ratio to 16:9 and 4:3 as well, we
suggest you stick to the full screen option. The
OSD functions are well defined, and the docu-
mentation and drivers are on the CD. Overall,
this is a very good 15-inch solution from
Philips.

+ Several input options, OSD well-defined
– Low on features
Price: Rs 29,999

Philips 15-inch 150T Multifunction Monitor

Conclusion
A good quality 19-inch monitor is a better option than 
smaller CRTs, or even 15-inch LCDs, which cost almost as much.
The display on a CRT is sharper and more detailed than on a flat
panel LCD, but you compromise on space. Working with office
applications such as Excel, or design applications such as Auto-
CAD are less frustrating—there’s a lot less scrolling required than

with smaller monitors. 19-inch monitors are a choice you need
to make depending on the type of the work you do.

Monitors are usually long-term investments, and they’re
usually the last component to be upgraded. So, do you really
want to spend the next three or four years staring at a depress-
ing 15-inch LCD or a 17-inch CRT, when you can have one of
these beauties?
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The Samsung SyncMaster
150MPplus is Samsung’s 15-inch

multifunction monitor. As a monitor,
it’s just vanilla, but take a look at its
features, and you’re sure to be
impressed. It comes with an inbuilt TV
tuner. 

The 150MPplus is loaded with addi-
tional features: watching movies is
enhanced with the PIP feature. You
can control the sound from the
remote; in fact, you can control every-
thing with the remote. The inbuilt TV
tuner lets the SyncMaster 150MPplus
function just like a normal TV, with
channel scan, fine tuning, colour
control and user settings to boot. Even
the remote looks like the ones
Samsung bundles with their TVs. 

All necessary wires and accessories,
plus an extensively documented
manual, are bundled. All input devices
can be connected simultaneously, and
you can use the source button on the
monitor and remote to toggle between

each source. Another function is the
image quality, which adjusts the image
according to the viewing needs, and
makes the image sharper or softer.

If you’re interested in a 15-inch
LCD that can double as a TV without
the hassle of setting up a TV tuner, this
is a monitor you should consider.

+ Very good display quality
- Expensive
Price: Rs 35,400

Samsung SyncMaster 150MPplus
Philips 
109P4

19
18
Y

0.24
50 - 160
30 - 110

1920 x 1440 @ 60
261

Aperture Grille
456 x 469 x 439

23.5
Y
Y

Manual, driver CD, iKey and
LightFrame 3 software

3.75
19.25
23.5

4
28.75

18
32

41.45
73.45
2.38

18,500

Samsung 
SyncMaster 955DF

19
18
Y

0.26
50 - 160
30 - 85

1600 x 1200 @ 68 
135

ShadowMask
440 x 454 x 461

19
N
Y

Manual, driver CD

3
5

18.25
3.75
31.5
16.75

16
30.95
46.95
1.76

16,000

Aperture Grille: Invented by Sony, this technology uses a series of
thin, closely-spaced, vertical wires, to isolate the pixels
horizontally. To keep the vertical wires in an Aperture Grille
properly aligned within the picture tube, one or two horizontal
‘damper’ wires are required. Monitors manufactured with
Aperture Grille are sharper and clearer.
Colour temperature: This is the amount of white on the screen,
and is measured in degrees Kelvin. Colours used in images such as
landscapes, or pictures of people, look better when displayed at a
colour temperature of 6500 K. However, regular black text on a
white background is better displayed at 9300 K.
Sharpness or Convergence: This refers to the convergence of the
three different electron guns—red, green and blue. The closer the
dots fall, the sharper the image is.
Dot pitch: This is the distance from the centre of one phosphor
dot to the centre of the nearest dot of the same colour, on the
line directly above or beneath. The closer the dots are, the smaller
the dot pitch, and the sharper the images.
High voltage regulation: This is the ability of high voltage to
respond to changes in current. Good high voltage regulation
means a stable display, even when changing intensity levels.
Horizontal Scan Frequency (Scan rate): The number of lines
illuminated on a video screen in one second, or how fast each of
the horizontal lines that make up the display are scanned,
measured in kilohertz (KHz). High scan rates are required to
provide sharper images at higher resolutions.

Interlaced and Non-Interlaced: In order to create a picture on
the screen, the screen is divided into lines that get illuminated. In
non-interlaced mode, the lines are illuminated sequentially, several
times a second. In interlaced mode, the lines are not continuous—
they are in two sets, alternating with each other, both sets being
illuminated at the same time. This translates to flicker.
Magnetic field effect: A steel cabinet or desk, or magnetically
unshielded speakers, may interfere with the picture tube’s electron
beams. This causes the screen to show myriad hues of blue or red.
Persistence of vision: This is the ability of the human eye to
retain an image after the image has been taken off the screen.
Contrasting screens, such as a black screen shown immediately
after a white screen, or the movement of a white block on a black
background, illustrates this phenomenon. 
Pincushion: This is the effect of the inward curve of a video
image, like an hourglass. All monitors experience this to an extent.
Pixel: Short for picture element, a pixel is a single point in a
graphic image. Monitors display pictures by dividing the display
screen into thousands (or millions) of pixels, arranged in rows and
columns. It is the smallest point on a screen that can be
illuminated. A pixel may only be one colour at any given time, so
the image you see is the sum of all the pixels on the screen. The
more the pixels, the better the resolution.
ShadowMask: This is a thin screen full of holes, attached to the
back of a colour CRT’s viewing glass. The electron beam is aimed
through the holes in the mask onto the phosphor dots.

Jargon Buster
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If you’re looking forward to buying an LCD monitor in India,
well, you just chose the wrong country. LCD monitors are,
in general, expensive here. But the good news is that last
year, 15-inch LCD monitors got cheaper and better. 
The levels of acceptance in a corporate environment were

much higher than ever before, and the rub-off effect was felt in
the home segment, too. This year, two major players—Sony and
Sharp—are out of the market, while there’s a new entrant in the
form of BenQ. Meanwhile, the cheapest 15-inch LCD was the
one from ViewSonic. Presenting a complete rundown on the 13
monitors that landed on our desks for testing.

Features
A higher contrast ratio means a monitor can be viewed well under
different lighting conditions; for example, a monitor with a very
high contrast ratio can be viewed in the dark without too much
eye-strain, and at the same time, in bright sunlight with all colours
visible clearly.

The CMV CT-259A and CT-522A have a contrast ratio of 500:1,
and the others range from 350:1 to 400:1. The CT-259A also has a
high brightness level of 450cd/m2, which will add a dimension to
your movie-watching experience. On the other hand, the Digi-
View DGL-115AS has a poor contrast ratio of 250:1.

You’d consider space saving as an important aspect of LCD
monitors, so depth obviously is one of the important parameters
for judging. The HCL HCM 500LSA saved most space, with a total
depth of 160 mm including the base, followed by the Digi-View
DGL-115AS, with a depth of 173 mm. However, the HCL monitor’s
speakers are on the vertical support, and are therefore too close to
each other—so much so that the stereo effect is completely lost. 

Another factor is power consumption: LCD monitors
consume less power compared with their CRT counterparts. The

15-inch LCD Monitors

CATEGORY LCD MONITORS 15”

Brand
Model

Pixel size (mm)
Luminance (cd/m2 )
Contrast ratio
Vertical scan rate (Hz)
Horizontal scan rate (KHz)
Maximum resolution
Video bandwidth (MHz)
Response time (ms)
W x H x D (mm)
Weight (Kg)
In-built speakers (Y/N) / watts
VESA Wall Mount
Swivel—vertical/horizontal axis
Power Consumption
Bundled Accessories

Performance
DisplayMate tests
Sharpness and Resolution (out of 10)
Greyscale range (out of 60)
Miscellaneous tests
Viewable angle test (degrees)
Image persistence (scale of 5)
OSD usability test (scale of 5)
Overall Scores
Features
Performance
Overall Score (Performance + Features)
Value for money
Price (Rs)
Grade

BenQ
FP567s

0.297
250
400:1

75
63

1280 x 1024
80
16

354 x 362 x 190
3.5
Y
Y

N/Y
40

Power cord, data cable,
manual, audio cable, iKey

adjustment software,
driver 

6.25
36.5

150
4

3.25

25
28.36
60.21
2.62

23,000

CMV
CT-529A

0.297
450

500:1
50 - 78
28 - 65

1024 x 768
NA
16

348 x 334 x 186
2.6

1.5 W x 2
Y

N/Y
33

Power cord, power
adapter, audio cable,
data cable, manual on

CD

6
37.5

150
3.75

3

28
35.44
63.44
3.17

20,000

ACER
AL511

0.297
250
350:1

75
60

1024 x 768
NA
40

353 x 368 x 204
3.2
N
Y

N/Y
35
NA

6.25
31.25

150
3.25
3.5

15
33.45
48.45
2.42

19,990

CMV
CT-522A

0.297
250
500:1

55 - 78
28 - 65

1024 x 768
NA
16

365 x 399 x 181
2.3

1.5 W x 2
Y

N/Y
33

Power cord, power
adapter, audio cable,

data cable, manual on CD

6.5
38

150
3.75

3

27
36.55
63.55
3.18

20,000

HCL
HCM 500LSA

0.297
NA
NA

55 - 75
30 - 60

1024 x 768
80
40

356 x 356 x 160
3.7
Y
Y

N/Y
30

Audio cable, manual, driv-
er on floppy

6.75
35.75

150
3.75
3.5

19
28.95
54.55
2.48

21,990

Digi-View
DGL-115AS

0.297
250

250:1
50  - 70
29 - 60

1024 x 768
NA
25

385 x 375 x 173
3.3
Y
Y

N/Y
36
NA

6.5
37.25

150
3.5
3

18
27.56
52.91
2.69

19,690



Philips 150C was the most energy-efficient, with a power
consumption of only 18W, compared to the 40W typically
consumed by 15-inch CRTs. The BenQ FP567s, meanwhile, is the
most power hungry-panel—it needs a good 40 watts.

But when it comes to looks, nothing beats the BenQ
FP567s—it comes loaded with a white front panel, a black stand,
and a silver-grey strip at the bottom that houses the speakers and
buttons. The Samsung SyncMaster 152s has a sophisticated look,
making it more suitable for corporates: the body is dual-tone sil-
ver-grey and black, with tiny chrome-plated buttons.

Performance
With a new monitor, the first think you’d probably look at, and
the first thing you’ll definitely be shown, are the features. 

Caveat Emptor. Never ever ignore performance. We used Dis-
playMate Video Edition to test performance, as well as other mis-
cellaneous tests, to bring out the performance issues and high-
lights of each monitor.

The point shape and visibility test is important for any kind
of user, because it checks how well a monitor displays a detail as
small as a dot. It checks, for example, whether the monitor dis-
plays a black full-stop as a black full-stop, or as a small square in
a different colour. The Samsung 152s was ahead of the rest: a
round white dot appeared perfectly round and white, without
additional colours—red, green or blue—visible at the edge, which
is not the case with most of the other panels. 

However, most panels performed reasonably well in this test,
with very little pixel bleeding at the edges.
The CMV CT-522A also returned accept-
able results, albeit with some slight bleed-
ing at the edges.

As for video bandwidth, the higher it is
the better, but all the panels we tested had
a rated bandwidth of 80 MHz. In the video
bandwidth test, we use thin white lines
separated from each other by a distance of
just one pixel, and we then try to see
whether the lines appear distinct.

The Samsung 152s performed very well
here, and we could see the lines as distinct
even from a distance of 2 to 3 feet. We there-
fore recommend the 152s to users of page
layout software, or, for example, fashion
designers, since the monitor displays the
finest of details. Some panels, such as the
Philips 150X didn’t perform too well—the
lines could not be distinguished, and looked
like a single block. 

The Samsung 152s, along with the
CMV CT-522A and Philips 150X, did not
display any streaking or ghosting. This is
good for people who work mostly on doc-
uments and spreadsheets, where bright and
dark areas can be adjacent to each other. 

These three panels are also good for
movie-watching, because there won’t be
shadowing on the screen. In the white and
black level shift test, there’s a sharp edge
between a white and a grey block. The CMV
CT-522A performed very well here. Graphic
artists would be interested in this, because
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CMV CT-522A

The CMV CT-522A was amongst the best
performers when it came to detail and

colour reproduction. The  ‘auto’ setting but-
ton is featured. It’s ideal for SoHo and cor-
porate office use—it has a better brightness
and contrast range, and is also good at
reproducing finer details. Home users, too,
can consider this monitor, given the com-

petitive price tag of Rs 20,000.
The power rating is 33 W, which is in

line with other LCDs. The monitor looks
decent, with a dual-tone black and silver-
grey body. The bottom support is firm,
which is important for equipment as
delicate as an LCD panel.

The speakers are rated at 1.5 W,
which is good enough for system
sounds—but not really for music, for

which we recommend getting sepa-
rate speakers.

+ Firm bottom support, ‘auto’ button for
screen adjustment
– Speakers not adequate
Price: Rs. 16,500

Samsung 
SyncMaster 152s

0.297
250

350:1
56 - 75
30 - 61

1024 x 768
80
25

357.5 x 346.7x 184.5 
2.9
N
Y

N/Y
31

Manual, data cable, audio
cable, power cord, power

adapter, wall-mount
accessories, natural

colour software, driver

7.5
36.25

150
4
4

22
29.8
58.45
2.69

21,720

Philips
150C

0.297
250

400:1
56 - 76
30 - 61

1024 x 768
80
30

360 x 356 x 177
4.55

N
Y

N/Y
18

Power cord

6.25
34.25

150
3.75

3

18
27.32
51.33
2.44

21,000

NEC
AccuSync LCD51V

0.297
250

400:1
56 - 75

31.5 - 60
1024 x 768

NA
25

347.4 x 341.9 x 183.5
3
N
Y

N/Y
24

Manual, power cord

6.25
39.5

150
4

3.75

21
29.3
58.10
2.58

22,500

Philips
150X

0.297
250

400:1
56 - 76
30 - 61

1024 x 768
80
25

360 x 358 x 177
4.63

1 W RMS
Y

N/Y
20

Power cord

6.25
37

150
3.25

3

20
28.08
55.49
2.52

22,000

Viewsonic
VE155s

0.297
250
400:1

50 - 75
30 - 62

1024 x 768
80
30

356 x 344x 200 
3.7
N
Y

N/Y
30

Driver, manual on CD,
quick start guide, data

cable, power cord

6
36.25

150
4

3.75

20
28.65
55.35
3.08

18,000



poor performance on this test means graphics can look dull and
lifeless. Sharpness demands that the colour change sharply 
at edges.

In the 16 intensities test for primary colours, the CMV CT-
529A and the NEC AccuSync LCD51V were good performers. What
this shows is that the auto-calibration feature of these panels is set
better than on the others. This test is of importance for digital
imaging artists, and, especially, layout artists who make marketing
collateral, brochures and magazine covers—where proper colour
reproduction and variation amongst shades is critical. 

The viewable angle test saw amazing consistency: All panels
were visible from 150 degrees. However, different panels had
their issues—some displayed a slight red tinge, and others a slight
blue tinge, at wide angles. We suggest users sit right in front of
the monitor, and if there are more people around, it would be a
good idea to space them all within the 120-130 degree range. 

At the end, in the 15-inch LCD category, it was the two CMV
models that made it to the top. A 0.11-point difference in per-

formance scores between the CT-522A and 529A was the decider,
and we awarded the CT-522A both the best performance and
best value award.

Conclusion
The 15-inch LCD category is hot right now, because of falling
prices. In our tests, it was close competition between the CMV,
BenQ and Samsung monitors.

The CMV monitors got to the top slot—they have better fea-
tures as well as commendable performance. The BenQ FP567s
wasn’t far behind, though. It’s also a great looking model. The
Samsung 152s returned some terrific results in a few tests—it
carved a niche for itself; it’s a great monitor when finer details
are more important.

The Acer AL511 and the Philips 150C aren’t really up to the
mark in this category, whether it’s about features or performance.
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When we first saw the iMac, we were surprised by its size,
but amazed by the quality and clarity of the display. The

sad part is that this display is only available with the iMac. So,
Apple came out with the dazzling Cinema Display series, but
stubbornly kept its connectivity options limited to Apple
computers. The Cinema Display that we got had the same
issue, but a little research revealed that adapters that will let
you connect them to regular PCs are available.

The Apple Cinema Display comes in a 20-inch wide-screen
version, but even bigger ones are available. The display is
encased in a stunning fibre-glass body, and is lighter than the
LG 23-inch. This unit could not be tested using our standard
tests, as we couldn’t connect it to a PC. Also, the resolution on
the Apple G5 was set to 1,680 x 1,050, which isn’t available on
the PC. It should default to 1,600 x 1,024 if connected to a
computer with a high enough resolution for this monitor. As of
now, only 3DLabs has made a video card—the Oxygen
GVX420—which supports the Apple display natively.

We received a G5 to test this display, and it was just magi-
cal. We just couldn’t find any dead pixels, bright spots or colour
differences; in fact we couldn’t find anything wrong at all. We

put on the Terminator 2:
Judgement Day DVD to
check the quality of the
display, and found
ourselves ducking to
avoid bullets. Images
were razor-sharp, and
colours as vibrant as
we’ve ever seen. In short,
this monitor is
absolutely brilliant.

The Apple Cinema
Display will find favour

with all users who use Macs for video editing and designing. As
for PC users, help is at hand in the form of third-party solutions
that allow you to connect it to a PC, but you’ll need a heavy-duty
card that can support a resolution of 1,600 x 1,024 with ease. 

+ Excellent display quality
– Cannot be connected to a PC without third-party connectors
Price: Rs 86,600 plus taxes

Apple Cinema Display 20-inch

DECISION MAKER

A compact monitor for your
small office where display
quality is important, with
low power consumption

An LCD panel, as it con-
sumes less power and saves a
lot of space. It is flatter and
brighter than a CRT monitor,
and strains your eyes less
CMV CT-522A, Samsung
SyncMaster 152s

Rs 18,000 - 22,000

A monitor for gaming use,
where high refresh rate,
brilliant colour reproduc-
tion and brightness are
important
A 19-inch or 21-inch
Aperture Grille monitor for
the best results. Also make
sure it can handle a refresh
rate of 75 Hz at 1,600 x
1,200 pixels
Philips 109P4, NEC
MultiSync 912SB

Rs 18,000 - 25,000

A monitor for home
use—working on docu-
ments, e-mail, surfing the
’Net and playing games
over the weekend
A compact monitor that
has 110 MHz video band-
width for better refresh
rates at high resolutions

Samsung 763MB, LG
E700S

Rs 8,500 - 9,500

A monitor for designing and
graphics applications. It
should be able to reproduce
fine details and  colours, and
offer accurate geometry
For best geometry results,
17-inch or larger LCD pan-
els are best. You can also 
try 19-inch Aperture Grille
technology-based CRT 
monitors
Samsung SyncMaster
1723MP, Samsung
SyncMaster 172s, NEC
MultiSync 912SB (CRT)
Rs 24,000 - 38,000

A monitor to watch DVD
movies, VCDs and TV
programmes

A wide format (16:9)
LCD is what you should
look for. Also look for
wall mounting capability

LG L2320A, Philips 170T

Rs 50,000 - 1,85,000

You need

Look for

Our pick

Price
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17-inch LCD Monitors

OK, first a damper. Seventeen-inch LCD monitors are
expensive—one panel costs as much as a fully-func-
tional PC. However, prices here too have fallen, and
the cheapest model this year is Rs 27,000—a drop of

around 30 per cent from last year’s Rs 38,000. But it is still an
expensive proposition to buy one.

For our comparison, we tested 13 models from nine brands.

Features
The Samsung 173P offers the best contrast ratio and brightness
of 700:1 and 270 cd/m2 respectively, as per the specification
sheet, making it the best choice for movie viewing and gameplay.
The higher brightness means that that you can adjust the mon-
itor to a higher brightness level when needed, while being able
to reduce it when working with white backgrounds. 

The brightness figure of 270cd/m2 can light up the screen
enough so you can view weapons placed on a corner table in a
dimly lit room of an action adventure game. The contrast ratio
of 700:1 can help adjust the monitor to get it to display any
colour or shade; the slightest difference between shades become

visible. This monitor also has highest video bandwidth—
140MHz—of all the monitors in the comparison, allowing it to
reproduce fine details at a higher resolution and refresh rate.

The pixel response time, which is the time each pixel takes
to switch on or off, was the lowest in the Acer AL712 and the
Umax V7, at 15ms. This means that the image quality on these
panels should be the best, but low response time is not the sole
criterion for performance; we didn’t see either of these models
top any of the performance tests.

Speakers are, more or less, considered a default accessory
with LCD panels, and most of the panels we compared featured
speakers, except for those from two vendors—Samsung and LG.
If you want to wall-mount a panel, opt for the light Philips 170N.
But a good set of speakers will set you back by another Rs 1,500
or so, eat up desk space, and increase wire clutter.

One good improvement in design we came across, compared
to the LCDs of last year, was the drilled hole (see box ‘VESA Wall
mount’), provided with every monitor we tested. However, we

Samsung SyncMaster 173P

This monitor is such a pleasure to look at,
you’ll watch it even when it’s off. The

panel has a round bottom with a silver lin-
ing, and a front panel just an inch in
thickness. The panel can be height-adjust-
ed, and can be both tilted and swivelled.
The front panel has just one silver
button—the power button. 

The 173P is also the only
17-inch LCD we tested that
features the landscape and
portrait modes. These
features make the 173P a
good display solution for
professional use; it could also
be used in showrooms and
restaurants, gelling with the
interiors. 

And the performance is definitely something to write
home about: the 173P returned the best results in the 64-
intensities aspect of the primary colour test. The test screen
was one of the more difficult ones to produce: there were 64
shades ranging from black to white, and this monitor repro-
duced them all brilliantly.

The only sore point about the 173P is the separate power
adapter, which is bulky and hard to manage. At Rs 47,500,
it’s definitely on the higher side, but it’s worth the money if
you want the best.

+ Very good performance
– Bulky power adapter, expensive
Price: Rs 47,500

Video Electronics Standards Association (VESA) is a non-profit
organisation that sets standards for displays. These standards are
adhered to by most display (CRT and LCD) manufacturers world-
wide. VESA Wall Mount is the standard set by VESA, using which
any brand of monitor can be mounted using any third party
VESA-compliant wall mount fixture. Here we’ll see how to fix an
LCD with wall mount fixtures, and hang it on a wall.
1. First things first: check whether the LCD panel is wall-
mountable.  Look for four drilled holes
at the back of the panel, at a distance of
either 75 mm or 100 mm.
2. After this, remove the stand, or if the
design allows, fold it. Now it’s time to
fix the sheet metal back plate—this
comes bundled with some monitors,
and can be bought from the manufac-
turers or third party vendors—which has
four U-shaped pegs that fit into the grooves of the plate. 
3. Now, the other plate that’s provided must be fixed on the
wall where the panel is to be mounted,
with the help of bolts.
4. Match the four pegs of the back
plate with the ones on the wall and
hang the monitor.
5. Apply a little pressure on the panel
to check whether the panel is secure-
ly fixed.

You can also opt for a mounting
arm, which will offer you the flexibility
of being able to move the LCD panel back, forward, up and
down. This is more suitable for showroom owners and reservation
counters.

VESA Wall Mount
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have serious doubts about the availability of accessories such as
bolts, back plates and arms that are fitted on the wall. We think it’s
time LCD vendors began to offer these as standard accessories.

OSD (On Screen Display) buttons are the set of buttons on the
monitor using which you set the different parameters of the mon-
itor, such as brightness and contrast, geometry, and so on. We found
the Samsung 172s to be the best in terms of ease and access of OSD
buttons. The Samsung 173P, on the other hand, doesn’t have any
buttons on the panel for OSD functions; it comes with the Magic-
Tune software to take care of OSD functions.

Landscape-to-portrait mode is a great feature—it’s very useful
while browsing through a long Web page or Excel sheet. The Sam-
sung 173P was the only model to offer this. 

The 173P comes bundled with the Pivot Pro utility which, once
installed, rests in the taskbar and allows the user to switch from
landscape to portrait mode at the press of a button. Of course, you
need to physically rotate the screen. The 173P was also the only
monitor to have just a power button onboard. The MagicTune util-
ity is provided to take care of OSD functions. This approach is both
good and bad. It’s good because you have no buttons on the panel,
which adds to the look, and besides, people are more comfortable
using a mouse rather than tiny buttons.

It’s bad because, if the software is deleted and you don’t have
the installation CD handy, you’re stranded until you get the soft-
ware from somewhere, somehow!

CMV CT-722A

The CMV CT-722A is the 17-inch LCD of
choice for budget users. It’s one of the

cheapest 17-inch LCDs available, and doesn’t
miss out on anything as far as performance
goes. You won’t regret having
bought this monitor, whichever
way you look at it. In the looks
department, it sports the dual-
tone black and silver-grey look,
which is the in thing right
now. There’s an ‘auto’ button
that takes care of monitor
adjustment—the geometry as
well as the contrast and 
brightness.

Rs 27,000 means this panel is
affordable for many SoHo users.
Home users would be advised to wait another year for the
price to drop further.

+ Affordable; ‘auto’ button for display correction, looks great
– None
Price: Rs 16,500

CATEGORY LCD 17”

Brand
Model

Pixel size (mm)
Luminance (cd/m2)
Contrast Ratio
Vertical Scan Rate (Hz)
Horizontal Scan Rate (KHz)
Maximum Resolution
Video Bandwidth (MHz)
Response time (ms)
W x H x D (mm)
Weight (KG)
Built in Speakers (Y/N) / Watts
VESA Wall Mount (Y/N)
Swivel/Tilt (Y/N)
Power Consumption
Bundled Accessories

Displaymate Video Edition
Sharpness and Resolution (out of 10)
Greyscale range (out of 60)
Miscellaneous tests
Viewable angle test (degrees)
Image persistence (scale of 5)
OSD usability test (scale of 5)
Overall Scores
Features
Performance
Overall Score (Performance + Features)
Value for Money
Price (Rs)
Grade

BenQ
FP767

0.264
260

500:1
56.25 - 75
31.47 - 83

1280 x 1024
135
16

382.7 x 404.3 x 200
3.5
Y
Y

N/Y
50 W

Manuals, colour pro-
file, driver, calibrat-
ing software, data
cable, audio cable,

power cord

6.75
37.25

150
3.5
3.75

30
40.3
70.3
3.08

32,000

CMV 
CT-722A

0.264
400

450:1
50 - 76
28 - 62

1280 x 1024
NA
16

400 x 388 x 192
4.3

Y / 2.5 W x 2
Y

N / Y
45 W

Quick setup guide,
electronic manual

6.75
37.5

150
3.75
3.5

26
39.45
65.45
3.39

27,000

Acer
AL712

0.264
250

500:1
56 - 76
24 - 80

1280 x 1024
110
15

374 x 394.5 x 204
5.9
Y
Y

N/Y
54 W

Power cord

6
36.75

150
3.5
3.25

25
39.45
64.45
2.91

30,999

NEC
MultiSync 1760NX

0.264
260

450:1 
75
81

1280 x 1024
NA
16

374 x 343.8 x 205
6.3
N
Y

Y/Y
38 W

Naviset colour pro-
file, driver, manual

5.75
5.75

39.25
150
3.75
2.5
2.5
28
28

39.5
67.5
2.74

34,500

Samsung 
SyncMaster 173P

0.264
270

700:1
56 - 75
30 - 81

1280 x 1024
140
25

382 x 236.2 x 395
6
N
Y

Y/Y
40 W

Natural colour, Pivot
Pro, MagicTunes soft-
ware, drivers, wall-
mount accessories,

DVI-Data cable, man-
ual, power cable

adapter, Power Cord
6.5

42.75
150

3.875
3.625
3.625

36
36

44.3
80.3
2.25

47,500

LG
Flatron L1720B

0.264
250

450:1 
56 - 75
30 - 83

1280 x 1024
110
16

394 x 412 x 128
4.8
N
Y

N/Y
40 W

Power cord, data
cable

6.75
36.625

150
3.75
3.5

25
39.35
64.35
2.82

32,000

Philips 
170N

0.264
260
400:1

56 - 76
30 - 82

1280 x 1024
135
25

399 x 398 x 197
4.7
Y
Y

N/Y
40 W

Data cable, power
cable, audio Cable

5.75
42.25

150
3.75
3.75

29
43.25
72.25
3.37

30,000
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Performance:
The contest between the Samsung 173P and the Philips 170N
was close, with just a one-point difference in scores between them.
Lack of features such as height adjustment, and absence of colour
calibration, made the Philips lose out on the overall score. How-
ever, if you just consider performance, the winner was the Sam-
sung 172S.

In the point shape and visibility test, the Samsung 172S
returned the best results, with the dot reproduced perfectly, with-
out any pixel bleeding—this means it’s a good choice for design-
ers, graphic artists and movie editors.

The Umax V7 was the best performer in the video bandwidth
test—this means the V7 is a good choice for playing games at high

resolutions. Also,
3D software users
can take advan-
tage of its video
bandwidth, as the
monitor affords
higher resolutions
and refresh rates.

In the streak-
ing and ghosting
test, the Samsung
173P and the
Philips 107N
returned impres-
sive results. We
strained our eyes
trying to find
some slight
streaking or
ghosting, but
there was none.
These two are,
therefore, good
for movie buffs.

The Philips
170N returned
excellent results
in the level shift
test, with no pixel
bleeding at the
edge. The Acer
AL712 fared poor-
ly here. People
who use image-

restoring software, and also those who do image editing, should
consider the Philips 170N. 

All the monitors we tested gave average results in the text-
colour combination test. We observed that text in magenta was
consistently reproduced poorly, by all the panels. Magenta on dark
colours, especially, appears crooked, and prominent black dots are
visible between the magenta dots. The same was the case with red
text on a dark background. We therefore advise marketing and
sales people in advertising agencies to stay away from LCDs alto-
gether for presentations, where dark backgrounds and coloured
texts are used.

In the colour scales test, colours are presented from their dark-
est to their brightest areas. The NEC MultiSync 1760NX did the
best. This was the only LCD where we could see the darkest as
well as the brightest blocks. Other panels missed out on either the
darker or on the brighter side.

The Samsung 173P stole the show in the performance
department. It also scored high on looks, something which is
very important for an expensive, lifestyle product such as an
LCD panel.

Conclusion
Though LCD monitors are expensive, once you take a look at one
of these beauties, you’re sure to get hooked. There are 17-inch
LCD monitors for all kinds of buyers—from those who want the
best, to those who look at the price tag. Each monitor has its fea-
ture set and performance level, and is priced accordingly. Price
drops will probably happen soon enough. We can also expect to
see more vendors entering the market.

ALIASGAR PARDAWALA

aliasgar_pardawala@thinkdigit.com

BHASKAR BANIK

bhaskar_banik@thinkdigit.com

CMV

Cee Vision Technologies
Pvt.Ltd.
022-26733353
chemoplastmumbai@vsnl.net
www.cmv.com.tw

Samsung 

Samsung India Electronics Ltd
011-51511234
marketing@samsungindia.
com
www.samsungindia.com

Digi-View

D-Link India limited
022-26526696
sales@dlink.co.in
www.dlink.co.in 

Samsung*

Savex Computers Ltd
022-22886161
www.samsungindia.com
* Samsung SyncMaster
150MP plus* Samsung
SyncMaster 773s

BenQ

BenQ India Pvt ltd
022-25705231
hcsheth@esysmail.com

Philips

Philips India Ltd
022-56912325
PCP.India.Info@philips.com
www.philips.com 

HCL

HCL Peripherals
044-34539847
kiruba@hclp.com
www.hclp.com 

Umax

Neoteric Informatique
022-24172600
sales@neoteric-info.com
http://www.neoteric-
info.com

LG

LG Electronics India Pvt
Ltd
0120-2560902
response@lgezbuy.com
www.lgezbuy.com 

Viewsonic

Priya ltd
022-56663100
sejal.shah@priyagroup.
com
www.viewsonic.com

Acer

Acer India Ltd
080-5219520
rajesh_aiyer@acer.co.in
www.acer.co.in

Microtek

Microtek International
Ltd
022-28362407
an.bom@mtk.sril.in

Umax 
Maxvison V7

0.264
250

400:1
56 - 75

31.5 - 80
1280 x 1024

NA
15

413 x 414 x 195
5.13

Y
Y

N/Y
NA

Manual, power
adapter, data

cable, audio Cable

7
39.25

140 - 145
4

2.75

22
41.05
63.05
3.04

29,000

Samsung 
SyncMaster 172s

0.264
270

350:1
56 - 75
30 - 81

1280 x 1024
135
25

385 x 396.3 x 216
4.7
N
Y

N/Y
42 W

Manual, natural colour
driver, data cable,
power cord, power
adapter, wall mount 

6
42.2

150

4
4

27
44.65
71.65
2.80

36,840

Samsung 
SyncMaster 172MP

0.264
250
700:1

56 - 75
31 - 81

1280 x 1024
135
25

412 x 415 x 203
4.9
Y
Y

N/Y
58 W

Manual, natural colour
driver, data cable,

power cord, external
TV tuner card, remote

control

6.75
25

150
3.75
3.25

31
31.75
62.75
1.42

61,800



Handhelds are much more than souped-up digital diaries; a good Per-
sonal Digital Assistants (PDAs) can completely change the way you
work and play, especially while on the move.

Since the introduction of the first Palm Pilot in 1996, the Palm OS has been
the defining factor in the adaptation and evolution of mobile computing. With
a Motorola 16 MHz processor and 128 KB of memory, the Palm Pilot 1000 was
the first device to feature the Palm OS (v1.0). Since then, the OS has seen numer-
ous revisions and upgrades, continually improving over time. 

With a majority market share and millions of devices sold, the Palm OS has
become the standard for mobile computing. A wide variety of devices running
Palm OS, suitable for different user categories, are now available. The OS also
enjoys excellent support from software developers and hardware vendors alike—
with loads of options from third-party vendors and independent developers.

Add-on products, such as expansion cards, wireless keyboards, modems,
etc., are easily available. Apart from all this, ease of use, great compatibility with
Windows-based programs, minimal memory usage and long battery life make
devices running on the Palm OS a popular choice world-wide.

Palm devices currently run the v5.x platform. New developments on the OS
front include the Palm OS Garnet and Cobalt. Palm OS Garnet is an enhanced
version of Palm OS 5, and provides support for a broad range of screen resolu-
tions, dynamic input area, improved network communication and Bluetooth.
Cobalt-Palm OS 6 is the next generation of the Palm OS, and has been designed
from the ground up, to support new classes of device such as smartphones. 

On the hardware front, we've already been seeing a range of Palm OS
devices, right from entry-level solutions for first time users, to business PDAs
with stretch displays, and smartphones such as the Tungsten W. To help you
make an informed decision, we look at some devices running the Palm OS.

DEEPAK DHINGRA

deepak_dhingra@thinkdigit.com
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Imagine scheduling
an urgent meeting,
calling up all the
executives and
getting all the other
things on the agenda
in place—all from the
Palm in your hand. 
Here are seven PDAs
that vie for your
attention and
promise you that...
and more!
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The Palm Zire 21 is ideal if
you just want some-
thing that helps you

organise your life, without
being too heavy on the pock-
et. But considering its limited
features, we’d recommend that
even if you’re a first-time user,
you should buy a Zire 71—if
you can afford it, of course.

Design-wise, the Zire 21
sports plain, yet elegant looks.
It measures 4.4 x 2.9 x 0.6 inch-
es, and is the lightest of the lot
at 108 gm. Encased in a plastic
body, with a white front panel
and grey application buttons,
the device runs Palm OS 5.2.1.

It’s a significant upgrade
from the original Zire. The
screen is 160 x 160 greyscale,
and displays 16 shades of
grey. The 126 MHz TI
OMAP311 processor is
probably over-pow-
ered for most applica-
tions you’re likely to
use on the Zire 21.

Going by the
features provided,
you’ll use the

device mostly for its PIM functionality, so the 7.2 MB of user-avail-
able storage should be more than enough to store your contacts,
to-dos and notes.

It’s an ergonomically good device. There’s no backlight, how-
ever, so you can’t view the display in the dark. The internal bat-
tery lasted us a cool 11 hours and seven minutes. 

There’s no card expansion slot and no universal connector
either, which puts expansion capabilities at zero. In terms of con-
nectivity, you only get Infra-red to pair it with a compatible device.
There’s no cradle, and the internal battery can be charged through
the provided AC adapter. The battery also charges when it’s con-
nected to a PC through a USB port.

The Zire 21 comes with standard Personal Information Man-
ager (PIM) applications including Date Book, Address, Calculator,
To-do, Notepad and World Clock. You also get other useful appli-
cations such as Handmark’s MobileDB, Handmark PDA Money,
Palm Reader, PowerOne Personal Calculator and Handmark’s Mag-
icDogs Playing Cards.

Palm Zire 21

+ Economical
- Lacks features
Price: Rs 7,249

Palm Zire 21

Performance
Features
Ergonomics
Value for money

A-A-

The complete range of Palm OS-based PDAs was tested on the
parameters of features, performance, battery life and ergonomics.
The weightages allotted were 55 per
cent for features, and 15 per cent
each for the rest. In features, we
looked for connectivity options,
screen capabilities, memory and
media playback capabilities, as well as
special features such as an integrated
camera and keyboard, among others.

To test performance, we used
Benchmark 2.0, PilotMark and
Speedy 3.3. Benchmark 2.0
performed the CPU and memory-
intensive Fibonacci calculation test,

and provided a percentage score relative to the Palm IIIe.
PilotMark showed the time taken by the device to read, write

and copy 1 MB of data. Speedy 3.3
tested the CPU, memory and
graphics, and gave a score relative
to the Palm Vx.

To test battery life, we set the
screen brightness and volume to 50
per cent, and played a movie trailer,
looping continuously until the
battery died. 

Ergonomics took into account
button placement and tactile feel,
how easy the device was to hold
and use, and so on.

How We Tested

The Zire 21’s 160 x
160 greyscale screen
does not have a backlight.

Ü



If the Palm Zire 21 is targeted at budget
users, and the Palm Tungsten series is
meant for the business class, then the Zire

71 is for the rest of us. 
With a blue and silver combination, the

PDA stands out from the pin-stripe crowd.
Apart from the 320 x 320 colour screen, there’s
a five-way joystick and four application buttons
on the front panel. The SD card slot, IR port
power button, stereo jack and stylus access are
on top. The speaker is placed on the metallic
rear panel, while the Palm Universal Connector
is, as usual, at the bottom. The handheld sits on
its cradle via this connector—which can also be
used to connect to other peripherals such as a
modem and a keyboard—and talks to the PC
via the USB port. The plastic stylus is very com-
fortable to use.

The Zire 71 is powered by the Texas Instru-
ments OMAP310, a 144 MHz CPU and runs
Palm OS 5.2.1. The handheld has 16 MB
of internal memory, which is adequate
for most, but we felt a little more
would be welcome.

Pulling out the metallic rear
panel reveals the 640 x 480
digital camera, and the
screen becomes the
viewfinder. Now you can
use the dedicated shutter button (hidden on the top of the slider),
or the joystick, to click pictures. Though there’s no flash, you can
adjust the resolution (160 x 120, 320 x 240, or 640 x 480) and save
images in the RAM, or on the memory card. The desktop compo-
nent of the Palm Photos application allows you to synchronise
images between the handheld and the PC. We really missed Blue-
tooth support, though.

The handheld comes with a good selection of software—an
SMS application, Audible Player for audio books, Kinoma Player
for movies, RealOne Player for MP3s, Palm VersaMail,
PowerOne Calculator for crunching tax returns and Adobe
Acrobat Reader for Palm. If you have an IR-capable cell phone,
and a subscribtion to the required services from your service
provider, you can link the Zire 71 and the cellphone to access
the Internet, send and receive e-mail, exchange SMS messages,

dial numbers from your PDA contacts list and even perform
wireless HotSync operations.

The 144 MHz processor is fast enough
for most applications and games. The hand-
held doesn’t have a full-battery charge indi-
cator. Also, the output from the headphone
jack isn’t decent enough. The screen,
though, is exceptionally clear, uniformly
lit and bright. 

The button layout is a pleasure to work
with. The five-way joystick lets you browse
with one hand, and the slider camera
operation can be accomplished single-
handedly as well.

The  images turned out better than
those we took with cellphone cameras.
However, since the shutter speed is a bit
slow, you’ll need to hold the PDA in
place after clicking a picture, to avoid
blurry images.

The mono speakers are badly
placed—at the rear of the unit. As a
result, alarms, game sounds and the like

come out as faint squeaks. Similarly, the
stylus could have been placed further away

from the power button—we accidentally turned off
the PDA on numerous occasions while attempting to retrieve the
stylus. We got a reasonable three hours and 14 minutes of con-
tinuous playtime using the Kinoma media player, with the bat-

tery fully charged.
With its funky

looks, integrated
camera and multi-
media capabilities,
the Zire 71 will
appeal to the youth.
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Palm Zire 71
n PDAs

+ Integrated camera
- Few connectivity options
Price: Rs 19,999

Palm Zire 71

Performance
Features
Ergonomics
Value for money

B-B-

test drive n

The Zire 71’s screen
becomes the camera
viewfinder when you open
the slider 

Bond’s suave expression on
the Die Another Day trailer

s



test drive n
n PDAs

77 MAY 2004

This entry-level business PDA is encased
in a slick metal casing. Running Palm
OS 5.2.1, the Tungsten E measures a

mere 4.5 x 3.1 x 0.5 inches and weighs just 130
grams. It can easily be slipped into a jacket or
shirt pocket.

The facia includes the 320 x 320 TFT screen,
and the traditional silkscreen area. Under this, you
find the rectangular five-way navigator with two
application buttons on either side. The stylus is
located in a partly covered silo, while the expansion
card slot, IR port, stereo headphone jack and power
switch are on top. The charging port and the USB
cable connectors are at the bottom, and the speaker is
at the back. The steel finish casing tapers inwards from
both sides, goading the E into conference rooms. 

For a business solution, this PDA has limited con-
nectivity options. You only get the card expansion slot
and infra-red; there’s no Bluetooth or wireless capa-
bility. Also, Palm has done away with the Universal con-
nector, and opted for a direct USB connection for PC

synchronisation.
A charger and

a USB cable, both
of which connect
directly to dedi-
cated sockets at
the bottom, come
with the package.
Playback of audio and video
clips is supported by the

bundled software. MP3 playback requires an external
memory card, though.

Standard PIM applications—calendar, con-
tacts, and world clock—come pre-installed, and
the calculator is installed at first HotSync. The
Software Essentials CD includes Documents
To Go, Palm Dialer, RealOne Mobile Player,
Kinoma Player, and Palm Reader, apart from
other useful applications.

The 126 MHz processor ensures smooth
playback of audio and video. The audio
quality from the integrated speaker is decent.
Usability is excellent, and synchronising the
device is a breeze. However, the rectangular
five-way navigator requires that you use
the tip of your thumb to scroll. Applica-
tion buttons, too, lack depth. In our bat-
tery drain test using Kinoma player, the
internal Lithium-ion polymer battery
yielded two hours and five minutes of

playtime before the device gave its first
low battery warning, but it ran another 42

minutes before shutting off.
The Tungsten E is ideal for a budget-conscious business user

who has no use for frills, so long
as he or she can be productive
on the move. 

Palm Tungsten E

+ Extremely light
- Lacks connectivity features
Price: Rs 13,999

Palm Tungsten E

Performance
Features
Ergonomics
Value for money

B-B-

The Palm OS is flexible enough to
allow for utilities that change the
icons and the look of the interface.
Some even change the way
applications launch, suggest colour
themes and backgrounds, and even
provide battery status, alternate data
input methods, etc. Do check
compatibility with your device, and
the Palm OS version, before you
start experimenting, though!

One such utility, SilkScreen
(www.rogame.com/pages/
SilkScreen.html), serves as an
application launcher and lets you perform all functions
associated with the silkscreen in the main display. It reserves
space at the four edges of the screen. Enable SilkScreen to use
four virtual buttons that perform the same actions as the buttons
in the graffiti area. You can also write in the main display area. A
menu lets you access any installed application, or on the
memory card. You can also check battery status and access the
virtual keyboard, brightness, and so on.

ZLauncher (www.zztechs.com/en/zlauncher.php4), lets you
change backgrounds, colour schemes and fonts. It includes a
theme manager, and a file manager that gives you access to all
data stored on the device, or on the expansion card. Besides
standard operations such as deleting,
organising, copying and moving data,
the file manager also lets you beam a
file directly. You also get battery and
memory status, a virtual power-off
button and so on.

SilverScreen (http://www.pocket
sensei.com/silverscreen.htm) is another
popular application launcher. It has a
pop-up toolbar where you can drag
and drop application icons or files to
get info, categorise, beam, or delete
them. You can assign two applications
to hotspots, and get a list of recently-accessed applications.

Other interface enhancements include tab-based access to
various categories of application, and a ticker that displays to-dos
and appointments. Theme support is excellent, and you can
customise almost everything, including application icons, fonts,
battery status meter and even scroll bars.

Change that Look

The Agenda screen displays
appointments and tasks for the day

Enhance your usage experi-
ence with your Palm device
using SilkScreen

ZLauncher changes the look
and feel of your Palm device 
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The core business line of PDAs from Palm, the Tungsten
T and T2 are sleek and feature an innovative slide-out
design. Palm India doesn’t retail the T, but encour-

ages bulk buys from corporates.
Though both use the same processor and are exactly the

same in terms of design and features, the T2 is the later
model, running Palm OS 5.2.1; the Tungsten T runs Palm OS
5.0. This means that the T does not have Graffiti 2, Colour
Themes and Writing Area—Writing Area allows you to use
the entire screen as a Graffiti 2 input area. It also allows you
to see pen strokes as you write, if this option is selected.

Apart from this, there is a slight difference in body colour—
a gunmetal finish for the T, and metallic silver for the T2. With
32 MB of internal storage, the T2 has double the memory as
compared to its predecessor, and a transreflective colour screen
that’s better than the original Tungsten T display.

Both PDAs weigh 159 gms, and measure 4 x 3 x 0.6 inches.
Apart from the 320 x 320 colour screen, both have the circular
five-way navigation key, four application buttons, a small LED on
the top left and a speaker on the corresponding right side. Both
have a voice recorder button and a 3.5 mm stereo jack on the left.
Power buttons, expansion card slots and the IR ports are on top,
while the Palm Universal Connectors are at the bottom. The
spring-loaded stylus is concealed, and can be accessed by
pressing the protruding end. The bottom on both the units
slides out to reveal the graffiti area. If you want to access data

just by using the
stylus and the
buttons, you
can leave the
slider closed.

A clear
clip-on plastic
screen cover is cut out
to expose the five-
way navigator, so you
can peruse without
removing the cover.
You can also press
down once on the
button in the centre
of the navigator to
display the date and
time, or hold it down

to display the home screen, from which you can launch appli-
cations. The reset button now hides at the rear, and can only be

accessed with the slider open.
Moreover, the wider reset access hole

means that you can use the stylus
tip to reset the PDA, instead of
hunting for a pin or paper-clip.
The build quality for both is
excellent—even with the
sliding design—and both PDAs
feel rugged.

With Texas Instruments’
OMAP1510 ARM processors
running at 144 MHz, you get
Bluetooth, a voice recorder,
an external speaker, MP3 and
video playback. The PDAs
sync with a PC through the
accompanying USB cradle.

In terms of applications,
both PDAs come loaded
with the usual PIM appli-
cations. A generous bundle
of third-party applica-
tions—Documents to Go,
Chapura Pocket Mirror

(for syncing with Outlook),
BlueBoard, BlueChat, Handmark’s MobileDB, PowerOne Per-
sonal Calculator, Acrobat Reader for Palm, Palm Reader, Hand-
mark’s Monopoly, Handmark’s Scrabble—are provided on the
CD. BlueBoard lets you share ideas with up to three other Blue-
tooth users simultaneously, and you can chat using BlueChat.
Some applications—VersaMail, Web Browser Pro, WAP Browser,
Dialer and SMS—are on the CD bundled with the Tungsten T, but
come pre-installed on the T2. 

Though the Tungsten T is multimedia-capable, it does not
have any applications for music or video playback. This is reme-
died in the T2, in the form of the RealOne Mobile Player and
Kinoma Player and Producer.

3D games run without hiccups. Switching between applica-
tions, and viewing images and videos is fast. The colour screen
on the T is bright and evenly lit, while that of the T2 is even
better, showing better colour saturation. The speaker in front
means that unlike the Zire 71, sound isn’t muffled. The
internal lithium polymer 900 mAH battery on the T gave us a
good two hours and 37 minutes, while the T2 lasted for one
hour and 55 minutes before dying out.

With features such as voice memo, Bluetooth, sliding
design and multimedia capabilities, the T and T2 have a lot to
offer. However, if you are a corporate executive and already
own a Tungsten T, don’t con-
sider upgrading to the T2.

+ Compact size
Price: Tungsten T2: Rs 21,999,
Tungsten T: NA

Palm Tungsten T2

Performance
Features
Ergonomics
Value for money

C+C+

Pairing the Tungsten T2 with a Bluetooth-
enabled mobile phone is child’s play

Palm Tungsten T and T2

Ü
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Palm Tungsten T3

The top-of-the-line handheld in the Tungsten T series—the
Tungsten T3—features the same sliding design found in its
predecessors. It betters the older models with a display that

stretches automatically to 320 x 480 pixels when you
open the slider. Couple that with a faster
processor and more memory, and
the T3 certainly becomes a
package for power users.

Encased in a brushed alu-
minium body, the T3 weighs
155 gm and measures 4.3 x 3 x
0.66 inches when closed—
slightly longer than the T and T2.
The sides are slightly tapered to
better fit your hand. The front panel
buttons have been re-designed, and it
has an oblong five-way navigator,
around which four oddly-shaped
application buttons are arranged.

The design and placement of the
rest of the controls are the same as those
of its predecessors. A new addition is a
hinged door for the card slot when no
card is inserted, so the plastic dummy
cards that ship with the other models
are no longer needed. Deviating from
the plastic snap-on screen covers of
the T and T2, the T3 screen is cov-
ered by a removable leather flip. The
build quality is great, and you can expect years of faithful service.

The T3 is powered by an ultra-fast Intel XScale 400 MHz (PXA
255) CPU, and has 64 MB of in-built memory, 52 MB of which
is available. Other features included are voice recording, Blue-
tooth and media playback. But the best is yet to come: Though
it runs the same OS as the T2-v5.2.1, the T3’s stretch display and
virtual graffiti area adds a dimension to the user experience. 

Close the slider, and you’ll see the 320 x 320 screen with a
taskbar at the bottom. Open it and the display stretches automat-
ically to 320 x 480—the taskbar still at the bottom. The applica-
tions shrink and expand when you close or open the slider.  

Tapping the ‘expand’ button displays the virtual graffiti area
and the application icons. The main advantage of the virtual
graffiti area is that you can remap any of the four silkscreen
buttons to any application of your choice, and the icon
changes accordingly. Also, the Preferences module lets you
change the view to a virtual keyboard, or a wide mode that
hides the buttons at the side and provides dedicated writing
areas. Tap the rotate button on the task bar to rotate the
screen 180 degrees to landscape mode. The taskbar
moves, and the five-way navigator, too, changes its ori-
entation automatically. You can set rotation for either
left- or right-handed use in Preferences. 

Apart from standard applications such as Cal-
endar, Contacts, Tasks and Voice Memo, you get a
bunch of useful applications such as Documents
to Go, VersaMail, Dialer, SMS, Palm Photos,
RealOne Mobile Player and Kinoma Player,

Adobe Reader, Palm Reader, BlueBoard,
BlueChat, Java and Palm Web Pro browser are
included on the CD. This may seem like a

standard line-up, but quite a few enhancements
have been made to the applications in the T3. For

instance, Contacts now support multiple addresses, and
more fields for e-mail addresses, instant messenger accounts and
Web sites for each entry.

The 4 KB limit for memos has now been increased to
32 KB. An Agenda view in the calendar displays appointments,
tasks due and e-mail. Documents To Go v6—the latest—
supports native MS-Word and Excel formats, so no conver-
sion is necessary.

Bluetooth features also have some enhancements: you can
pick a Bluetooth device from an existing list, or from your trusted

devices, instead of searching for a device to pair with.
In terms of usage and performance, the T3 is great to

run heavy applications such as 3D games and movie clips.
The fast processor makes short work of whatever you
throw at it. Viewing applications in landscape mode is a
treat—especially reading eBooks, working on spread-
sheets and viewing photos. The power switch on the top
lacks depth, and you need to press it a little hard. Apart
from that, the ergonomics are excellent. The 900 mAH
battery gave us an hour and 55 minutes of continuous
playback in Kinoma.

Overall, the T3 is a PDA power user’s dream, and is 
a scorcher both in terms of raw power and features. 
The high price tag may deter quite a few prospective
buyers, though.

Top: The T3’s stretch display
with virtual graffiti
Right: Wider possibilities with 
landscape mode

Palm Tungsten T3

Performance
Features
Ergonomics
Value for money

C=C+
+ Stretch display and
landscape mode view
- Low battery life
Price: Rs 26,499
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The Tungsten W is a PDA-phone combination device with
a full-fledged QWERTY keyboard. Running Palm OS
4.1.1, it has a full-sized stylus for operating the

applications installed.
Measuring 4.8 x 3.1 x 0.7 inches and

weighing 181 gm, the steel blue-coloured device
is quite bulky. The facia has the keyboard, the
five-way navigator flanked by two application
buttons on either side, and the power button.
The top has a headset jack and an IR port, while
a silo on the right houses the stylus.

The expansion card slot is on the right-
hand side, contrary to other Palm handhelds,
which house them on the top. The SIM card is
inserted into a slot at the rear. The screen is cov-
ered by a leather flip cover that has a window to
show who’s calling.

Powered by the Motorola Dragonball VZ 33 MHz,
the Tungsten W features 16 MB of internal memory,
with 14.8 MB available to the user, and a 320 x 320 16-
bit colour TFT screen. The tri-band GSM phone, with
GPRS support, is useful for the global traveller.

There is no integrated speaker, and the only way
to use the phone is to connect the hands-free
headset. A button on the headset lets you switch to the phone
application at any point, and answer calls. Press and hold the
button to hang up. 

The device supports six profiles, and you can customise set-
tings for each, including volume, vibrate mode and ringtones,
and even divert calls to another number. The keyboard replaces
the silkscreen area. The main keys are aligned in three rows. The
fourth row has a blue function key, Shift/Caps Lock, spacebar,
shortcut and Home keys. The Home key provides
single press access to the ‘home’ applications. You
can re-map each key as required. 

The antenna’s notification LED blinks green to
show when the mobile is still within signal range, and
red when it’s not. The LED also indicates new mes-
sages, missed calls, alarms and battery status. In terms
of connectivity, only IR is available—no Bluetooth.
Application installation and PC synchronisation is
accomplished through the bundled Palm Desktop

software and
the USB cradle
using the Palm
Universal Con-
nector.

The Tungsten W has
SMS, Mobile Dialer and a
VersaMail 2.0 e-mail client
pre-installed, apart from
standard applications such
as Date Book, Calculator,
Memo Pad, To Do, etc.; SIM
Manager, Expense and Web-
clipping support are
installed on first sync. The

Software Essentials CD includes several produc-
tivity, entertainment and communications appli-
cations—Documents To Go, WorldMate, Jot,
Palm Reader and ArcSoft PhotoBase. A call-man-
agement software called Mobile Dialer allows
for caller ID, conference calls, call waiting, call
forwarding, call logs, speed dialling, call pro-
files and dialling from your contacts list. 

Performance-wise, the CPU is sluggish.
There is a noticeable difference in respon-
siveness, especially when playing games and
trying to switch between applications. The
keyboard design and button placement is
quite ergonomic, and a novice will have no
problems using the device.

The pre-installed keyboard tutorial
trains a new user to enter text, numbers and
symbols. However, the keys are not backlit,
so using the keyboard in the dark is a
problem. The keyboard also lacks the direc-
tional arrows, and the five-way navigation
key can’t be used to scroll through text char-

acters. As the Tungsten W lacks a Graffiti area, a
copy of CIC’s Jot is included on the CD. Jot allows you

to write directly on the screen, which takes some getting used to.
You can switch the screen backlight on or off by pressing and

holding the power button for two seconds. The dialler application
has large onscreen buttons, so you can dial, answer or reject calls
with your fingers instead of the stylus. The lack of a physical switch
to access silent mode is quite inconvenient. 

As with other smartphones such as the Treo 180, SIM integra-
tion is poor. Though you can use the SIM Manager to read SIM con-

tacts and copy them to the phone, or even dial
directly off the SIM using the mobile application,
reading the contacts takes a fair bit of time. You
need to copy the SIM contacts to the device to be
able to use telephony and messaging properly.

With the phone off, the internal 1500 mAH
lithium polymer battery lasted a whopping 12
hours and 47 minutes. With the phone switched
on, you get about three days with normal PDA
and phone usage.

Lack of an integrated speaker and micro-
phone makes the Tungsten W more suitable for
those who want to use it mainly for its PDA func-
tionality and wireless data access, and not as a
replacement for a cellphone. The slow CPU and

lack of media playback features also need to be considered if you’re
thinking of acquiring a Tungsten W. However, with support for tri-
band GSM, GPRS, an integrated keyboard and great battery life, the
Tungsten W holds a lot of promise for globe-trotting executives.

+ Integrated keyboard, good
battery life
- Slow CPU, lack of media
playback
Price: Rs 21,999

Palm Tungsten W

Performance
Features
Ergonomics
Value for money

C+C+

Palm Tungsten W

The Mobile application on the
Tungsten W lets you dial using
your fingertips

Reading and editing documents using
Documents To Go on the Tungsten W



test drive n
n PDAs

82 MAY 2004

First off are cases that help you protect your device. These range
from the necessary, to the superfluous: opt for just a hard plastic
but stylish case, or a sleek Italian-crafted leather case for a
touch of class. The leather case featured here, for the
Tungsten T and T2 models, also has space
for the expansion cards, and for
visiting and credit cards.

Other essential
accessories, ranging from
styli to screen protectors,
keyboards to memory cards,
modem kits to power kits, are
also available. Many are not
comfortable using the onscreen
keyboard, and writing with the stylus may not be their forte.
Help is at hand: external keyboards are available. These include
both wireless and connected keyboards. Wireless keyboards
connect via infra-red, and are foldable.

Other accessories include memory cards, which are, by
themselves, a necessity. If you want to play MP3s off your Palm,
you’ll need a memory expansion card, since MP3s cannot play
from internal memory. Plus, once you begin to use your Palm to

maximum
advantage, you’re
going to need
more storage. And
talking about
expansion cards,
it’s not limited to
just a memory card.
You also have a PalmPak Language Translator expansion card,

which can let you communiquer with your French counterpart. A
Bluetooth SD card is also available for models with a SD slot.
However, this will not work with models running Palm OS 5.x.

In other, non work-related accessories, a PalmOne PalmPak
Games Card is available for when you’re stuck in traffic or are
waiting for a flight. And if playing games is not your style, you
can catch up with some reading with the PalmOne PalmPak
eBook Series cards, which are a set of e-books ranging from
Personal Finance to Mystery.

Other accessories include an MP3 audio kit and a Palm
Modem connectivity kit that let you connect to the Net. And
when you just can’t afford to run out of power, the PalmOne
Power To Go clip will definitely come in handy. 

Sweets for your Sweet

CATEGORY PDAs
Brand
Model

Operating System
Size (H x W x D) (inches)
Weight (gms)
CPU Speed (MHz)
CPU Type

In-built Memory / Available to User (MB)
Screen
Colours / Resolution (Pixels)
Type
SD/MMC Card Expansion Slot
Wireless Connectivity
Battery Type / Rating
Speaker / Headphone Jack
Media Playback
Special Features

Benchmark
Pilotmark
Write 1 MB (ms)
Read 1 MB (ms)
Copy 1 MB (ms)
Speedy 3.3 Relative Timing (ms)
Battery Life (15%)
Ergonomics (Scale of 5) (15%)
Overall Scores
Features (out of 55)
Performance (out of 15)
Battery Life (out of 15)
Ergonomics (out of 15)
Overall (out of 100)
Value For Money
Price (Rs)
Grade

Palm
Zire 71

Palm OS 5.2.1
4.5 x 2.9 x 0.7

150
144

Texas Instruments
OMAP310

16 / 13

16-bit / 320 x 320
Transreflective

Y
Infra-red

Li-Polymer/900 mAH
Y / Y

Y
Integrated Camera

249

200
210
230
542

3 hr 14 min
3.5

34
5.64
3.16

10.50
53.30
2.67

19,999

Palm
Tungsten E

Palm OS 5.2.1
4.5 x 3.1 x 0.5

130
126

Texas Instruments
OMAP311
32 / 28.3

16-bit / 320 x 320
Transreflective

Y
Infra-red

Li-Polymer/840 mAH
Y / Y

Y
NA

215

190
220
260
500

2 hr 47 min
3.5

24
5.26
2.72
10.50
42.48
3.03

13,999

Palm
Zire 21

Palm OS 5.2.1
4.4 x 2.9 x 0.6

108
126

Texas Instruments
OMAP311
8 / 7.2

4-bit / 160 x 160
Reflective

N
Infra-red

Li-Polymer/840 mAH
N / N

N
NA

223

190
210
250
586

11 hr 7 min
3

11.5
5.54
10.87
9.00
36.91
5.09
7,249

Palm
Tungsten T

Palm OS 5.0
4 x 3 x 0.6

159
144

Texas Instruments
OMAP1510

16 / 14

16-bit / 320 x 320
Reflective

Y
Infrared, Bluetooth
Li-Polymer/900 mAH

Y / Y
Y

Voice Recorder

253

170
180
220
549

2 hr 37 min
4

29.5
6.11
2.56
12.00
50.17

NA
NA
NA

Palm
Tungsten T3

Palm OS 5.2.1
4.3 x 3 x 0.66

156
400

Intel XScale PXA255

64 / 52

16-bit / 320 x 480
Transreflective

Y
Infrared, Bluetooth
Li-Polymer/900 mAH

Y / Y
Y

Voice Recorder

539

90
100
130

1500
1 hr 55 min

4

35
12.20
1.87

12.00
61.07
2.30

26,499

Palm
Tungsten T2

Palm OS 5.2.1
4 x 3 x 0.6

159
144

Texas Instruments
OMAP1510
32 / 29.5

16-bit / 320 x 320
Transreflective

Y
Infra-red, Bluetooth
Li-Polymer/900 mAH

Y / Y
Y

Voice Recorder

255

170
180
230
514

1 hr 55 min
4

32
6.00
1.87

12.00
51.87
2.36

21,999

Palm
Tungsten W

Palm OS 4.1.1
4.8 x 3.1 x 0.7

181
33

Motorola Dragonball VZ

16 / 14.8

16-bit / 320 x 320
Reflective

Y
Infrared, GPRS/GSM

Li-Polymer/1500 mAH
N / Y

N
Mobile Phone,

Integrated Keyboard
156

290
310
480
140

12 hr 47 min
3.5

29.5
3.13
12.50
10.50
55.63
2.53

21,999

Contact: Tech Pacific Fax: 022-55960101, E-mail: manishl@techpacindia.com, Web site: www.palmone.com, Phone: 022-55960303

External keyboards can really speed up the
way you use your PDA
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Internet Explorer (IE) may be the most popular, but it’s also
the most basic of browsers. Just look at Opera or Mozilla—IE
lacks pop-up blockers, tabbed browsing and numerous other

tiny details that make searching easier.
The good news is that it supports third-party extensions, so

you can get most of these missing features installed. We divided
all available add-ons into nine different categories—based on the
function they perform—and looked for the best in each category.

Remember, if you want to install these add-ons, you need to
first start IE, go to Tools > Options > Advanced and check the Enable
Third Party Browser extensions Meanwhile, explore the following
add-ons that can spice up your explorer.

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

Did we hear you say that Internet
Explorer has no features? With a
few plug-ins, it can rival the best

Browser Sentinel
For total control over all installed third-party extensions, you need a
program that tells you what’s installed where, and monitors new
installations too. Presenting...the Browser Sentinel...

Use its interface to view extensions installed in different categories—
Browser Helper Objects (BHOs), toolbars, bands, buttons, context menu,
tools menu and ActiveX components. It also lets you manage the
programs that start with Windows. If you’re going to try out the add-ons
we have discussed here, install Browser Sentinel first!

Get it on the Mindware
CD, or download it from
http://www.unhs
olutions.net/Browser-
Sentinel. 

Note that Windows XP
SP 2 will have all the
features of Browser
Sentinel incorporated into
IE (See ‘Pack 2 The Brim’,
Page 87). 

Add-on Management

EMS Free Surfer mk II
Pop-up advertisements are undoubtedly
the worst irritant. They are created using
various techniques, and a good pop
up blocker should be able to stop
them all. It should also allow the pop-
ups you need, be light on memory and
be extremely customisable and controllable.

We tested quite a few blockers before
deciding on EMS Free Surfer mk II. Some other
popular pop-up blockers are Pop-Up Stopper
Companion (available at www.panicware.com), and the Google
Search toolbar’s pop-up blocker.

EMS Free Surfer mk II has two modes—Natural and Strict.
Natural mode is the one you use most. In this mode, pop-ups are
blocked, but requested windows are opened. In strict mode, no
other window opens. It also includes few other features such as a
plug-in to cleaning browser caches, home page lock, etc. 

EMS Free Surfer mk II blocked unwanted pop-ups, and allowed
all legitimate pop-ups. But here comes the best bit, it’s a free
download from http://www.emsproject.com/FS, or you can just pop
our Mindware CD into your CD drive. If you want to test how
good your pop-up blocker is, log on to www.popuptest.com.

Again, note that Windows XP SP2 has included a pop-up
blocker for IE. See page 87 for details.

Pop-Up BlockerSpice up
your IE

Mahesh Benkar
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Form Fillers
RoboForm 5.6.4
No Net surfer should be without one!
Why fill the same fake details into
hundreds of different forms, when you
can get a program to lie for you? 

RoboForm is a password manager
and form-filler that’s here to make your
life easier.

Just install it, fill in your details when
the setup prompts you to, and you’re
set to fill forms with a mouse-click.

You can have multiple identities, for
each member of your family or for each
of your personas. It can even handle
radio buttons and check marks, and
stores your passwords with triple DES
encryption.

The tool is accessible from the
browser toolbar, the context menu, a
tray icon, or a desktop shortcut. Get it

from www.
roboform.com.

You can also
refer to the October
2003 issue of Digit
for the Quickstart
article, ‘What’s in a
password’ on
Roboform 5.6.4.

You could also
take a look at
Dejasurf (www.
dejasurf.com) as
an alternative.

IE Booster 2
This add-on is a Web page analyser meant for Web site
developers.It adds a toolbar to your browser. Analyse a
Web page using its buttons. This gives you information
about the source, links, style sheets, frames, etc. It has a
collection of online tools—think Google site search,
W3C validation, traceroute, ping, search engine checker,
etc. It has a button to resize the IE window, and one to zoom
in and out of a Web page—actual zoom, not just change font sizes. 

It adds three buttons to the standard IE toolbar, including the HTML Detective and an
editor to edit the context menu. In short, it’s a must-have for those who want to understand
how Web pages are built. We’ve included it on our Mindware CD. Go to http://www.paessler.
com/iebooster to learn more about it. Also check out IESizer (http://iebars.com/).

Developer Tools

Toolbars
Search Toolbar
Many of us prefer to use two or three search
engines to get better results. What you
really need is a tool that gathers results from
all your favourite search engines.

Search Toolbar is the perfect solution.
You can search over 70 Web sites, and can
customise it even further. The different
search engines are arranged in categories,
so navigation is not a problem. It also has
keyword search to speed up your searchs.

For example, to search for ‘Jasubhai’
with Google, all you need to do is enter
‘g Jasubhai’.  This functionality can also be
achieved in IE by using Microsoft’s TweakUI
Utility or some registry tweaks, but you will
need to know the URLs of the Web sites and
the way the search string is passed to them.

This tool is useful as it gives you access
to many search engines without knowing all
these details.

It can also check your e-mail, and show
you how many new mails you’ve received; it
has a pop-up

blocker and form filler. It also
contains a WinAmp control button, and you
can add more for other applications. You
can use a really simple wizard or the
standard options dialog to configure this
tool. Get it from www.searchtoolbar.com.
Another popular toolbar is Groowe Search
Toolbar (www.groowe.com).

IE Privacy Keeper
Guard your temporary files and browsing history with
small, free and effective IE Privacy Keeper. Use it to clean
out those files, URLs, auto-complete forms and cookies.
You can even clean up the mess you leave Windows—in
the temporary files, Recycle Bin, Open/Save history, Recent
Documents and even the Recently Opened files list.

Set it to erase tracks when you close an IE window, or
when Windows starts or shuts down. It’s available at
http://www.unhsolutions.com/IE.

Another option is Webroot Window Washer
(www.webroot.com).

Privacy

Productivity tools
ieSpell
Some of us just can’t speel. Oops, spell!
Thank God for Word! But what do you do
when you need a spell checker while surfing
the Net?

Though many Web-mail services offer a
spell checker, they’re just a waste of
bandwidth—you have to click on a button,
submit your mail to the e-mail service’s spell
checker, and wait for it to send corrections
back. ieSpell does away with all that and
checks spellings at the click of a button. 

Activate it from the tools menu, the
toolbar, or the context menu. The dialog box
is identical to MS Word. Choose between
UK, US and Canadian English. Add new
words, and install new dictionaries too.

It also has a link to the Merriam-Webster
online dictionary. Overall, a useful tool
available at www.iespell.com.

Other similar tools available include Hot
Lingo (www.hotlingo.com) and Wordz
Toolbar (www.socketsoftware.com).



86 MAY 2004

test drive n
n browsers

Image Grabber
1ClickPicGrabber 2.01

Oh! What a beautiful scene. Look
there’s more below, wait there’s about
50 amazing pictures on this Web site.
Oh well, Right-click > Save As > [Enter],
Right-click > Save As > [Enter], Right-
click > Save As > [Enter], Right-click >
Save As > [Enter]…

That’s one way to go. The smarter
thing to do is install 1ClickPicGrabber.
It adds a button to IE that lets you
download all images on a Web page,
images that are linked to from that
page, and even movies and other
files, with just a single click. The files
copy in the background to folders.

You can filter offensive images by
using its inbuilt ‘Skin Filter’. Just be
careful you don’t click that button when
on Google—that would be like trying to
download the Internet! Get it from our
Mindware CD, or from www.1cpg.com.

SmartGrabber 3.1
(http://www.hibrosoft.com/smartgrabbe
r.php) is another option to look at.

Miscellaneous

ActiveTracker Email Plug-in
If you use Yahoo! and Hotmail, and really miss the
‘Read Receipt’ feature of Outlook, don’t fret.
ActiveTracker works with Yahoo! and Hotmail. 

Once you’ve installed it, you can track when
the recipient read your e-mail, where he or she
geographically was when the e-mail was opened,
how long they took to read it, did they print the
e-mail, was it forwarded, etc. These notifications
are sent to you in a detailed e-mail.

But that’s not all…you can also send self
destructing mail. Mission Impossible anyone?
Once the e-mail is opened, it’s only readable
for a specified time. This is done by sending a
link to the reader, while the e-mail sits on the
server. Once a reader visits the link, the link
becomes inactive after the specified time.

Unfortunately, this is a trial software, valid
for 25 e-mails or 15 days, whichever comes
first. You can try it out by installing it from our Mindware CD,
or go to www.readnotify.com, to learn more.

UCmore
You’re looking to buy that great Sony TV you saw somewhere, but now you can’t find

the Web site…let UCmore help you. It’s great: install,
navigate to www.sony.com and UCmore immediately
uses a search engine to display buttons called
‘Consumer Electronics’, ‘Communication’, ‘Home

theatre’, etc., on its toolbar.
This is much better than search engines, as it only

displays related information—all sorted in groups. Click on a
button, and get a drop-down menu showing you selected

Web sites. A brief description of each site is shown as a tool tip.
We suggest you try it immediately: log on to

www.ucmore.com and download it.

Other Browsers

Internet Explorer has long been the most popular browser, but it’s
simple, missing a lot of features. This is why most plug-ins are
developed for IE. However, there are tools that will improve even the
experience that Mozilla Firefox and Opera have to offer.

Opsed, or Opera Search.ini Editor (http://starzaki.eu.org/~hclan/
operapl/en/), is a useful tool for easy customisation of the search
engines used by Opera. It is basically a GUI interface to edit Opera’s
search.ini file, which is otherwise difficult to edit. Other plug-ins for
Opera can be found at www.opera.com/docs/plugins. 

For Mozilla Firefox, there are over 150 plug-ins listed at

http://texturizer.net/firefox/extensions/alpha.html. Some useful plug-ins
listed here are Adblock (block images or other elements on a page),
Scribe (lets you to save the forms you fill), Bookmarks Synchronizer
(allows you to save your bookmarks to an FTP site), Nuke Anything
(removes any object from the Web page layout) and PNH Developers’
Toolbar (allows you to analyse a Web page).

If you use more than one browser, or just have too many
bookmarks to be able to find a site that you need to re-visit,
Powermarks (http://www.kaylon.com/power.html) will prove to be a
useful tool. It is a bookmark management tool that works with Opera,
Mozilla and IE and offers a simple and very effective search-based
organisation of your cherished bits of the Web.

Plug-in to Another
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The best products in different 
hardware and software categories

Motherboard
MSI 875P Neo
+ Terrific performance and equally
good features
- Bad component layout
Contact: Cyberstar
Phone: 080-2276986
E-mail: narend@cyberstarin.net
Price: Rs 35,500

Primary Storage
Maxtor 250 GB MaxLine
Plus II
+ Tons of space
- Gets heated
Contact: Cyberstar
Phone: 011-6438216
E-mail: yogi@maxtor.com 
Price: Rs 19,500

Secondary Storage
DVD-Writer 
LiteOn LDW-811S DVD-
Writer
+ Fast write speeds
- Cannot write on dual-layered
media
Contact: Mediatech India 
Phone: 022-56396696 
E-mail: sales@mediatechindia.com
Price: Rs 13,750

Input Devices
Microsoft Natural
Multimedia Keyboard
+ Great quality and ergonomics
- Takes time to get accustomed
to new key layout
Contact: Microsoft Corporation 
Phone: 011-26294600
E-mail: connect@microsoft.com
Price: Rs 1,498

Graphics Card
Gainward GeForce FX 5950
Golden Sample
+ Extremely good performance
- Expensive
Contact: Mediatech India
Phone: 022-56396696
E-mail: sales@mediatechindia.com
Price: Rs 31,475

Sound Card
Creative SoundBlaster
Audigy 2 Platinum 
+ 6.1-channel output
- Expensive
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com 
Price: Rs 14,199

Speakers
Creative Inspire 5700D
+ Crystal clear sound reproduction
- Will not be able to shake the
room
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com 
Price: Rs 23,999

Display
LCD Monitor
Samsung SyncMaster 173P
+ Very elegant looks, Landscape and
Portrait modes
- A bit heavy
Contact: Samsung India Electronics
Phone: 011-51511234
E-mail: marketing@samsungindia.com
Price: Rs 47,500

The A-List

Microsoft Wireless
IntelliMouse Explorer
+ Optical Mouse, USB interface
- Expensive
Contact: Microsoft Corporation
Phone: 011-26294600
E-mail: connect@microsoft.com
Price: Rs 4,278

Products that topped
our performance tests

Laptop
IBM T40
+ Great design, 
excellent performance
- Expensive
Contact: IBM India Ltd
Phone: 080 2063199
E-mail: sanmenon@in.ibm.com
Price: Rs 1,53,366

Branded PC
HCL Beanstalk 4658
+ Great package
- None
Contact: HCL Infosystems Ltd
Phone: 0120-2520977
E-mail: raman@hclinsys.com  
Price: Rs 51,490

Multi-functional
Device
Xerox PE16 All-In-One
+ Good fax features, 
compact design
- Below par scan and 
copy quality
Contact: Xerox Modicorp Ltd
Phone: 0124-2561930/ 940
E-mail: kuldeep.malhotra@
ind.xerox.com
Price: Rs 40,000

Laser Printer
Canon LBP3200
+ Compact and light; fast 17
ppm text printing speed
- Flimsy paper tray mechanism
Contact: Canon India Ltd
Phone: 011-26806572
E-mail: rajeev.singh@
canon.co.in 
Price: Rs 13,995 plus taxes

Inkjet Printer
Canon i560
+ Classy printing speeds
- None

Contact: Canon India Ltd 
Phone: 011-26806572
E-mail: rajeev.singh@

canon.co.in  
Price: Rs 9,995

PDA
Palm Tungsten T3
+ Stretch Display
- Expensive

Contact: Tech Pacific 
Phone: 022-55960303 

E-mail: manishl@ 
techpacindia.com 
Price: Rs 26,499

Mobile Phone
Sony Ericsson P900
+ Good integration of phone
and PDA features

- Expensive
Contact: Sony Ericsson

Phone: 0124-2560808 
E-mail: dhiraj.soni@sonyerics-

son.com
Price: Rs 40,000

Digital Camera
Canon IXUS 400
+ Cerabrite body, better 
buttons layout, wide shutter
speed range

- Ultra compact body 
hampers handling

Contact: Canon India Pvt Ltd 
Phone: 011-26806572

E-mail: shyam@canon.co.in 
Price: Rs 49,995

MP3 Player
Apple iPod
+ Hard-drive based, FireWire
cable bundled, line-out socket
- Very expensive

Contact: Apple Computer
International Private Limited

Phone: 080-25550575/ 73
E-mail: indiainfo@

asia.apple.com
Price: 30 GB-Rs 41,000

CPU
AMD Athlon64 FX-51
+ Great performance with multi-
media applications
- Expensive
Contact: Tech Pacific
Phone: 022-55960101
E-mail: pratik.chube@
techpacindia.com
Price: Rs 41,000
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Secondary Storage
CD-Writer
Benq CRW5224W
+ Cheap
- Data cable not bundled
Contact: BenQ India Pvt Ltd
Phone: 022-25705231
E-mail: salesenquiryin@benq.com
Price: Rs 2,000

Speakers
Frontech JIL-1870 
+ Good sound at an affordable
price
- Cannot handle high volume
Contact: Jupiter International
Phone: 022-22001211
E-mail: frontech@bom5.vsnl.net.in 
Price: Rs 1,500

CPU
AMD 2400+
+ Sufficient power for normal
desktop use
- Cumbersome installation
Contact: Tech Pacific
Phone: 022-55960101
E-mail: pratik.chube@techpacin-
dia.com 
Price: Rs 4,100

Motherboard
Krypton NF2400U
+ Good features, impressive per-
formance 
- Lacks onboard video 
Contact: Priya Ltd 
Phone: 022-56663100 
E-mail: priyabom@priyagroup.com
Price: Rs 3,550

Primary Storage
Samsung SV1203N 120 GB
+ Noise Guard and ImpacGuard
- 5400-rpm drive
Contact: Samsung Electronics
India Information
Telecommunication India Pvt. Ltd
Phone: 011-515111234
E-mail: marketing@
samsungindia.com
Price: Rs 7,200

Display
CRT Monitor
Philips 109E5
+ Good geometry results, good
colour purity
- Average results in fine matrix
Contact: Philips India Ltd
Phone: 022-56912325
E-mail: PCP.India.Info@philips.com
Price: Rs 11,500

Branded PC
HCL EzeeBee
+ Winner of Best Value and
Best Performance
- Needs a better graphic card
Contact: HCL Infosystems Ltd
Phone: 0120-2520977
E-mail: raman@hclinsys.com
Price: Rs 26,500

Laptop
ACI Ethos 4
+ Good configuration for
the price
- Hampered ergonomics
Contact: Allied Computer 
International (Asia) Pvt Ltd 
Phone: 022-56943260/
26733124/ 56407000
E-mail: sales@aci-asia.com  
Price: Rs 44,990

Multi-function
Devices
HP Officejet 4110 All-in-
one 
+ Very fast printing speed
- Lacks a flatbed scanner
Contact: HP India Ltd
Phone: 011-26826000
E-mail: seema.dawar@hp.com
Price: Rs 8,999

Laser Printer
Samsung ML-1510 
+ Good image quality
- Slow print speed for combo
document
Contact: Samsung Electronics
India Information and
Telecommunication Ltd
Phone: 011-51511234
E-mail: farrukh@
samsungindia.com 
Price: Rs 10,990

Inkjet Printer
HP Deskjet 3550
+ Good photo printing 
capability, quite cheap
- High cost per page
Contact: HP India Ltd   
Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com 
Price: Rs 2,999

PDA
Palm Zire 21
+ Affordable, good battery life
- No Palm Universal Connector,
no backlight, no expansion slots
Contact: Tech Pacific
Phone: 022-55960303
E-mail: manishl@
techpacindia.com
Price: Rs 7,249

Digital Camera
Kodak DX6340
+ 3.1 megapixel camera with 
4X optical zoom
- Only 16 MB memory 
Contact: Neoteric Infomatique
Phone: 022-24172600
E-mail: rajeev@neoteric-info.com 
Price: Rs 18,900

Mobile Phone
Sony Ericsson T200
+ Light-weight, perfect grip,
WAP 1.2.1 browser and 
43.2 Kpbs GPRS, PIM features
- Keys are hard and noisy, 
unusual socket for the charger
Contact: Sony Ericsson Mobile
Communications International
Phone: 011-26180808
E-mail: sudhin.mathur@
sonyericsson.com 
Price: Rs 5,900

MP3 Player
Ennyah Digisound II
DS601
+ Fast data transfer, feature-rich
Contact: Great World Tech 
Pvt Ltd
Phone: 022-23892828
E-mail: sales@gtechworld.com
Price: Rs 6,000 (approx)

Graphics Card
Ennyah GeForce FX 5700
+ DirectX 9.0 compatible
- Very expensive
Contact: Great World Tech 
Pvt Ltd
Phone: 022-23892828
E-mail: sales@gtechworld.com
Price: Rs 8,500

Products that are 
the best value buy

Input Devices
Samsung PC Keyboard
+ Unmatched value for money
- No multimedia buttons, wrist
support not bundled
Contact: Samsung Asia Pvt Ltd
Phone: 022-22814886
E-mail: marketing@samsungindia.
com
Price: Rs 300

Logitech Scroll Mouse
+ Ambidexterous design
Contact: Rashi Peripherals
Phone: 022-28260258/ 59
E-mail: ho@rptechindia.com
Price: Rs 450
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We test the latest and the best hardware and software products available in the market 

How do you replicate a
class act, and then

justify the ‘new and
improved’ tag? If ever there
was an example that
management students can
learn from, it’s the Sony
Ericsson P900 phone-PDA
combo. It looks more
professional, is smaller,
lighter, less clunky and has
features ideal for both
business and pleasure.

The price (Rs 40,000)
puts it off-limits for most of
us, but with current smart-
phone technology, you could
hardly ask for more.  The
internal 16 MB memory 
can be boosted using the
Memory Stick Duo socket—
up to 128 MB.

The P900 offers great
functionality as a regular
phone, with excellent voice
clarity even in areas with low
network coverage. The
phone’s bulk may prevent

those with small hands to
hold it, but it must be
mentioned that the 65K
touchscreen is extremely
clear, and the colours are
rich. In flip-open mode, the
entire LCD screen comes into
views, and phone is now a
fully functional PDA.

Music playback is good,
and though the videos (in
MPEG-4 format) seem a little
grainy, the pictures (stored in
JPEG format) come out pretty
well. But make sure the
lighting conditions are good. 

The integrated digital
camera has a resolution of
640 x 480, 320 x 240, or 160
x 120 pixels, allowing you to
choose from three types of
picture quality—high,
medium and low. Videos can
be shot for as long as you
want, limited only by the

amount of free memory
available. Apart from JPEG,
the picture viewer supports
the BMP, GIF, PNG and
WBMP formats.

The device would seem a
bit slow while opening some
applications, and playing
games is not a pleasurable
experience at all. Most of all,
you miss the full-screen
mode, and you need the
stylus and a virtual
navigation pad to control
game objects. 

It features  a voice
recorder and an integrated
hands-free speaker. Apart
from the T9 numeric keypad
and an onscreen virtual
keypad, there is also CIC’s
JotPro that uses character
recognition, à la Palm
Graffiti, for onscreen writing
using the stylus.

Connectivity and data
transfer options include
Bluetooth, Infra-red, GPRS
and HSCSD. Surf the Web
using the WAP 2.0 HTML
browser. Features such as
support for e-mail with
attachments and a built-in
viewer that can read
Microsoft Word and PDF
documents, let you do your
work on the move. 

The PIM features Tasks, a
calendar with multiple views,
notes, a calculator, and
multiple alarms. There’s an
inbuilt file manager to

organise stored files in the
internal and external
memory. The CD also
includes the Opera browser.

We were able to pair the
device with a desktop PC
using a Bluetooth USB
adaptor without any hiccups.
The lithium polymer battery
can last you three days with
normal use of the phone,
camera, multimedia and PDA
features.

+ Stacked to the gills with features
– Slightly expensive

Price: Rs 40,000
Contact: Sony Ericsson
Phone: 0124-2560808
E-mail:
dhiraj.soni@sonyericsson.com
website: www.sonyericsson.com

Sony Ericsson P900 BB
Performance
Features
Ergonomics
Value for money

SPECIFICATIONS

Tri-band (GSM E900, 1800,
1900), Symbian OS 7.0, 115 x
57 x 24 mm (with flip), 150 gm,
integrated camera, video
recorder, GPRS, WAP, HSCSD

Sony Ericsson P900

The applications installed resem-
ble the Start Menu in Windows 

Capturing stills or videos on the
P900 is simple
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ADJ Console is a
turntable-like device

that a DJ uses for mixing
tracks.  Hook it up to your
PC via USB, and mix MP3s
you’ve collected over time

on your hard disk.
Traditional DJ consoles

consist of two decks—
sources of music—and a
mixing console. Here, the
PC works as the music
source, and the console as
the mixing equipment. 

Queue songs from your
music collection in the order
you want, and with practice,
you can even become a
professional DJ. However, at
Rs 14,495, the Hercules DJ
Console is priced slightly on
the higher side. You could
consider some assembled
options for practice.

The console provides a
range of connectors: MIDI-
In/Out, Coaxial Digital
In/Out, Optical In/Out and
Audio In/Out with the help
of a mini-stereo jack (3.5
mm) or an RCA plug. An
added advantage is the 5.1
sound card that allows you
to connect a five-channel
speaker set.

The Mixing Console is
low on desk space
requirements; its compact
profile tends to induce some
ergonomic problems. The

controls are similar to those
of a traditional console, with
mixer knobs, switches, etc.
The mixer can also be
controlled using the bundled
software. Plenty of software

applications are provided
with the console, including
Virtual DJ from Atomix
Productions, Ots CD Scratch,
OtsDJ Demo, Storm 2.0 DJ
Edition from Storm Music
Studio and DJ Console
Softmapper from Hercules.

Queue up two audio
streams (MP3,WMA, etc.) to
be mixed on the interface,
and line up the next track as
well. Each stream has its
individual volume, treble,
bass and mid controls, play,
track forward, track
backward, etc; as well as the
mixing options of tempo
changer, pitch bend,
scratching knobs, three cue
points, auto beat, special DJ
effects and a cross-fader,
which should get any DJ
going right away. 

+ Unique product 
- Slightly cramped work space, a
tad expensive

Hercules DJ Console

SPECIFICATIONS
MIDI-In/Out, Coaxial Digital
In/Out, Optical In/Out and
Audio In/Out, 5.1 sound card

Price: Rs 14,495 
Contact: Mediatech India
Phone: 022-26361111 
E-mail: info@mediatechindia.com
Website: www.mediatechindia.com

Hercules DJ Console

Performance
Features
Build quality
Value for money

B-B-
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The Philips 535 is a sensibly
priced good phone to

distinguish yourself from the
Nokia and Sony Ericsson herd.
It integrates the Philips sound
system. The design is unusual.
The hot pink with matte silver
model should appeal to
women, and the black one, to
most young men.

Connectivity comes in the
form of infra-red and GPRS. You
get an integrated VGA camera
with a maximum resolution of
640 x 480, and a minimum of
128 x 128. There’s colour
mode, quality, resolution and

night shot settings. The images
don’t look that great on the
screen—transfer them onto a
palmtop and they look much
better. A small mirror for a self
portrait is provided.

The keypad is neither good,
nor bad. The keys have the
right tactile feedback, and the
joystick is fun to use. At times

At Rs 6,500, the Jetway
N2view is the best thing

to happen since cable
Internet to a cyber cafe
owner since you can set up
two PCs at the
price of

one. The
N2view  integrates

two D-Sub monitor-outs.
The board ships in with two
PS/2 Y cables. 

For a lark, we used the
board in single-user mode,
and it gave good results. The
real test, however, was in the
twin-user mode. We tried to
simulate every possible
scenario wherein the system
could be used as two

independent systems. In
office-related work, both
systems ran perfectly. Even
when one system ran Quake
III, the other ran MS Word
perfectly OK. But when
Quake III was started on both
systems, the board crashed.

Thus, this motherboard is
good if your work is

usually restricted to
office suites, Internet
surfing and 2D games

in two-user mode. 

+ Good features, relatively good
performance
- Doesn’t support 400 MHz
memory
SPECIFICATIONS

Supports AMD Athlon 3200+,
DDR 333 MHz, onboard six-
channel sound, supports ATA
133 and an AGP 8x slot 

Price: Rs 4,900
Contact: Anirox Technologies
Phone: 022-28655282/3/4
E-mail: aniroxby.vinay@anirox.com
Web site: www.jetway.com 

Jetway N2view
motherboard 
Performance
Features
Build quality
Value for money

A-A-

Jetway N2view motherboard 

At Rs 1,20,000, the
Lifebook S6130 is a

bit expensive, but its
price is justified—the
bundle is elegant,
eminently portable and
performs where it
matters most. Built
around Intel’s Centrino
platform, it is in the
league of the top
performers. It did extremely
well in our productivity and
business application tests.
The ultra-portable form factor
and 
1.7 Kg add immensely to its
appeal. The battery lasts for
around four hours on a
normal workload. 

The keyboard is large
enough, and the keys at the
extremes fall within easy
reach. There’s enough space

near the
touchpad for resting one’s
palm. The swappable combo
drive can be easily removed
an re-inserted. 

+ Good performance

Price: Rs 11,360  
Contact: Philips India Ltd
Phone: 011–26950448/49/50
Fax: 011–51678632
E-mail: manisha.singh@philips.com
Web site: www.philips.com 

Fujitsu Lifebook S6130 

the joystick gets the
jitters and jumps onto a
menu other than
expected. 

Browsing the menu is
easy with dedicated
buttons. The screen is small
and quite blurry. In daylight, 
it goes pale, but remains
readable. 

A unique feature is the Be DJ
Mixer functionality, which lets

you edit pre-existing
tunes and compose

new ones. It’s a
limited tool, but
fun. 

+ Good features,
stand-out design

- Relatively poor
display screen 

SPECIFICATIONS: 
Pentium M 1.7 GHz, 256 MB
DDR RAM, 13-inch TFT display,
40GB hard drive, combo drive,
Wi-Fi 

Price: Rs 1,20,000
Contact: ACI Infocom Ltd
Phone: 022-28266031/32
Fax: 022-28250674
E-mail: desmond@aciinfo.com
Web site: www.aciinfo.com

Fujitsu Lifebook S6130

Performance
Features
Build Quality
Value for money

B-B-

SPECIFICATIONS

95 gm, dual band, MMS
capability, 28 x 28 mm 65k
colour screen, voice dialling,
recording features, 32-bit
polyphonic ring tones

Philips 535 
Mobile Phone (200)

Performance
Features
Build quality
Value for money

B+B+

Philips 535 Mobile Phone

Two PCs with Jet-
way motherboard

52.13
Rs 28,500

1.82

Performance (out of 75)
Price

Performance/Price ratio

Two individual
PCs

54.12
Rs 56,200

0.96
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If you want a performance-
oriented laptop, the Dell

Inspiron 600m fits the 
bill. It’s excellent value for
money.

Performance separates 
it from the crowd. It beat
our January 2004
comparison winner, 
the IBM ThinkPad T40. But
higher performance means
that the battery lasts only
three hours.

The Inspiron 600m is
based on the Centrino
platform, is powered by a
Pentium M 1.7 GHz, 512 MB
of DDR memory, a 64 MB
Radeon 9000 display card
and 40 GB of hard disk
space. It weighs 2.3 Kg. 

The
design is a
perfect
blend of
aesthetics
and
practicality.
Ergonomics is
spot-on, and using
the laptop is a
pleasure. The keys are
reasonably large and well-laid
out. The touch pad is
sensitive and accurate, but the
touch pad buttons lack the
feel associated with quality
laptops. Overall, however, the
build quality is superb.

For connectivity, the

Inspiron 600m comes
with built-in Wi-Fi and
Ethernet as well as an

optional Bluetooth
adapter. Video

options
include one

monitor D-sub
and an S-Video

connector.

+ Excellent performance
- Flimsy touch pad buttons
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Dell Inspiron 600m

SPECIFICATIONS
Pentium M 1.7 GHz, 512 MB of
DDR RAM, 32 MB Radeon dis-
play card, built-in Wi-Fi card,
combo drive, optional Bluetooth
adapter

Dell Inspiron 600m

Performance
Features
Ease of Use
Value for money

A-A-
Price: Rs 90,690
Contact: Dell Computer India
Pvt Ltd
Phone: 1600-338044
Fax: 080-25586107
E-mail:
HSB_Web_India@Dell.com
Web site: www.dell.com

The Orite VC3240 is not
worth Rs 7,950. Indoor

images were
not of
acceptable
quality, and
outdoor
images, just
about average.

Details were lost
in an extreme close-up: the
crystal pen stand we shot looked
like a 
plastic stand. We couldn’t get
better results even though the
camera features exposure
compensation, four pre-defined
white-balance settings and two
settings for quality.

At factory settings, indoor
images were dark, and had
prominent red tinges in the light
areas and green tinges the dark
areas—neither the colours nor
details were reproduced well. For
usable images, you have to rely
on the manual mode.

It’s compact enough to fit in
most palms. A nice mode dial
does the switching between
operational modes—manual,
auto, movie and so on.

But that’s all you are 
paying for. 

+ Good looks
- Below-average quality images

Orite VC3240

SPECIFICATIONS
3.2 megapixel CMOS sensor,
4x digital zoom, 16 MB internal
memory, ±2EV exposure, four
white balance settings, 20 cm
macro mode, four AAA
batteries required, 2 to 10
seconds self timer, 110 gms

Price: Rs 7,950 
Contact: Mediatech India
Phone: 022–26361111
Fax: 022–24968085
E-mail:
csales@mediatechindia.com
Web site: www.orite.com.tw

Orite VC3240

Performance
Features
Ergonomics
Value for money

CC

The Brother MFC-3820CN
has card reader slots that

read MemoryStick, Compact
Flash, Secure Digital and
Smart Media formats. As you
plug the memory card in, a
dialog box provides options
to open the folder or print it. 

The printer head
produces 5 picolitre drops,
while a Canon photo printer
manages drops as small as 2
picolitres. Hence, the 3820CN
lags far behind in image
sharpness and details.
However, images printed
from the Compact Flash card
at the best settings on glossy
and inkjet paper had vivid
colours and crisp details. 

The combi-document
print-out also returned good
prints. The text printout,
though, had lots of
smudging all over and
looked like a print from a
dot-matrix printer. 

The scanned image had
endless banding, and details

were lost. Also, it took 17
seconds to scan the preview,
whereas the Epson CX3100
took just 6.25 seconds. The
ADF, however scans quickly
while copying.  

It has a dial-pad and
separate fax buttons on the
front panel to straight away
send/receive the fax without
any help from PC. 

The printer has four
separate ink-cartridges

(CMYK), which is good
approach as it lets you
change only the empty
cartridges. The black
cartridge costs Rs 910,
where as the three-colour
cartridges are priced at Rs
531 each, which is quite a
competitive price. 

The integration of its
paper trays leaves very

little, or no chance of them
being damaged. In all, it’s an
all-round solution for the
small office.

+ Good print quality
- Poor scanning unit

SPECIFICATIONS
1 line x 16 character LCD Dis-
play, 16 MB memory, 20 sheets
automatic document feeder,
Max. 600 x 2400dpi optical res-
olution, USB 2.0

Brother MFC-3820CN

Performance
Features
Build Quality
Value for money

BB

Brother MFC-3820CN

Price: Rs 27,600+ taxes  
Contact:Godrej & Boyce Mfg Co Ltd
Phone: 022-55961609
E-mail: nad@godrej.com
Web Site: www.brother.com
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Pack-2 The Brim

Security! That’s what’s on us Windows
user’s minds. Even Microsoft holds it
as a top priority. A technical preview

of Service Pack 2 (SP2) has been released
Windows XP. This is downloadable from
http://www.microsoft.com/sp2preview/—be
warned, it’s a 273 MB download, and still
in its beta stage. The final release is

expected at the end of 2004, so the beta
may have bugs; even Microsoft states,
“This technical preview is unsupported
and is intended for testing purposes only.
Do not use in production environments.”

You’ll be asked to enable Automatic
Updates at the Welcome Screen. Both
the Web interface, as well as the system
interface for automatic updates has
been revamped.

The Security Center is like a master
control centre for three main aspects of
your security—firewall, automatic
updates and anti-virus. A red icon shows
which is turned off, and you also get
frequent balloon pop-ups that say, “Your
computer might be at risk”. SP2 was smart
enough to recognise that Norton
AntiVirus (NAV) was installed, but

couldn’t tell whether NAV was enabled or
not. We couldn’t even force SP2 to accept
that NAV was indeed running fine.

SP2’s firewall is a marked
improvement over the simple Internet
Connection Firewall that comes with
Windows XP. The new firewall is turned
on automatically, has a better user

interface and better application
control. The Exceptions tab let’s
you choose programs and
services that should get
uninterrupted Internet access.
Using the advanced tab, you can
change detailed settings for
Network Connections, Security
Logging and Internet Control
Message Protocol.

Whenever a program tries to
access the Internet, a dialog pops
up asking you what action it
should take. However, this is very
buggy: both Windows Media
Player and Opera could access the

Internet without being allowed to do so—

it didn’t detect Opera until a few days
later. This is unacceptable, and will
hopefully be fixed in SP2’s final release.

To protect your memory from
malicious code, Microsoft has introduced
hardware-enforced Execution Protection,
also known as NX. Processors that support
this mechanism can prevent code
execution from data pages, by marking a
range of memory with an attribute, so that

code is not executed from that memory.
This will help prevent the very common
buffer overflow-based attacks that occur in
software as varied as browsers, e-mail
clients and file-sharing services.
Unfortunately, the only processors that
currently support this are the AMD K8 and
the Intel Itanium processor family—so
until you upgrade your hardware, this
technology is useless for you.

After a lot of complaints, Microsoft
has finally added a pop-up blocker for IE
in SP2. It was able to stop unwanted pop-
ups and allow the genuine ones. SP2 also
has an Add-on Manager for IE—it allows
you to view, enable and disable Active X
controls, browser extensions, Browser
Helper Objects (BHO) and all the toolbars
that are installed. Outlook Express can
now block images in HTML e-mail, until
you choose to display them. This also
prevents spammers from validating your
e-mail address and tracking when an e-
mail is opened.

A lot of smaller features have also 
been added, such as the addition of the
Bengali and Malyalam locales. SP2 also
has a new command line tool called
powercfg.exe, which can be used to access
the Windows power policy settings
(Control Panel > Power Options).

Though SP2 looks very promising,
there’s no point installing this beta
release—we suggest that you wait for the
final release.

Security Center is the master control centre for 
firewall, automatic updates and anti-virus

A much improved firewall comes with SP2

Finally, IE users get an inbuilt pop-up blocker

Outlook Express now blocks images in
e-mail messages to protect your privacy

We take a sneak peek at Windows XP Service Pack 2, to show you what to expect
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Watching TV the other day, I
was bombarded by ads that
featured state-of-the-art

smartphones. Especially catchy was the
Nokia 6600 and whatever came with
it, including a promotion and a girl-
friend. That really had me itching to
go out and get one for myself. And
well, it was about time I sent my
Nokia 3310 to the museum anyway.

With that in mind, I dashed off to
Mumbai’s mecca of all things giz-
motic—Heera Panna at Haji Ali.
Making my way through the crowds of
window-shoppers, I walked into the
shop that had the most models on dis-
play. The smiling chap at the counter
introduced himself as Amit, and asked
what I wanted.

I meekly asked for a phone that had
a camera and some other stuff thrown
in, such as Bluetooth, GPRS and radio,
and if possible an MP3 player. Pat came
the reply, “Budget kitna hai?”, which in
consumer-speak roughly translates to,
“How big a hole in your pocket do you
want to burn?”

Lying through my teeth, I told him
that money was no object, and that I
wanted a phone that would take care of
my needs and look good.

A Nokia 6600 was placed in front of
me, the same one I’d seen on TV: it was
Rs 21,500. Latest maal, and the most
selling at this time. Camera, organiser,
Bluetooth—the works. Ah well, don’t
you have anything better than this, I

said. He went on to show me a Sony
Ericsson P900, one of the best smart-
phones available today: Rs 35,000. Any-
thing similar, I prodded further. Sure,
the Siemens SX1 at Rs 27,000 was avail-
able. Giving Amit the ‘maybe I’ll buy it’

look, I began to scour around for more
exotic choices.

Soon enough, I found one that had
the 02 XDA on display, for Rs 45,000.
The 02 XDA features Pocket PC tools
such as Word, Excel and Media Player,
and has an Intel StrongARM 32-bit

processor with 64 MB of RAM, plus
expandability options.

Needless to say, I was hooked. But
this was more of a PDA than a
phone. And it didn’t have Blue-
tooth. I asked the friendly guy at
the counter if he had anything
else. He could only churn out
some Sony Cliés and a Zire 71,
which didn’t interest me.

So my journey continued.
In another shop,  I got to look
at the Handspring Treo 600,
which has not yet been offi-

cially introduced in India. At Rs
36,000, it was priced like the Sony

P900, but features such as Bluetooth
were missing. The Tungsten W was Rs
22,000, but again there were drawbacks.
Like most of its counterparts, it lacked
Bluetooth. Plus, you can only speak into
the phone if you attach the headset, and
the processor is slow. 

This was more than enough research
for me, and I got back to where Amit sat
smiling. I asked him to show me the
Nokia 6600 and the Sony Ericsson P900.
I had narrowed the choices down to
these two, though the Siemens SX1 does
have features similar to the P900. The
6600 is a definite looker and also has fea-
tures, but it can’t record video for more
than 9 seconds. Plus, on the P900, you
can flip open the keypad so the full
screen is viewable; you can also take
videos horizontally.

Yes, the Sony Ericsson was worth it. I
asked about the warranty. Amit’s basic
premise was I would get a one-year
repair warranty, but no replacement. So
I asked for an absolutely new piece
which was brought in and given to me
right out of the box, which I checked to
ensure that all was right, before paying
and making my exit from the place. 

Amit was still smiling.

n Before you splurge on a smartphone, make sure you really need it.
If you need a mobile phone, get a mobile phone. If you need to take

notes at the drop of a hat, or if you need to check out stock prices on the
go, get a smartphone.
n If you’re getting a really worthwhile features, but need to spend a couple
of thousands more, go for it.
n Make sure the features on your smartphone include options for easy
connectivity with your PC, and expansion options such as memory cards.
n Take your time to check all the functions, because in the shop is the only
time you can get a replacement if something doesn’t work right. If the
mobile stops working even the very next day, you can only get it repaired,
not replaced.

Smarter than Thou
Today, mobile phones aren’t bought to make calls.

You’re only as cool as your instrument, so buy carefully...

Mahesh Benkar
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“Streaming is so cool!”
exclaims Rajesh Lamba, a
cyber cafe owner in
Mumbai. “At least five

people who come to our cyber cafe love to
stream music while they are surfing the
Net,” he says. “Just the feeling of listening
to music while checking e-mails or surfing
is refreshing. And with thousands of
sources, you can choose what you want,
instead of carrying your own CD. I don’t
think many people know about this,
otherwise they would be streaming too,”
he reckons.

The Internet is changing the way we
listen to radio and watch TV. Online radio
stations let you choose your listening
content while their TV avatars—read
streaming video services—let you watch to
your taste. 

Put on your blue suede
shoes
Used mostly for audio and video content,
streaming is a technology that sends files
in continuous streams, which you can

access without waiting for them to down-
load completely. This lets you play bits and
bytes of the file instantly. Obviously, you
need an Internet connection that 
can download streams at about the play-
back speed.

You can find such content on the Web
either via the listings in software such as
Windows Media Player, or accessing Web
sites through a browser.

Play that song
Windows Media Player, Real
Player and Winamp are 
the three most popular
streaming media players.
Old horse Real Player
has come out with a
new version that over-
sees the streaming
process. Real One Player
also has a host of radio
stations to offer. Winamp 5’s
proprietary video format —
.nsv—lets you view crystal clear
video content. 

Have a blast of a
time, with streams
of the
entertainment
kind

Solomon Lewis
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The Windows Media Player 9 series has
revised its codec technology, thereby allow-
ing for smaller file sizes with better sound
quality. Its Radio Tuner lists numerous
radio stations. You can listen to some—
ClassicalMusicAmerica.com, for exam-
ple—from within the software. Others,
such as Ultimate-80s (www.ulti
mate80s.com), requires you to log on  to
their Web site.  

If your Internet connection is slow,
and you experience frequent pauses
due to buffering, here’s what you can

do. In Windows Media Player, go
to Tools > Options, switch to the

Performance tab, and set the
buffer time to 60 in the

Network Buffering area. 
Use Winamp 5 to

watch Internet TV. First,
to filter offensive
content, press [Con-
trol] + [P] to bring up
the Preferences
dialog box. Click on
Media Library and
switch to the ‘Inter-
net Radio/TV’ tab.  

Here, tick the
appropriate rating
of the channel you
want to see, and

click OK. Now, go to
File > Internet TV, and

then double-click the
desired channel. 

If radio is on your
mind, click File > Internet

Radio instead. Here, you’ll
find practically every listening

option—news, Hindi music,
western music, comedy, etc. 

As you hit a Web site in your search
for channels, you come across another
Web address that offers some more, and
thus your range of choices expands. You
get a lot more channels to peruse than
what media player software can offer.
However, do remember that most of
these are customised for Internet
Explorer. Browsers such as Opera may not
display them properly.

Do Re Mi...
LAUNCHcast, a unique music service by
Yahoo!’s Launch (http://launch.yahoo.com),
lets you customise your radio stations. It
claims to be the only such free service, with
unlimited artists, albums and song ratings
in tow. However, you can only listen to 400
songs per month. Beyond that, restrictions
such as a ban on further customisation
apply. To use LAUNCHcast, you need to
have Internet Explorer 5.5 or higher, and at
least Macromedia Flash 6.0.

Iceberg Radio (www.icebergradio.com) is
another online station worth tuning into.
It has around 250 channels, distributed
across categories that include Comedy,
Oldies, Opera, etc. Do remember that you
need to register—for free—before you sing
along. BBC (www.bbc.co.uk/radio/) also has
several music channels guaranteed to keep
you hooked.

Sa Re Ga...
With sections named Forthcoming, Instru-
mental, Classical, Meditations, Pop, Oldies,

Ghazals ,
Remixes etc., Smashits
(www. smashits.com) has one of the
largest collections of Indian sur. Regional
music finds its place here in sections
devoted to Bhangra, Bengali, Carnatic,
Gujarati, Kannada, Malayalam, Marathi,
Tamil, Telugu and north Indian 
classical music. 

Its radio stations are sorted by singer,
music director, actor or actress, year of
release, etc. That isn’t all—there are movie
trailers, song clips, screensavers, wallpapers,
jokes, astrology, and even e-greetings. Regis-
ter for free, and create WebCDs—online
albums comprising numbers of your choice!

Although Raaga (www.raaga.com) has a
smaller collection than Smashits, the audio
quality is slightly better. It has three
sections—Hindi, Tamil and Telugu. Here too,
albums are grouped by actors, actresses,
singers, music directors, etc. You’ll also find

lyrics of selected songs.
In the mood for some Bhangra?

PunjabiSongs.com (www.punjabisongs.
com) is just what you need. Apna Radio
(www.apnaradio.com), too, has some
decent Punjabi fare. Groove to the beat
of Indian folk music at Beat of India
(www.beatofindia.com). Music India
OnLine (www.musicindiaonline.com) and
the music section of AllIndianSite.com
(www.allindiansite.com) are also worth a
mention for their collection of
Bharatiya Sangeet.

Views on news 
Think news, and you probably think
BBC; so head to www.bbc.co.uk/radio. It has
news channels in 42 languages, includ-
ing BBC Hindi. CNET Radio (www.cnetra-

Find a big collection of Indian music at
www.smashits.com
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dio.com) gives you your dose of technology, peppered with video and
audio news, analysis and interviews. 

Another news radio Web site is ABC News Radio (www.abcradio.
com). CNN’s Videos section (www.cnn.com/video/) and BBC’s Video
Nation (www.bbc.co.uk/videonation/) put up crisp, concise, video 
clips from their reporters across the world. Indiatimes’ Talk 
Radio (http://talkradio. indiatimes.com) gives you news from an Indian
perspective. 

If music is the only world you’re bothered about, then Yahoo’s
Launch is just the Web site for you. It has sections for artists’ photos,
lyrics and interviews. Launch also archives its articles. 

I’ll be watching you
Blastro (www.blastro.com) is known for its huge music video collec-
tion that’s categorised into Hip Hop, R&B, Pop, Dance, Electronic,
Rock-Metal. You can use either Windows Media Player or Real
Player to watch them. You can also launch the external player if
you don’t want to see the video embedded in the browser. Blas-
tro also has movie reviews, and a few TV shows that you can
watch for free.

Yahoo! Launch also has a slew of the latest music videos for free
viewing. As a guest, you are confined to two videos. For more,
you’ll need to register, free of cost. You need Windows Media
Player to play these. Launch maintains a list of the top 100 videos,
based on user hits with new videos added daily in the ‘New Music
Videos’ section. You can also submit your own music videos for
listing. However, you will need to send these on videotape, and not
in electronic format.

Other music video destinations worth a mention are Rolling
Stone (www.rollingstone.com/videos), Video-C (www.video-c.co.uk) and
Music Brigade (www.musicbrigade.com). iFilm (www.ifilm.com ) is a
good place for movies, trailers, clips, short films, stunt clips, funny
ads and TV clips. 

Where do I go from here?
If you’re in a quandary on what to choose, since just about every-
thing sounds super, a radio directory is what you need. You can start
off with Real Guide Radio (http://radio.real.com). It has thousands of
links, categorised into different sections. Of course, you need Real
Player to tune into these stations. 

Another good place for perusal is
About.com’s Radio section
(http://radio.about.com). It has a
horde of links to Internet radios,
radio news, streaming software, and
lots more. Flip2it (www.flip2it.com) is
a directory of Webcasts and Internet

radios classified into Movies, Arts,
Science, Computing and so on.

The next time you go a-cruising, let
these radios and TVs rev up your spirits. A dial-up connection,
with a decent speed, will just about help, but a broadband connec-
tion will accelerate the experience to a high. 

Slow Net speeds warrant a choice of stations that broadcast at
lower bit rates. You may have to compromise on quality, but that’s
better than listening to chopped bits as the numbers buffer up.

And yes, as you decide on the station and the service, don’t
forget to post your experiences at the Digit Readers’ Forum
(http://www.thinkdigit. com/forum).

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

1/2 page V AD
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You just can’t beat a
great idea. The basic
barcode, or the
Universal Packaging

Code (UPC), first introduced
in the early 1970s, is one such.
UPC barcoding was the first
standardized product identifi-
cation system. It’s simple and
easy to implement: with no
effort, you can barcode every-
thing from groceries to books
and clothes. The white and
black bars require just a quick
scan to update the status on
the inventory tracking system. 

The idea is to allow manu-
facturers, wholesalers and
retailers track products and
shipments.  Whether it’s a
supermarket checkout line or
your local British Council library, barcodes
have found use in all kinds of places.

Intelligent stripes
Radio Frequency Identification (RFID),
married with today’s Enterprise Resource
Planning (ERP) solutions, may soon be the
next big thing in inventory management.
The technology provides an automated
method to collect product or transaction
information. The RFID system works using
‘smart’ tags, with inbuilt silicon chips that
store data, a reader that scans information
from the tags, and  the infrastructure to
store and analyse the data.  

Barcodes made inven-
tory tracking easier,
but they have

their disadvantages. For starters, each
barcode has to be read in individually by

the reader. If an entire warehouse-
worth of products needed to
be checked into a computer,
it could mean several hours
of work.

Furthermore, the basic
barcode is just a tag with data

printed on it, and this data can’t be
updated. Except, of course, by sticking

another barcode over it.
This is where
RFID tags

come in. RFID
takes asset tracking to the
next level; with smart, intelli-
gent tags embedded in the pack-
age, the information on the tag
can be scanned and updated
automatically by ‘readers’. Little
wonder that courier service

FedEx, and US retail giant
Wal-Mart, are looking at RFID
implementation for stream-
lining delivery and asset
management.

How RFID works
An RFID smart tag has a tiny
inbuilt integrated circuit, and
a coiled antenna. A tag beams
out the information it
carries—how far the tag can
beam information depends
on the operating frequency—
and automated reading can
be done by installing readers
wherever required. 

The readers are
connected to a computer
network. After a reader reads
the data from the tag, it

passes it to the computing network associ-
ated with the RFID system. The network
takes this incoming data, and tracks and
updates its records. If the tag information
needs to be updated, appropriate instruc-
tions are sent back to the tags.

Tags are of two types—active and
passive. An active tag has its own, internal
power supply. This allows them, for
instance, to add in new data or modify exist-
ing data, independent of a reader. Passive
tags have no internal power supply; the
same electromagnetic field that is emitted
by the reader is used to power up the tag, so
that it talks back to the reader.

The advantage is that
passive tags can have nearly unlimited life
spans, and need not be out of service unless
there’s a circuitry breakdown. Active tags,
though, have a lifespan limited by the

Solomon Lewis

Beyond 
Barcodes

Someone’s
taking those
little black
and white
bars on your
bag of chips
further...
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endurance of the onboard battery. They are
also more expensive to produce, and are
larger.

Readers and tags can use low frequen-
cies—30 KHz to 500 KHz . Low frequencies
means  lower ranges—up to a few metres.
They may use high-frequency communi-
cation systems too, such as those in the 2.4
GHz range. These offer far longer ranges—
up to 25 metres. However, they’re more
expensive to build and operate.

RFID in action
The market for RFID solutions is huge.
RFIDs can network just about anything—
shipping containers, clothes, books and
even pets! The manufacturing and retail
logistics sectors are big users of current UPC
technologies. So are the service sectors that
move shipments across the world. RFID
would enable them to monitor production
and eliminate wastage, since inventory and
other data would be real-time. In fact, Wal-
Mart has mandated that their top suppliers
start using RFID technology, and that all
shipping cases be RFID-enabled, come
2005. The US Department of Defence is also
considering mandating RFID.

The organised Indian retail sector
would be interested in RFID too. So would
the Indian transportation logistics sector. S.
R. Mallela, Chief Technology Officer of AFL,
an express parcel delivery service, says,

“RFID, coupled with other technologies,
will help us track our shipments from point
to point”. He should know: AFL is a major

player in the Indian logistics services sector,
as a leading parcel delivery service.

AFL is considering implementing RFID,
coupled with other tracking systems based
on Global Positioning System (GPS) or
General Packet Radio Service (GPRS), which
will help deliver up-to-date information to
customers about their shipments. 

Despite the substantial investment
needed to implement the technology,
Mallela points out that the returns in
terms of customer benefit make it worth
it. Currently, information while tracking a
shipment is obtained only when it reaches
a checkpoint in the system; an RFID
system in conjunction with real-time
tracking using GPS, would let customers
track their goods on a minute-to-minute
basis over the Internet. While AFL is not
using RFID-based tracking systems now,
they intend to conduct feasibility trials
over the first half of this year.

Other RFID applications include track-
ing farm and wild animals. Animal conser-
vation experts in several places—Africa, for
example—already use RFID microchips to
track animals habits and to ensure their well
being. For example, if an animal is in the
same place for a long time, it might mean
that it’s been trapped.

In a pilot project, the Indian Ministry of
Environment and Forests worked on

getting RFID
m i c r o c h i p s
implanted in elephants in north-
eastern India in 2002. The idea was to create

and maintain a database of the elephants
and track their habits.

Software giant Patni Computer Systems
worked on a pilot of an animal tracking
system, using RFID, for a major US-based
client, which, in Dilip Dhanuka’s words,
“tracks the animal from farm to plate”.
Dhanuka, General Manager of Products and
Technology group at Patni Computer
Systems , says that the system works using
RFID readers and a desktop synchronisation
device—a service that allows one to view
and control everything from one central
location. A Web application allows users to
aggregate, synchronise and view data across
multiple farms and the abattoir, and also to
modify the database.
The readers, also
c a l l e d

‘Romeos’—‘Juliet’ is the desktop
synchronisation device—can be inter-
faced with other external devices,
such as thermometer sensors.

RFID technology can be
employed in security and identi-

fication systems as well. In an interest-
ing case, the European Central Bank is

MAY 2004

Wired Magazine reported early this year that
Intel and the Georgia Institute of
Technology were working on systems that
kept track of senior citizens and their health
at any point in time, using RFID. Sounds
like an amazing application, but there's a
trade-off with privacy. Pervasive RFID could
well let Big Brother keep tabs on you. Of
course, in the case of Intel and
GeorgiaTech, the seniors signed into the
program, and the data went only to
caregivers who monitored the seniors’
routine for any indications of illness.

Imagine RFID-enabled clothes that could
keep tabs of your movements and
preferences. Worse still, think about RFID
tags that could keep tabs of who you
interact with, when and where. Most of
this, admittedly, is doomsday fantasy
material, but deep privacy concerns do
exist: if anything can be tagged, and if that
tag could keep reading in all sorts of
information and potentially spill it out to
those who shouldn’t have it, privacy is
threatened. RFID technology
implementation in the mainstream will have
to address that before everyone’s happy.

Privacy

The package, affixed with an RFID
tag, is read in at the checkpoints.
Updates are immediately made
to the database records storing
the consignment information. 
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Tags
The tags hold the inventory data, and are
affixed to individual items and the 
shipping crates.

The tags are affixed onto the individual items, and
inventory and shipping data is written onto them.

The tagged item is crated, and the shipping crates
(also tagged) move out from the manufac-
turer's warehouse to the distribution
point…

At the distribution point, the tags
are read and the consignment is
sent to the correct destination… 

At the destination, the 
consignment is received, and
acknowledged for, and verified by 
reading in the tags. The consignment is then
unpacked and individual items are then made
available in the store.

While billing the items, the tags are read in, and
the data is updated on the

network. The tags can then
be disabled or removed,

and the customer can
take the goods

home. 

This is how RFID could come into the supply chain for retail sales

Computer 
network
The computer network
gets the information from
the readers, then updates
their records.

The users can now
track and analyse the
status of individual items
in the inventory.

Readers
The readers talk to
the tags, obtain the 
information, and pass
this on to the 
computer network

Factory

Distribution
Centre

Store

Billing

A

A
B

B

C

C

1

1
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2
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3
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4
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even considering putting RFID tags  in currency notes to 
thwart counterfeiters. 

In the future, your bank accounts will directly tie into your
RFID-enabled cards, and the RFID-tagged goods you buy will be
talking straight to the computers that make your bills. All you’d
need to do in a supermarket is swipe your RFID-enabled card, pick
up what you want and walk out. For some years now, it’s been
possible to pay highway toll charges in the US and Europe using
RFID-based cards. 

The problems
The biggest hurdle in RFID’ path is cost. RFID readers start off at
about Rs 23,000, and the cheapest tags come for about Rs 10.
Barcodes are only about 50 paise. Also, there are problems of
erroneous data capture. Initially, there were several  incompati-
ble RFID standards, which resulted in the technology not pick-
ing up in popularity. Other concerns include privacy. (See box,
‘Privacy’ on page 125) 

With vast investments, there’s been a deliberate move to stan-
dardise the technology and create cheap, workable solutions. A
recent study by IDC, a global market intelligence and advisory
firm in the IT and telecom industries, claims that by 2008, RFID
should account for $1.3 billion of the US retail supply chain.

That’s a lot of money, but there’s a world of information to be
tapped in the retail supply chain. For this to work, though, the
RFID system will have to be affordable, and that tags should be
cheap enough to mass-produce. RFID experts have estimated that
the magic number is the 5-cent per tag cost.

At MIT, researchers and industry sponsors formed the Auto-ID
Center in 1999, which worked on creating a workable system to
manage the data that’s out there, for example, in the retail sector. 

The result is the Electronic Product Code (EPC). EPC-compli-
ant smart tags will hold just 96 bits of data; this includes a 40-bit
serial number, and product and name information, amongst other
parameters. Unlike conventional RFID tags, the Auto-ID frame-
work emphasizes on minimal data—hence the 96-bit limit. The
entire system will focus on storing the information on a commonly
accessible computer network. 

Think of it as the Internet of the RFID age, where the system
will resolve the product information from the serial number
using the Object Name Service (ONS), which is functionally
similar to a DNS.  The entire information is going to be coded
in what’s known as the Physical Markup Language, or PML.

The system works by querying the location of
the servers hosting the information using the ONS,
and then reading in the information on the PML
server. 

The entire system should be accessible with a
computer connected to a reader, and an RFID tag-
management software called Savant controls the
RFID-related data read in. 

The end result, as Auto-ID hopes, will standard-
ise and bring down the cost of the RFID architecture,
and eventually let EPC take over from the current
UPC standard. 

Patni’s RFID pilot was based on the Auto-ID’s
framework, and it has a lab manned by supply-chain
and RFID consultants. The lab lets them and their
customers experiment with  RFID deployment, and
understand what RFID could mean for them. 

RFID’s grand entry
Technologies such as RFID will eventually move into the main-
stream, perhaps through supply chains at first.

Experts opine that, for a while, RFID will co-exist with UPC.
Once contentious issues are sorted out, there’s every chance that
we could see an example of cheap pervasive computing dominat-
ing our environment. Dhanuka says the RFID industry calls 2004
‘the year of the pilots’. (2005 is expected to be the year that wide-
spread RFID deployment begins.) So you won’t need to wait too
long—within the next couple of years, your neighbourhood store
could well be tracking their supplies right from source.

SRINIVASAN RAMAKRISHNAN

srinivasan_ramakrishnan@thinkdigit.com
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These steps pertain to the HP 27A and
28A cartridges that are used in the HP
DeskJets 3550 and 3650. For other
printers, please refer to their respective
manuals.  

Switch on the printer and lift the
top lid. The carriage assembly

centres itself right in the middle, allowing
for easy access to the cartridges.

To remove the
cartridges, apply some

gentle pressure in the down-
ward direction, and then pull
the cartridge towards you.

Place the cartridges
upside down, or on their

sides, on a table. 

An entry-level printer, today, costs
no more than Rs 3,000, and that’s
a great price for a home printer. But

that’s not the ownership cost, as the
hidden costs that surface once you start
using the printer will tell you. Cartridges
are exorbitant, and sometimes cost nearly
as much as the printer itself. 

Under such conditions, refills are
economical. We tried refilling a cartridge
to see if the kits you get provide as good
print quality, without harming the

printer. Various kits are available in the
market, and we settled on the most
popular and easily available—the one
from Lipap.

The cartridges we used for the test
were from the HP DeskJet 3550—our value
winner in the home category for April
2004. We printed various kinds of docu-
ment, such as pure text documents, text-
and-picture documents and photographs.
We then compared the results to those
obtained using the original cartridges. 

What you need
n An appropriate cartridge refill kit—
available at your local hardware vendor
n A sharp blade or cutter
n A cleaning cloth or tissue paper 

Preparation
Before refilling, get all the materials in
one place. Remove the refill bottles
from the kit, unwrap them and keep a
cleaning cloth or tissues handy, for
accidental spills.
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Pull out the cartridges without applying force Ü

PRINT, REFILL, PRINT

Removing cartridges from the printer

Don’t sell your printer for a new cartridge—refill the old one instead

n Do not apply force—just a gentle push in the downward direction is
enough to release the cartridges from their locked position.
n Do not place the cartridges with their ink nozzles facing the table.
Nozzles are delicate and are likely to be damaged. 

Atul Deshmukh
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Locate the fill holes on the
cartridges. Their position differs

from one cartridge to another. Refer to the
manual bundled along with the refilling
kit for this information.

For HP cartridges, the fill holes are
underneath the sticker on the top of

the cartridge. Take a sharp object—a cutter
for example—and lift one edge of the
sticker to expose the holes under it. 

You’ll see five fill holes. Refer to the
refilling manual to find out which

one corresponds to which colour.

Now, take a refill syringe. Each
syringe is demarcarted into three

parts. Each part equals one refill. Hence,
each syringe gives you three refills.

Remove the rubber cap covering
the tip of the syringe, place the tip

near the fill hole and slowly insert the
needle as far as it will go.

Once the needle is in, hold the
syringe upright and open the top

cap so that the ink flows down. Close the
cap once the ink level in the cartridge
reaches the lower mark. 

Tilt the cartridge and the syringe to
the horizontal position, and pull

the needle out.  

Repeat the above steps for each
colour, and for the black cartridge.

Put the refilled cartridges back into the
bay and close the top lid. Try printing
some documents with varying colours
and text. If the colours are not properly
reproduced, clean the nozzle.

Remove the cartridges as
mentioned in the earlier steps, and

put them upside down on a table.

Take out the tissue
provided along with the
kit, and put some drops of

its cleaning fluid on it.

Place the nozzle area on the wet
tissue for a few minutes.

Replace the cartridge, and take
some more printouts. If the colours

appear faded , or you observe horizontal
banding, try cleaning the nozzle via the
printer driver. 

Refilling the cartridges

Post-refilling procedure

n Do not remove the sticker
completely. Just pull out three-

fourths of it, so that you can cover the
holes again.
n After removing the rubber cap, hold 
the refill syringe horizontally to avoid 
ink spills.  
n To avoid wastage, close the top cap
before the ink level in the syringe
reaches the next marker.  
n Do not overfill the cartridge. This can
lead to leakage. 
n Wait for some time before pulling out
the needle so that the ink in it is soaked
up by the sponge in the cartridge.
n Before replacing the needle cap, see
that there is no leftover ink that might
dry and clog the needle. 
n To clean the nozzle using the printer
driver, go to Start > Programs > Hewlett
Packard > Printer assistant > Utilities >
Printer maintenance > Clean cartridges.   
n Do not wipe the nozzle with the
tissue, as this might damage the nozzle.
Just place it on the tissue, and apply
enough pressure on the nozzle so that it
comes in full contact with the wet tissue.  

Details

Cost for colour refill*/cartridge (Rs)
Cost for Black  refill/cartridge (Rs)
Total Cost incurred (Rs)

Refill kit

400
100
500

Original 
cartridge

1,100
800

1,900

* Cost includes all three colours; each colour refill can be used thrice 

Peel the sticker from one corner using a 
sharp blade

Open the top cap so that ink flows due 
to gravity

Never place your finger on the circuit when
holding the cartridge

Place the cartridge as shown above to clean
the nozzle

5
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Our analysis looked at two aspects—
performance and quality. In performance,
we logged the time taken to print our test
files. As seen in the results, the differences
aren’t significant. 

Surprisingly, the refilled cartridges did
better in most tests. In our opinion, ink
characteristics such as viscosity, pigment
concentration, etc. vary— hence the
difference in the output.

Quality-wise, the results were  rather

astonishing. There was hardly any differ-
ence between the two text printouts. The
combi-document differences were signifi-
cant, with the genuine cartridge yielding
better sharpness and reproduction of details. 

The refilled ink also took some
seconds to dry on normal paper—the
media that was used for most of the tests,
except the photograph test. This charac-
teristic—drying time—might be what’s
responsible for the differences in quality

between the two combi-document
outputs, and in the performance figures.

The photograph test saw minimal
differences, and these were restricted to
tonal deviation. The near-perfect skin
tone produced by the genuine cartridges
was lost to some extent when the refilled
ones were used. Barring this, there was
hardly an error that we could point out. 

Overall, the differences between the
two cartridges were minimal (refer table
alongside), and in everyday use, they’d
hardly matter. Moreover, if you refill the
cartridge twice—which is what we feel is
the safest bet over buying new
cartridges—you can easily save enough
money to buy a new printer, rather than
buying new cartridges, or refilling them
for the third time! 

SANKET NAIK

sanket_naik@thinkdigit.com
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Analysis

An image produced by the
refilled cartridge. Note the
slight difference in detail,
as well as colour
reproduction, when
compared to the image on
the right

The refilled cartridge loses out on reproduction of detail (marked in the
circled areas), but not too much

Note the level of detail in the circled areas, produced by the original
cartridge—it’s not so obvious; there’s only a subtle difference

The image produced by
the original cartridge.

Note that all colours—
the blue, especially—

have been rendered
perfectly. Note also the

level of detail in the
flowers

The Results

Refilled 

cartridges

14

133

74

150

388

Original 

cartridges

18

140

72

148

395

Text printout—Normal 

Text printout—Best

Combi-document—Normal

Combi-document—Best

Photograph—Best

Refilled 

cartridges

3.50

3.50

3.00

3.00

3.25

Tests
Original 

cartridges

3.50

3.50

3.50

4.00

3.50

Quality (Scale of 5) Time taken in seconds
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You’ve just returned from a busi-
ness trip, and start the process of
transferring files from your laptop

to your PC. With fingers and toes
crossed, you pray that everything goes
well. As you even sit and search through
folders, to see which files aren’t already
on the PC, you contemplate quitting
your job. Fortunately for you, we’ve got
a simple solution. All you need do is let
Windows XP’s Offline files feature help
you out of this predicament.

Enabling offline files
First, go to Control Panel > User

Accounts > Change the way users log on or
off and uncheck ‘Fast User Switching’.
Next, open My Computer, and go to Tools
> Folder Options. Switch to the Offline
Files tab, and ensure that ‘Enable Offline
Files’ is ticked. Here, you’ll also find
options that let you decide about
synchronising while logging on and off.
Note that these affect all the network
drives you set for synchronisation.

Map network drives
It’s time now to create a network

drive. Map a shared folder over the
network using a drive letter. On the laptop,
open My Computer, and click Tools > Map
Network Drive, choose a drive letter, and
enter ‘\\computername\sharedfolder’,
where ‘computername’ is the name of your
desktop PC, and ‘sharedfolder’ is the folder
you’ve shared on the desktop computer.
This folder should have read and write
access in order to synchronise.

Networking offline
Click on the networked drive in My

Computer and go to File > Make Available
Offline. A wizard lets you set further options
when you do this for the first time. This
option is available only by going through
the aforementioned path. To disable
synchronization for a mapped drive, select

the drive in My Computer, and go to
File > Make Available Offline and
remove the checkmark. 

Synchronising 
When you first make a

network drive available offline, all
the files are downloaded from your
laptop to your desktop PC. When-
ever you re-plug the laptop to the
network and log on to Windows, the
network drive is synchronised.
Synchronisation is done based on
the date the file was last modified.
Say you created a file in offline mode,
named ‘somefile.txt,’ on May 25,
2004, which was not accessed thereafter.
Say another user created a file with the
same name in the target folder on the
desktop on May 26, 2004.

If you plug your laptop into the

network after the 26
th
, the file on the desk-

top replaces the one on your laptop.

Synchronisation
Manager

Access the Synchronisation Manager by
going to Start > All Programs > Accessories

> Synchronize, or just enter ‘mobsync’ in
the Run dialog box. Here, you’ll see a
number of network drives, as well as
Offline Web pages to be synchronized.
Select an item and click Setup. There are

three tabs where you can specify
when to synchronize. The
Logon/Logoff tab lets you decide
about  synchronizing while logging
on or off. Use the On Idle tab for
synchronising when the computer
is not in use. In the Schedule tab,
set the time at which synchroniza-
tion should start automatically.  

The third-party way
Third-party software such as
Second Copy (www.centered.com),
Folder Match (www.foldermatch
.com), etc., also help you orches-
trate harmony between your laptop
and desktop PC. They also throw in
some nifty features such as mass file
renamers and duplicate file finders. 

Synchronisation saves a lot of grief
when maintaining that much-needed
accord amongst your work files. Say good-
bye to those backbreaking data transfer
days of yore!

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

Lap Sync

Drives available offline get synchronized once you plug
the laptop into the network 

The Synchronisation Manager gives details of the process 

Find it on the Mindware CD
Second Copy 2000Fed up of manual file transfers after tedious business trips?

Get in sync ...



133

insight n
n smart@work

MAY 2004

Document security is a matter of
concern for anybody, and in
extreme cases, a matter of high
anxiety. You may be a corpo-

rate employee worrying about whether
prying eyes may lay see your report, or a
home user worrying about other account
holders perusing your data. Here, then
are simple steps that ensure a basic level
of protection and security. 

Zip it! 
The easiest way to protect files is to put
them in a password-protected zipped
file, using such software as WinZip.
With WinZip 9.0, you can secure files,
encrypting them with the Advanced
Encryption System (AES). This
method, also known as Rijndael,
has been approved and adopted

Paranoia about private 
data is a good thing. Find
out how to lock your 
docs, erase your tracks,
and more

Mexy Xavier
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by the US Government’s National Institute
of Standards (NIST).

WinZip has three encryption
options—standard, 128-bit AES and 256-
bit AES. The less secure standard version is
compatible with other applications and
older WinZip versions. The most secure
256-bit AES has high encryption and
decryption times.

To create an encrypted zip file in
WinZip, create a new archive by going
to File > New Archive. Enter the filename,
and press OK. An ‘Add’ dialog box will
pop up. Select the files you want to add,
and click OK. After this, go to Actions >
Encrypt, select the desired encryption,
enter your password, and click OK.

Although you need a password to
access files in a protected Zip file, the pass-
word is not required for deleting or replac-
ing files from, or in, the file. 

Jack of all trades
Portable Document Format (PDF), is
another popular way of distributing docu-

ments. You can set up
different password levels
while creating PDF docu-
ments using Adobe
Acrobat Professional. You
can also limit editing,
printing and even copying
for a PDF document. 

To do so, open the PDF
file and go to Document >
Restrict Opening and Editing.
In the Password Security
dialog box, select the
Acrobat version to open
the PDF. To set a password
to open the file, tick
‘Require a password to

open the document’ and enter it. 
To restrict editing, copying and print-

ing, enable the relevant checkboxes and
enter the passwords. Here, as you’ll see,
you can set other options as well.

Secure Office
Use the common, humble password to
securing Microsoft Office documents. In
Word, Excel, or PowerPoint, go to Tools >
Options > Security. You’ll see two fields to
enter a password for the open file. You
can set passwords to open and modify. If
you click ‘Read Only’ when asked for the
password, the file opens in that mode,
and the original file can’t be altered. The
passwords here are ciphers used by the
encryption algorithm.For better encryp-
tion, click Advanced,  and choose the algo-
rithm you want from the list.

Word stores detailed information,
known as metadata behind the scenes
about every document it creates.
Although metadata is stored to maintain
a history of files and aid in searching and

retrieving documents, it
can become a privacy
issue. However, it ensures
that proprietary informa-
tion is not separated from
the document. To see
what kind of information
is stored in Word files,
simply open one in
Notepad. You’ll find infor-
mation about the file’s
author and the path to
where the file was stored.

To ensure that this
data is removed while
saving files, go to Tools >
Options, and click on Secu-
rity. Tick ‘Remove
personal information

from file properties on save’, and click OK.
Changes apply only to the current file.
Hence, do this for every file.

To remove all metadata, locate the file
in Windows Explorer, right-click, and click
Properties. Delete all the information in the
Summary tab. There are many more
hidden things such as ‘track changes,’
comments and hidden text in Word that
need to be removed for total privacy. To
show all comments and changes tracked,
go to View > Markup. To show hidden text,
go to Tools > Options, switch to the View tab,
and enable ‘Hidden Text’.

Saving previous versions is useful
when you want other versions embedded
in the same document. However, Word
also saves information about who saved
the document. To remove this, go to File >
Versions. Click the version from the list,
and then Delete.

Another feature that might infringe
on your  privacy is the Fast Save feature,
enabled by default. Open a Word docu-
ment using the Recover Text from any
file method explained earlier and you
may see information deleted from the
file. To disable Fast Save, go to Tools >
Options, click the Save tab, and remove
the checkmark Allow fast saves.

When recording a macro, its header
begins with something like:

‘ Macro1 Macro
‘ Macro recorded 3/31/2004 by Upen-

dra Singhai
To delete this, press [Alt] + [F11] to

invoke the Visual Basic editor. Double-Limit writing to a PDF document using Acrobat 6 Professional

Remove personal information from Word
documents before distributing them

Encrypt your files in WinZip with 256-bit AES
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click the module name in the project
explorer window. Delete the line that
contains your name, and return to Word
by pressing [Alt] + [Q]. You can also delete
comments from the dialog box that comes
up when you click Tools > Macro > Macros.

To restrict editing in Word, go to Tools
> Protect Document. In Word 2002, a dialog
box lets you choose to protect the docu-
ment  from tracked changes, comments
and forms. Word 2003 shows you a task
pane coming up with more options to set. 

Here, choose specific formatting and
editing restrictions, and choose excep-
tions. Thereafter, click ‘Yes, Start Enforcing
Protection.’ Similarly, protect an Excel
Workbook by setting a password, remov-
ing metadata, or by setting various options
under Tools > Protection.

To remove metadata, go to Tools >
Options. In General, delete contents from
the ‘User name’ textbox, and the dialog
box that appears at File > Properties. 

If your PC is on a LAN,
your username appears in the
‘Last Saved’ field. This occurs
even if you’ve saved the file
after deleting this data. A
workaround is to copy the file
to your local hard drive, get off
the LAN and delete all data as
specified above. In general,
never open a document

directly from the network location—
always make a local copy.

To delete more, hidden metadata,
delete all comments, headers, footers and
hyperlinks from the document. Also,
ensure no hidden cells are unprotected. To
do so, first press [Ctrl] + [Shift] + [Space] to
select all cells. Now, show all rows and
columns by going to Format > Row > Unhide
and Format > Column > Unhide respectively. 

Embedded objects such as a Word
document have different propeties than
that of the workbook. Remove metadata
for them separately. There’s another way
out: select the object and cut it ([Ctrl] + [X]).
Then, go to Edit > Paste Special, and choose
‘Metafile’ format. Press OK to paste it
without any metadata. However, you now
won’t be able to edit the object. Finally,
delete custom views by going to View >
Custom Views. You should also remove
comments from macros.

More protection
In Excel, the layers of protection that
control data access to your workbook are
not true security features: you can prevent

the original data from being changed, but
you can’t stop anyone from copying data
from workbooks. These are thus useful
only, for example, when you want to
avoid someone accidentally making
changes to the data.

To prevent anyone from making
changes  to any cells, go to Tools >
Protection and click ‘Protect Sheet.’ This
dialog box also allows you to set more
options, such as a password to unprotect
the sheet, and individual changes that
users are allowed to make. This applies to
all cells. To unlock specific cells, select
them, right-click and choose Format Cells.
Then, go to the Protection tab and remove
the Locked checkmark.

Go to Tools > Protection > Allow users to
edit ranges. Here, define the ranges of the
cells that all users are allowed to modify.
Click Permissions to choose who can
modify the contents. 

This is different from the aforemen-
tioned lock-unlock method, since it’s
applicable for different users in Windows
2000 and XP. Secondly, the selected users
can edit these ranges without a password.
These options come into effect only
when you’ve protected the sheet.

Protecting PowerPoint
Metadata in PowerPoint presentations can
be deleted in ways similar to those used for
Excel. Go to Tools > Options and, from the
‘General’ tab, delete the information you
don’t want. Then, go to File > Properties and
delete information across different tabs. 

If you’re on a network, make a local
copy of the presentation, disconnect from
the network and then delete this informa-
tion. Disable fast saves by going to Tools >
Options > Save and removing the check-
mark that says ‘Allow fast saves.’ Also
delete comments, headers, footers, hyper-
links and comments in macro code as
with Excel. Give the same treatment to
embedded objects as with Excel, too.

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

The macros you
create have
your name in
comments

Microsoft Office 2003 Professional allows
you to restrict the permissions for the
documents you create, using Information
Rights Management. You can restrict access
to a document even after you send it 
to someone.

To create restricted content with Office
2003, go to File > Permissions and select
‘Restrict Permission As’. You are asked to
install the latest version of the Windows
Digital Rights Management Client—a small
345 KB download. You will be asked to sign
up for a free trial account on Microsoft’s
rights management server. Now you see a
dialog box where you can specify the .NET
passport addresses of the users, and the
permissions you want to give them—Read,
Change and Full Control.  

When users open this file, they will have
to sign in using their .NET passport account.

The extent to which they can work on the
file depends solely on the permissions you
had set when creating the file.

Information Rights Management in Office 2003

Security is a serious issue, and not just
for system administrators. What we’ve
discussed here is a drop in the ocean.
Share what you do to make your files
secure. Drop us a mail at readerslet-
ters@jasubhai.com or post your
comments at the Digit Readers’
Forum—www.thinkdigit.com/forum.

Feeling protected?

Set the .NET passport identities and permissions
for all users allowed to access your file

MAY 2004135
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Instant messaging (IM) isn’t just used
for chatting with friends anymore.
It’s pretty much a standard intra-
office communication tool as well.

Why walk a few feet to tell a colleague
something, when you can quickly type
out a message and hit [Enter], right?

IM depends entirely on the Internet,
and this is where the problem begins.
What about offices where employees don’t
have Net access, where dial-up access is
used, or where all IM ports are blocked by
a terrifying systems administrator?

Here’s a simple solution—get yourself
a Linux box, install a chat daemon, inform
your colleagues and get a big pat on the
back from your boss—you’ve just saved
the company some money on otherwise
wasted bandwidth.

JABBER
Beware the Jabberwock, my son!
The jaws that bite, the claws that catch!

Unlike Lewis Carroll’s proclamation,
Jabber is really just a neat way to start your
own local chat server. Jabber runs happily
on an underpowered rig, provided there’s
enough network bandwidth. 

To get the Jabber server up, you can
either choose one of its many open
and closed source implementations or, head
to Jabber.org and download the JabberD
Quickstart server (http://jabberd. jabberstu-
dio.org/quickstart/). This contains pre-
compiled binaries and a neat setup script.  

Create a separate user account within
a new group, in order to run Jabber.
Though not compulsory, this makes
sense from a security point of view. Also,
install Jabber in a directory with the
required permissions.

Log in as superuser and run the
‘groupadd jabber’ command, followed by
‘mkdir /usr/local/jabber’ to create a directory
where you can install and run Jabber. Now,
run ‘useradd -d /usr/local/ jabber jabber -g jabber’
to create the user ‘jabber’, with the home
directory at /usr/local/jabber and within the
group ‘jabber’. After all this jabbering, use
‘chown jabber:jabber /usr/local/jabber’ to get
jabber the permissions on the home direc-
tory. Copy the compressed Quickstart
installer into this directory. 

Start jabbering
Untar the Quickstart daemon from the the
/usr/local/jabber directory while logged in
as the user ‘jabber’. You don’t need to log
in as root while untarring, setting up or
running JabberD. Change to the directory
containing the extracted JabberD and run
the setup script by typing ‘./setup.sh’

This opens up the General Configura-
tion menu. Here, select ‘Gen’ and supply a
fully-qualified domain name for your
jabber server. This can either be a name
such as gothic.sytes.net that maps to the
jabber server machine’s IP, or the IP address
of the Linux box, if you intend to make
this sit on a LAN and behind a firewall.

The next, step asks for the name of the
server. Press OK to skip. The third screen

asks for a server description. At the fourth,
you are asked for a URL that users can
view. Again, these are optional. 

Following this, the setup script
prompts you for a JabberD server admin-
istrator name. Use the formerly created
jabber user account, and enter in the
server administrator password. Remember,
this is not the root password; it’s just the
JabberD admin password. 

Choose ‘Yes’ when asked to enable PID-
file support. This completes the General

Still using Yahoo! and MSN? Here are some super-simple chat solutions for both office and home

All right, you have the bandwidth, and
the Linux box in place, but you don’t
have a static IP address, or a domain
that you’d like to tag that IP to. Well,
this is how you can work around the
annoyance of dynamic IP allocation.

Look up www.no-ip.com—a free
service that lets you have a sub-domain
under the various domains they own.
Sign up, and get your box a name as
cool as gothic.sytes.net. Download
their tiny application program to get
this domain to reflect your changing
IP address.

It comes in flavours for Linux, Unix,
Windows and Macintosh. Untar the file,
run ‘make’ and ‘make install’. Enter the
e-mail address and passwords you set
while registering, and run it in the
background. The application
automatically gets the current IP address
and sends the same to no-ip.com. They
update this in the DNS records on the
Internet, and voila, gothic.sytes.net will
redirect traffic to your box.

No IP? No problem!

The Daemons Within

If you can install the OS, you can install
and run an IRCd“

JACKSON LOW (a.k.a. metalrock), MusIRCd daemon developer and final year Computer
Engineering student at California State Polytechnic University, Pomona, on the minimum system
requirements to run MusIRCd

The Daemons Within

Setting the domain name for your Jabber
server is simple; just type in the computer’s IP
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Configuration setup; the install script
generates the required (XML) config file,
and brings you back to the Configuration
Options screen. 

Before starting the server, select the
Users (User Administration) option. Next,
select the reg (Registration Settings)
option. First up, permit public registration

to ease the
task of setting
up individual
user accounts.
The screen
then asks you
if it should
inform the
J a b b e r D
administrator
about users
making new
accounts. This
is recom-
mended if
you expect a
lot of users

and their traffic, but for a small depart-
mental chat server, choose No.

Finally, it regenerates the config
file returns to the Configuration Settings
screen. Now, scroll down, and select
Start to kick-start your Jabber server.
Discontinue running the setup.sh
script once it informs you that the server
is running by scrolling down and
selecting Quit to exit. Confirm that
the server is running by using the ‘ps -aux
| grep jabber’ command. 

Fair Gaim
To use the new server, line up and distrib-
ute messenger clients. We used Gaim,
which works well with RedHat 9, as long

as you have resources to run the fancy,
heavy GUI. We also installed the Gaim
version available for Windows XP. You can
use any client and tweak accordingly, but
these directions are Gaim-specific.

Once installed, start Gaim and click
Preferences. Since we just wish to run a
local chat server and not access the Inter-
net, make sure that your Network settings
are appropriately set. We didn’t indicate
the proxy server address, since we ran
JabberD on a Linux box using a local LAN
IP address. Also, set other personalised
settings in the Preferences applet here, and
click Close. 

Now, set up the Jabber user account. On
the Gaim main (Login) menu, click on
Accounts, and then click Add to open the
Add Account applet. Choose the Jabber
protocol from the protocol list drop-down
box, and enter a screen name of your
choice. In the server option, add the IP
address of the Linux box hosting the Jabber
server. Ignore ‘Resource’, and skip the pass-
word, for now. Finally, click Register.

A registration window pops up and you
are prompted to enter in a new password
and other details. Next, click on Register.
If all goes well, a pop-up box informing
you of successful registration appears. 

Finally, sign into the account. Manu-
ally add in your buddies to start chatting. 

Jabber’s easy to set up, real fun and
pretty addictive. If you desire connectivity
with the rest of the world as well, choose
to set up accounts with www.jabber.org. It
takes at most 15 minutes to set up the
Jabber daemon and clients. 

IRC DAEMON (IRCd)
The very nature of IRC makes communi-
cation a snap. The channel (chat room)
format lets you communicate with a large
group or a select group at once, or even
with a single user. 

The most popular IRC daemons
(IRCds) are Unreal, Hybrid, Bahamut and
MusIRCd. We’ll show you how to set up
MusIRCd easily, and connect instantly. The
main reason we choose MusIRCd is its
stability, low system load and ease of setup.
There’s even no need to load X—as with
most *nix daemons, it’s totally installed
and run from a command prompt.

You don’t even need root access to
install and run this daemon; it can run
your IRCd on any Linux PC that you have
an account on.

Download the file from http://
musirc.sourceforge.net. A safe bet is to

download the stable build—musircd-

stable.tar.gz. So, use the ‘wget
http://musirc.sourceforge.net/musircd-
stable.tar.gz’ command.

Use ‘tar -zxvf musircd2rc3.tar.gz’ to
uncompress the file. Type ‘ls’ to view

the newly created directory—musircd.
Enter this directory by typing ‘cd musircd’.

Use ‘./configure’ to configure the
default install. We suggest that you

configure the IRCd for small networks, as
this optimises the system so it uses less
memory for the IRCd—unless you’re
expecting thousands of users on your
server. Type ‘./configure --enable-small-net --
prefix=/<Path>’, where ‘<Path>’ is the path
to the folder you want to install the IRCd
in. So, if you want to install the IRCd in,
say, ‘/home/raaabo/ircd/’, type ‘./configure --
enable-small-net --prefix=/home/raaabo/ ircd/’.

Finally! Starting up JabberD

Register the Jabber account
from within you IM client

IRC users have developed their own
language over time. Here’s a list of words
and their meanings, so that you won’t be
lost when chatting with someone on IRC:
Phr34k5: Phreaks; most IRC users like to
call themselves cool anti-establishment
names—whether or not they’re actually
capable of phreaking
Phreaking: Hacking into a telephone
company or network to use their services
freely—mostly to make free long distance
phone calls
1337 (leet): Really cool; from ‘elite’
H4x0r5: Haxors, or hackers
w007: Woot, an exclamation of
pleasure; from ‘root’
rotflmao: (Acronym) Rolling on the
floor laughing my a** off
ne1: Anyone
sp33k: Speak
n00b: Newbie; this is generally an insult
l4m3r: Lamer, a synonym for n00b
5ux0r5: Suxors; something that just,
well, sucks!
40l3r: AOLer, meaning a person using
an AOL dial-up connection; this is an
insult, as IRC users pride themselves on
their broadband connections

Slanging It

Use the ‘tar’ command to uncompress the
downloaded file

If you have problems signing in, first
confirm whether the JabberD server is
running. Next, make sure that the
server’s IP address is mentioned
correctly while setting up the account
in Gaim—or whichever client you
chose. Also, ensure that your PC is on
the LAN and is working fine.
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Use ‘make’ to compile the daemon.
This done, use ‘make install’ to install

the program into the correct directory, and
with the right arguments that you specified
when using ‘./configure’.

You’ll now find that the folder you
wanted the IRCd installed in has

been created. Enter that folder. Type ‘ls’ and
you’ll see six directories: bin, etc, help, logs,
messages and modules. ‘cd’ to the /etc direc-
tory and edit the example.conf file using
your text editor. We used Pico, by typing

‘pico example.conf’. Each and every setting is
explained in this file with a detailed expla-
nation. Read the file carefully, and change
the settings as per your requirements. (See
box ‘Operate your Conf’, for important
administration settings) Finally, save the
file as ‘ircd.conf’ and quit the editor.

‘cd’ to the bin folder, and start the
IRCd using the ‘./ircd ircd.conf’

command. A message saying some-
thing like ‘MusIRCd-2.0rc3 running 
in background from <path> pid:
<number>’ appears.

The next thing to do is connect to
the IRCd. We used the command

line EPIC IRC client to test our server,
which is available at www.epicsol.org. You
can also connect from a Windows
computer using the popular mIRC client
(www.mirc.com). Those running Unix-based
platforms (Linux, FreeBSD, etc.) may try out
the XChat GUI IRC client (www.xchat.org). 

If all goes well, you should connect
and see the Message of the Day

(MOTD). Now, use the ‘/oper <user>
<pass>’ command to see if you set the
Operator settings properly. You can also
use the ‘/raw help’ command for help. If

you can connect to the IRCd, you’ve
probably set everything just right.

Even if you don’t have a static IP, don’t
fret. See the box ‘No IP? No Problem’ on the
first page for details on how you can change
your dynamic DNS into a static URL. Once

you’ve done that, call or
IM all your colleagues
and get them to get on
your IRC server. If it’s set
to run only on the LAN,
tell them to connect to
irc://<your server’s IP>:<port

you specified in ircd.conf> (such as
irc://127.0.0.1:6667). Make sure you inform
everyone to install an IRC client first.

Daemon’s end
We installed and ran both the JabberD
and IRCd on a Pentium III 500 MHz,
with 64 MB SDRAM (though we started
with 128 MB of RAM, someone
‘borrowed’ a 64 MB stick), a 4 GB hard
drive, a keyboard and no mouse. We
never even installed X-Windows, since
the system was grossly underpowered,
but then again, we didn’t need to. We
ran both daemons simultaneously and
faced no problems.

So, all you need to do in order to test
both these interesting ways of communi-
cation is get your hands on some old hard-
ware, load Linux and the two daemons
mentioned here, and inform everyone.
Happy chatting!

SRINIVASAN RAMAKRISHNAN

srinivasan_ramakrishnan@thinkdigit.com

ROBERT SOVEREIGN-SMITH

robert_smith@thinkdigit.com

Perhaps the most important part of the
ircd.conf file is the operator setting. If
you do this right, not only will you be
able to connect to your IRC server, but
also control it from your IRC client itself.

Before you go ahead with editing the
operator block of the conf file, you need
to use the ‘./mkpasswd’ utility to create
an encrypted password. ‘cd’ to the
/ircd/bin folder and type ‘./mkpasswd’ at
the ‘Plain text’ prompt. Key in your
password and press [Enter]. The
encrypted password will be displayed.
For example, if you type ‘./mkpasswd’,
enter ‘digit’ and press [Enter], you’ll see
something like ‘guVwjn80QWx/g’ as the
encrypted password. If you try the same
thing again, the encrypted password
that’s outputted will be different.

Here’s how the first four lines of your
operator block should look:
operator {

name = “<Your Name>”;
user = “*@127.0.0.1”;
password = “ guVwjn80QWx/g”;
You also need to remember that if

you spoofed your host (127.0.0.1) to
something like ‘My.Spoofed.Host’ in the
auth.conf file, the user line should read
‘user=”*@My.Spoofed.Host”;’, for the IRCd
to recognise you.
Note: Editing a line in the ircd.conf file
will let you use plain text passwords
instead, but this is not recommended
under any circumstances.

Operate your Conf
IRC Operators: All server administrators
are also IRC Operators, but the converse
isn’t true. Most server administrators
can’t be online all the time to maintain
their servers. So, they appoint certain
trusted users to care for the server.
These IRC Operators can disconnect and
even ban users from a server. They can
also link and unlink networked servers
from each other.
Spoof: All users on an IRC server are
identified by their user@host, or user@IP
addresses. As IRC operators are hated by
troublemakers, they choose to protect
themselves by faking their IPs. This fake
IP is called a spoof, and is limited only by
imagination—spoofs such as bill@clinton.
gov, or you@talk.too.much are common.

Jargon Buster

Once you’re done editing the conf file, you’re
all set to start the IRCd

Run the
‘./configure’
command with
the desired
switches to
personalise the
installation

Starting the IRCd launches it into the background
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Recover registry in XP
One fine day, as I started up my com-

puter, I got a message that said, “Win-
dows XP could not start because the
following file is missing or corrupt: \WIN-
DOWS\SYSTEM32\CONFIG\SYSTEM”. What
do I do?
Badri Narayan

To start up your machine without re-
installing, you need to execute some
commands at the recovery console. To
get to the recovery console, boot with
the help of a bootable Windows XP CD,
and press [R] when prompted to enter
the recovery console. Select your Win-
dows folder, and enter the adminis-
trator password.

Once at the console prompt, the first
thing to do is back up the existing file;
you do so by executing the following
commands at the prompt:
md tmp
copy c:\windows\system32\config\system
c:\windows\tmp\system.bak

Now you need to replace these files
with the proper, non-corrupt files,
which are in the repair folder in the
Windows directory:
copy c:\windows\repair\system c:\win-
dows\system32\config\system

Now you can boot into Windows XP,
but, as this file was backed up when
Windows was originally installed, any
changes and settings after that are lost.

If System Restore is enabled on your
system, you can get back to the last
restore point. 

To do this, boot into Safe Mode with
administrator privileges, go to the drive
where Windows XP is installed, and look
for the ‘System Volume Information’
folder. Look for a snapshot folder—for
example, C:\System Volume
Information\restore{C0B08955-BE89-4849-
ABC0-715FCDE6CE4A}\RP3. Copy the _REG-
ISTRY_MACHINE_SYSTEM file to the ‘tmp’
folder by typing in ‘copy _REGISTRY_
MACHINE_SYSTEM c:\windows\tmp\_REG-
ISTRY_MACHINE_SYSTEM’.

Go to the recovery console again,
using the Windows XP boot disk, 
and copy this file over the existing one
by typing ‘copy c:\windows\tmp\_reg-
istry_machine_system c:\windows\system32\
config\system’.

Restart Windows normally, start
System Restore and restore your
machine to any point you wish.

Project home studio
I want to set up my own home

studio. Can you tell me the best PC con-
figuration to do so?
Rajieve Tanck

For a home studio PC, we suggest you
buy a Pentium 3.2c, an Intel 875PBZ
motherboard, 512 MB or more of 400
MHz DDR RAM, a 7,200-rpm   Samsung

hard drive—80 GB or more, a 9600 Pro
graphics card, an Audigy2 sound card, a
19-inch monitor, a floppy disk drive, a
keyboard, an optical mouse, etc. If you
want a better graphics card, opt for a
9800 Pro XT, 5900 or 5950—which will
cost about Rs 35,000.

8X on 4X
I have an Intel D845GBV motherboard

with Intel Extreme Graphics and a 4X AGP
slot with the 1.5 V specification. Will an
8X AGP card fit and work properly in my
4X AGP slot? I want to buy the latest
GeForce FX series card. Can you suggest
which one?

My 40 GB hard disk is split into four
partitions, with C allocated 11 GB, while
D, E and F have 9 GB each. Earlier, I had
Windows Me on the C drive and Windows
XP on D. The D drive is in NTFS format,
and I have now loaded Windows 98 on
C. How do I access my D drive when
working in windows 98? I have the Win-
dows XP Pro CD.
Jimmy Varghese

Yes, you can use an AGP 8X card
in an AGP 4X slot. AGP 8X supports
1.5 volts, but you won’t be able to
experience the full power of the card.
The GeForce FX from Compro is a
good choice in the GeForce series,
and has won the Digit Best Value
award in 2003.

A screen screaming blue, a partition giving you the blues. Resolve them, and with
your work, get glued!
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You can’t access your D drive from
Windows 98. There are a few third-
party utilities that will allow you to do
this, but these are not recommended.
You will either have to boot into
Windows XP to view your data on the
D drive, or convert your D drive to
the FAT32 format. 

Internal and external
conflict

I download e-mail from my server
using a pop puller, and forward it
to the respective mailbox on my local
exchange server.

Some users access their mailbox
directly from the external mail server. Say
my external mail server has the domain
name abc.com, and the internal domain
name is xyz.com. If I create a new
internal domain abc.com, and host my
exchange server on it, would I be able to
forward e-mail of non-existing e-mail
accounts from the internal server to the
external server?
Sanket Shah

You can’t have the same name
assigned to an internal as well as
external mail server. There is an MX
record associated with each domain
name, which points to an IP address.

You can’t have abc.com pointing to two
different IP addresses. If your external
server is abc.com, you need to have a
sub-domain such as internal.abc.com
for your internal server. 

Kabhi on kabhi off
I have an AMD K6 processor, 64 MB

of SD RAM, a SiS 530 motherboard and a
10.2 GB Seagate hard disk. Recently, my
PC started giving me error messages
saying, “Fatal exception error in vxd...
press any key to continue.” When I press
a key, the system comes back to normal,
but only for a few seconds, and then I get
the same message again. 

I think it might be due to a virus, but
I can’t do anything, as my system only
works for two to five minutes at a time. 

I formatted, and tried re-installing
Windows 98 SE, but the problem per-
sisted. Finally, I installed Me, to no effect.
I need to leave the system off for over five
minutes to be able to use it.
V Shankar Iyer

Since the problem exists even after
re-installing the OS, it looks like you
have a hardware issue. You say that
leaving the system off for a while seems
to temporarily solve the problem. This
indicates a cooling problem. Check

your cabinet’s fans. Make sure all of
them are running. 

The next suspect is RAM. Try and get
a friend’s RAM chip (make sure it’s com-
patible with your system), and check
stability using that. It could just as well
be a bad hard drive or motherboard
chip, so check these in turn.

Startup woes
Often, when I boot up my computer,

it hangs. If I press [Ctrl] + [Alt] + [Del], I
find a few additional entries that are not
present when the computer is running.
These are: scanregw, rnaap, smc and
dbhelp. I can’t see them in msconfig
either. I want to disable these programs
permanently. How do I do it?
Shirish

rnaap is notorious for causing your
type of problem. Uninstall and re-
install Dial-up Networking, and if the
problem persists, get your modem
checked. 

If the modem hangs when rnaap is
initialising it, your system is likely to
hang as well.

What’s my voltage?
How do I check the voltages of an ATX

power supply. My power supply outputs
about 4.5 volts at PS_ON, 5.2 at SB and
0.8 at PG. Please help me check the cor-
rect voltages of a power supply before
connecting it to my motherboard.
Nasiruddin

The SB (purple wire) voltage should be
5 V. In the PS_ON state, red and white
should read +5 V and -5 V respectively.
Yellow and blue should have +12 V and -
12 V respectively. Finally, orange should
read +3.3 V, and black is the common wire.

XP tyranny
I have a Pentium 4 2.8 GHz PC running

Windows 2000 and Fedora core Linux.
Recently, I installed Windows XP Profes-
sional. Ever since then, I can’t boot into
Linux. When I start my PC, it gives me an
option between Windows 2000 or Win-
dows XP, but no Linux or DOS option. How
do I get it back?
Amit.

Boot your PC with the Linux CD.
Type ‘linux rescue’ at the boot prompt,
and press [Enter]. Once you reach the
command prompt, type ‘chroot
/mnt/sysimage’, and press [Enter]. Here

Password hacking
Recently, one of my friends changed

my Yahoo! password. When I tried to
make my profile, I saw his ID in the alter-
nate ID location. Now, each time I
change my password, a message is sent
to his account as well. Is he spying 
on me? How did he change the pass-
word? Tell me how to remove his ID from
my profile. 
Rahul Sarma

Quite often, we inadvertently give
out our passwords. You may have men-
tioned it in a chat to someone, and the
chat was logged. Even more
common is using a pass-
word that is easy to guess
in less than 10 attempts.
If you keep your moth-
er’s name as your pass-
word, you can be sure
that almost all your
friends can guess it!

Once a hacker
logs into your

account, he or she can do everything
that you can—check your mails, change
your preferences, etc.

To remove the alternate ID, go to
Mail Options > Account Information, and
click Edit. This is located beside the
Member Information option. Change
the alternate e-mail ID to one of your
own and press Finished to save the set-
tings. Now he won’t get any of your
mails, and you’re free to change your
password to something he’ll never
guess.

Mahesh Benkar
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type ‘lilo’ if your boot loader is lilo, or
‘grub-install’ if the boot loader used is
grub, and press [Enter]. 

Dial-up hackers
I’m worried about my dial-up Internet

connection. What happens if someone
knows my username, and tries to guess
my password over and over again? Will
this lock my password? If so, how do I
prevent this?
Binod

When someone tries to hack your
password using the brute force tech-
nique—trying each possible combina-
tion—the account is suspended for a
preset time period. After 10 or 15 min-
utes, you should be able to use your
account again. 

Some ISPs, such as VSNL, offer a fea-
ture where you can lock your account
usage from a specific phone number.
This is good, because unless the hacker is
sitting in your house, or hacking your
phone line, he or she cannot access your
account.

Blue screen advertisements
I have a dual-boot PC running Win-

dows Me and Windows XP. Recently, I
started getting an error message during
bootup. I took a screenshot of the error.
What is the problem?
Agk Nair

The application specified in the error
message—CD_LOAD.EXE—has been
installed by Cydoor’s adware applica-
tion. It downloads advertisements to
your computer as soon as you go online.
Search for the application, and delete it.
Also, load an anti-spyware application to
keep your computer from facing this
problem again.

I can’t write
My Sony CD-RW CRX175A1

24x/10x/40x shows the ‘Power calibra-
tion‘ error when writing, and stops. What
is the problem? Do I have to change the
CD-RW?
Ravi S

Power Calibration is controlled by
the recorder. Before any write operation,
all recorders must do a 15-step power test
to determine the optimum power for
writing to the CD—this is called
Optimum Power Calibration (OPC).
During a write, it continues to do this

test to get the best write throughout the
whole CD—this is called Running
Optimum Power Calibration (ROPC).
This whole process is controlled by the
recorder, but is initiated by programs
such as Nero. There is an area on the
inner part of the CD for the test and test
data information to be stored. You can
use this area up to 999 times.

So, when you receive the ‘Power Cal-
ibration Error’ or ‘Power Calibration Area
full’ error message, it’s because of poor
media, poor power, or a defective
recorder. Most often, it’s due to bad
media, so try using better CD-Rs.

Break the partition
I have a 20 GB Seagate hard drive,

which has two partitions of 10 GB each.
Since I wanted one single partition 
of 20 GB, I went through fdisk and 
deleted the primary and the extended
partition. However, the partitions still
exist. I also tried deleting them with the
help of the disk manager provided by
Seagate, but they are stubborn. What
should I do?
Y S Samyal

Yes, parting with partitions can be
very frustrating. To delete the partition,
first go to the BIOS, select the hard disk

Choosy CD-ROM
I have a Compaq Presario computer

with Windows XP Home Edition and a
48x CD-ROM drive. The problem is that
the CD-ROM drive only reads the CDs
that came with the computer—the OS
CD, drivers CD, etc. It completely
ignores other CDs, even when there’s a
CD in the drive, it asks to insert one. 

I have tried about eight CDs, all
unscratched. I also installed Nero Burning
ROM 5 and Image
Drive. The help
and support
says that there
is a SCSI
p r o b l e m ,
while proper-
ties in device
m a n a g e r
reports the
device to be working perfectly. 

I’ve tried reinstalling XP
without format-
ting. Please help.
Siddharth

Most packaged CDs are pressed, not
burnt. These pressed CDs are made so
that they work on all CD drives.
Certain CD-Rs may not be compatible
with your drive. Check your drive by
attempting to use CD-Rs from other
manufacturers. If this fails, send your
drive to a service center, as the prob-
lem is a faulty lens. 

Nero is CD-writing software, and
you have a CD-ROM drive not a CD-

Writer, so its normal to get
errors when using Nero.

Use anti-spyware to protect your PC from nasty errors such as this one by Cydoor adware 



and change its mode from LBA to
normal. Now, let the PC boot up, run
fdisk and delete the partitions. This done,
go back to the BIOS, and change the
mode back to LBA.

The notorious SM56 modem 
I have run Linux for over two years,

from Red Hat 7.3 to Fedora Core 1.
I can’t install drivers for my modem—
D-Link with a Motorola SM-56 chipset.
I use kppp to dial my connection. What is
the solution?
Naimish J. Makwana

Motorola provides universal modem
drivers for all versions of Windows and
Linux. They are available at www.motorola.
com/softmodem/sm56_download.htm

Increase the power
I have a Pentium II 333 MHz, a 440 ZX

motherboard, 64 MB of RAM and a
6.4 GB hard drive. I want to upgrade
the processor and memory. Can I do
that on the same motherboard? In all,
there are two memory slots, so how
much memory can I add? Also, if I
change my hard disk, what drive capacity
will be supported?
Arvind

You are in a difficult position, to say
the least. 

First, the maximum processor upgrade
that the 440 ZX motherboard will sup-
port is limited to one with a speed of 450
MHz. That is hardly an upgrade. 

Secondly, the RAM you need should

be of the 66 or 100 MHz variety, which is
very difficult to procure. These memory
sticks are available in capacities of 64,
128, 256, and 512 MB.

As for your last query, the mother-
board can support a 40 GB hard drive.
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sos@jasubhai.com
E-mail us your
computing
problems, and
we may answer
them here!

Since we get more mails per day
than we can handle, it may take
some time for your query to 
be answered. Rest assured, we 
are listening!

Crawling computer
I recently installed Windows 2000 Pro-

fessional and Office XP on one partition,
and Windows XP and Office XP on
another. I have a Pentium 4 processor,
850 motherboard and 128 MB RD RAM.
When I open Windows 2000, the response
becomes slow, and after clicking the
toolbar and opening Task Manager, I
found Rscmpt.exe consuming 99 per cent,
or more CPU time. Please tell me how to
get rid of Rscmpt.exe.
GK Chakraborty

This is a known problem for nVidia
display cards, but all you have to do to
remedy it, is install the latest nVidia
drivers. You can download them from
www.nvidia.com.

Broadband on landline
Recently, I have seen many advertise-

ments about broadband on landlines
(ADSL) from MTNL. What is the major
advantage of this over others, and what is
the minimum hardware requirement. Is it
true that we can achieve speeds as fast as
256 Kbps on our landlines?
Siddharth Menon

Yes; you can achieve 256 Kbps, or
even more on your phone line. The
biggest advantage of ADSL is that you
can even receive telephone calls while
surfing the Internet, as the data is
transferred on a different frequency,

which is inaudible. As far as the hard-
ware is concerned, all you need is an
ADSL modem, which your ISP will
rent to you.

Monitoring the Internet
I work as a network assistant in a com-

pany, and we have provided everyone with
Internet access. The problem is that some
of the staff misuses this facility. They down-
load at will, and also visit indecent sites.
How can I keep a check on them?
Zahir Ahmed

Since you haven’t specified the soft-
ware you’re using to share the Internet
connection, we’ll have to solve your
problem by assumption. If your Internet
server is Windows-based, you should
use proxy software such as WinProxy or
Sygate. If your server is Linux-based, you
can try qmail, which can give you mon-
itoring capabilities after a few patches.

Create boot CD?
How do I create a Red Hat Linux-9

bootable CD?
Sumeet Saha

There’s a command in Red Hat called
mkbootdisk that does this. Use it to cre-
ate an ISO image of the bootable disk,
and use cdrecord, Nero, etc, to create the
bootable CD.

To create the ISO image, you’ll need to
know the kernel version—issue the ‘ker-

nelversion’ command in a terminal
window. Now verify that the folder with
the version exists in /lib/modules. If you
find that the folder name in /lib/modules
is bigger than that specified by the ‘ker-
nelversion’ command, use the ‘fullname’
switch instead.

To create the ISO image, issue the
‘mkbootdisk --device boot.iso --verbose  --iso
<full kernel version>’ command. Once the
ISO image is ready, burn it with the help
of CD-recording software, and voila, you
have a bootable CD!

Bad sectors
When I try to install Windows XP, I 

get an error that says, “Setup has deter-
mined that drive C: is corrupted and
cannot be repaired”. The hard disk does
contain some bad sectors. I have a Pen-
tium 4 1.6 GHz, VIA VT8751 (P4M266)
and Windows 98 SE. I have a Samsung
hard disk with four partitions—C(37.2
GB), D(9.19 GB), E(9.19GB), and F(9.45
GB). What do I do?
Jarnail Singh

You need to ensure that the hard disk
has bad sectors. Download and run the
disk utility for this purpose by Samsung
from www.samsung.com/Products/HardDisk
Drive/utilities/hutil.htm. Execute the pro-
gram, and let the utility test the hard
drive. The program will tell you if the
drive is usable or not. If not, then you
have to get a new one.

FAQs
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You don’t need the
latest hardware and
the best
configuration for
boasting rights. Fine-
tune your existing
system with these
tweaks to race
ahead
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Quickly press [Delete] as
your computer starts up to
enter your PC’s BIOS. This
is where you set your
system for better perform-
ance—no matter what OS
you’re running.

Flashers
Before anything else, if your
BIOS version is over a year or
two old, chances are your
motherboard manufacturer
has released an updated ver-
sion that will significantly
increase performance and
stability. If the flashing
process is interrupted, your
motherboard will be rendered
useless: flashing is therefore
not for the faint hearted. Get
your system assembler to
update your BIOS. 

Beyond clock
speeds
The first step to overclocking
your CPU is to increase the
Front Side Bus (FSB). Before
you start, ensure you have a
well-ventilated cabinet, with
at least three fans—one for
ventilation, one for the
Switched Mode Power
Supply (SMPS) and one for
the CPU. Increase the FSB in
the smallest of instalments—
from, say, 133 MHz to 135
MHz. Now change your CPU
ratio marginally, and keep
testing sytem stability and
performance. Of course, this
only applies to Athlon CPUs. 

Intel locks theirs to pre-
vent overclocking accidents.
Don’t give in to the
temptation of trying to

change voltage settings—this
will significantly increase the
amount of heat produced.

Basic BIOS tweaks
Here are some generic BIOS
tips to increase performance.
The gains are limited, but
the tweaks aren’t as risky as
overclocking. 

Firstly, set the First Boot
Device to your C: drive and
disable the Second, Third
and Other boot devices. On
the rare occasions when you
need to boot from a floppy
or CD, a deft move on
[Delete], and changing the
First Boot Device option to
Floppy or CD will remedy
the situation.

Change the ‘CAS Latency
Time’ from 3 to 2—this
reduces the amount of time
your RAM waits before it
starts a ‘read’ command.

Change the ‘RAS-to-CAS
Delay’ and the ‘RAS Pre-
charge Time’ to 2—this
reduces the delay between
signals and lets the memory
refresh faster.

Make sure that the
bootup virus checking
option is disabled to increase
boot times significantly.

Disable ‘Boot up Floppy
seek’ so that the BIOS won’t
waste time looking for a
floppy drive. Disable the
Video BIOS Shadow.

If you have a graphics
card with over 16 MB of
memory, disable ‘Video RAM
Cacheable’.

Set the initial display card
as either PCI or AGP, and not
‘Auto’, depending on the
configuration of your
graphics card.

Dirty hardware
Cleanliness is next to godli-
ness, even in technology.
Keep your cabinet clean and
in a well-ventilated area.
This is especially important
for surfaces such as those of
the CPU, GPU and power
supply that heat up. As long
as these are clean, the heat
won’t build up. 

Use soft paint brushes to
clean fans to prevent them
from slowing down or
locking up, which can cause
hardware damage.

Cable chaos
Arrange and tie your cables
with rubber bands or cotton
threads to prevent entangle-
ment and improve ventila-
tion. Also, try and space
hard drives as far away from
each other as possible. Con-
sider adding a fan for your
hard drives if your cabinet is 
too small. 

Separate IDEs
please
A common assumption is
that if the hard disk and CD-
ROM drive are on the same
cable, data transfer will be
faster. This isn’t true, since
data transfer rates depend
on Integrated Device Elec-
tronics (IDE) controllers,
which run at the speed of
the slower device. Since the
optical drive is slower than
the hard disk, connecting
them to the same IDE port
slows down performance.

Also, transfer speeds
between drives on two dif-
ferent IDE channels is faster
than that between devices
on the same IDE channel.

HARDWARE
Hardware is the first stop on the Tweak

Express. A few right and quick fixes, and your
system will surprise you
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File system first
When installing Windows
XP, make a clean install, as
opposed to updating from an
older version. This is because
formatting your hard drive to
use the NTFS file system is
better, since FAT32 is slower
and less stable. To change
your drive’s FAT32 file system
to NTFS, go to Start > Run and
type ‘command’. At the com-
mand prompt, type ‘convert X:
/FS:NTFS’ and press [Enter]—
here ‘X:’ is the drive you want
to convert. 

Start with the boot
What you should look to
improve upon is bootup
time. You can save as much as
30 seconds by optimising
your boot options. If only
one person uses your com-
puter, leave the password
blank. Also disable Fast User
Switching by going to Start >
Run, and typing ‘control user-
passwords’ and pressing [Enter].

In the User Accounts
window, click on ‘Change the
way users log on or off’; make
sure the ‘Use the Welcome
screen’ option is ticked, and
uncheck ‘Use Fast User
Switching’. Click on Apply
Options and close
the window.

Prettier equals
slower
The first thing you notice in
XP is the look. Unfortu-
nately, the crisp menus, the
new fade-in and fade-out
effects and the breathtaking
wallpapers drain your
system’s memory. For any PC
with less than 256 MB of
RAM and a CPU slower than
1 GHz, turn off all the frills. 

The easiest way to do this
is to press [Windows] +
[Pause/Break] to launch the
System Properties dialog box.
Here, click on Advanced.
You’ll see three ‘Settings’ but-
tons. Click the one related to

‘Performance’. The dialog
box called Performance
Options pops up. Under
Visual Effects, select ‘Adjust
for best performance’ and
click Apply. 

Again, in the Perfor-
mance Options dialog box,
click on Advanced. Under
P r o c e s s o r
scheduling
and Memory
usage, make
sure the Pro-
grams option
is selected in
each case. 

Do
away with
passwords
To disable
logon pass-
w o r d s
entirely, go to
Start > Run,
type ‘control
u s e r p a s s -
words2’ and

press [Enter]. In the User
Accounts dialog box that
pops up, uncheck ‘Users
must enter a username and
password to use this com-
puter’. Since you are doing
away with passwords alto-
gether, disable the HelpAs-
sistant account. In the User

…because your RAM doesn’t oblige XP’s bells
and whistles 

WINDOWS XP 

If you have only one user on your computer, it
makes sense to disable password requirements

From within the
System
Properties dialog
box, you can set
Windows XP to
give preference
to performance.
You can allocate
its resources to
give preference
to the programs
you run
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check ‘Display file size infor-
mation in folder tips’ and
‘Display simple folder view
in Explorer’s Folder list’.
Under Offline Files, uncheck
‘Enable Offline Files’.

Defragmentation
One cause of system slow-
down is fragmented data.
When writing to your drive,
whatever space is available is
filled, so even small files 

can be distributed all over
the place. 

Windows may also split
large files into many parts
and spread them over the
hard disk. This is fragmenta-
tion. To counter this, you
need to defrag your hard
disks once a month. 

Go to Windows Explorer,
right-click on a drive, select
‘Properties’ and in Tools,
click ‘Defragment Now…’.
When Disk Defragmenter
opens up, click Defragment.
After the process is done,
check your hard disks for
errors. In the disk properties
box, click ‘Check Now…’
under ‘Error-checking’.

No compression
and indexing
Drive compression and
indexing is a feature of Win-
dows XP that helps you save
space and search your hard
disk better—provided the
drive is formatted in NTFS. 

To begin with, if you have
slower 5,400-rpm drives, or
an older, slower computer, it’s
better that you leave these
features turned off. The eas-
iest way to check if this is
enabled, is to double-click My
Computer, right-click on an
NTFS drive and select Proper-
ties. At the bottom of the
dialog box that pops up,
you’ll see two check boxes
called ‘Compress drive to save
disk space’ and ‘Allow
Indexing Service to index this
disk for fast file searching’. 

If you don’t search your
hard disk for files frequently,
you can safely uncheck the
‘Allow Indexing Service to
index this disk for fast file

s e a r c h i n g ’
option. Turning
off disk com-
pression, how-
ever, is a little
more compli-
cated. Not all
users have 40
GB and 80 GB
drives, and
some would
rather save
every MB of
disk space
that they can,
gladly waiting
a few seconds longer for pro-
grams to load. 

Another thing to
remember is that if disk com-
pression is already enabled,
and your drive is almost full,
turning it off can have
unpleasant consequences—
prepare to lose a little data.
We suggest you turn off disk
compression only if you
have large hard disks, with
space to spare. 

If you change any settings,
click OK and then make sure
to check the ‘Apply changes
to <Drive>:\, subfolders and
files’. You can do the same for
all your NTFS drives. 

Boost that drive
Go to System Properties
([Windows] + [Pause Break]) ,
and then to Hardware > Device
manager. Look for ‘Disk
Drives’ and double-click on
it. In ‘Properties’, check
‘Optimise for performance’
and ‘Enable Write Caching
on the disk’. Now, go to IDE
ATA/ATAPI Controllers, and
double-click ‘Primary IDE
Channel’. Under Advanced
Settings, make sure ‘DMA if

available’ is enabled. 
Do the same for the Sec-

ondary IDE Channel. You’ll
need to restart for the
changes to take effect.

Unwanted fonts
and applications
Not only do extra fonts slow
down your system, they also
increase bootup times. Use
a font management tool
such as Typograph (http://
www.neuber.com/typograph/).
Refer to  the Quickstart
article—‘Fonts Sans Confu-
sion’—in  the January 2004
edition of Digit for tips  to
use Typograph.

The same applies to
unwanted programs. Unin-
stall all that you don’t
need—too many applica-
tions slow the system down,
even if you have space to
spare. All installed programs
have associated keys and
values in the registry, and ref-
erences to them are all over
your hard disk. Try asking a
hard disk that’s sorting
through 2,000 fonts and
applications to hurry up!

DMA access will let your drives communicate
faster with other components

Defragment disk drives once a
month, for faster data access

Setting the right folder options
will let you work faster in Explorer
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To make your PC play
faster, access the
graphics card settings

by right-clicking on the
desktop and going to Properties
> Settings > Advanced. You can
tweak all options from here.

OpenGL settings
For faster fps, and a more
enjoyable experience, turn off
eye-candy. 

Make sure all the options
in your graphics card settings
are tuned for high perform-
ance. Set the minimum levels
for—or turn off—resource
hungry settings such as
Anisotropic Filtering, Anti-
Aliasing, Mipmap Detail and
Vertical Sync.

Direct3D settings 
In your card’s Direct3D
settings, set all eye-candy to 
a minimum, or just turn 
the settings off. Here again,
turn off Anti-Aliasing,
Anisotropic Filtering, Mip-
map Details and Vertical
Sync. You may need to enable
Fog table emulation for

nVidia cards to avoid seeing a
blank screen.

A clean win
Keep your graphics card clean
and airy. All that gaming can
really test the hardware, and
if you’re not careful, be pre-
pared to see a BSOD, or worse
still, corrupted files after a
rather ‘hot’ reboot. 

The area around the
graphics card should be open
and cables shouldn’t obstruct
the fan. If possible, install an
additional fan on top of your
cabinet. With typical mother-
board placements, this new
fan will blow air straight onto
the AGP graphics card.

Get by with a little
help
You can get power-user-type
control over your graphics
card drivers with third-party
tools. These will further
tweak your card settings for
best performance with
decent visual effects. 

Radeon users can try out
PowerStrip (http://www.entech-

taiwan.net/util/ps.shtm), and
nVidia card owners, nVHard-
Page (www.nvhardpage.com).
For those still hanging on to
TNT and TNT2 cards, we 
suggest you use older, stable
drivers, instead of the 
latest Detonator drivers
(www.nvidia.com). 

The Detonator drivers are
optimised for the latest breed
of graphic chipsets, and may
tax your older cards. Of
course, if you can’t find the
older drivers, stick to the new.

Overclocking
You can overclock your GPU
to get better graphics, but
there is a limit. Don’t expect
to get 9800 Pro performance
out of your TNT2. There’s a
very fine line between a faster
GPU, and a minor explosion,
so be wary. And do bear in
mind that overclocking is
considered tampering, which
voids your warranty. If you
have no clue what you’re
doing, skip these tips.

Using third-party utili-
ties mentioned earlier—

PowerStrip for Radeons and
nVHardPage for nVidia’s
cards—you can tweak your
GPU. Go to the clock fre-
quency controller in your
respective utility, and
increase the clock speed
and memory speed at not
more than 5 MHz at a time.
Keep testing for stability
and excessive heat emitted
by the card. 

The performance increase
begins to go down as you
overclock more and more.
Use your judgement to get the
optimal setting where the
overclocking is moderate and
the performance gain is satis-
factory. As always, add a few
fans to your cabinet before
you do this.

LAN parties
Before connecting to a game
server, close all programs that
use the Internet to maximise
your connection speed and
minimise your ping times.
Don’t spare even IM applica-
tions. Also, exit as many pro-
grams and services as you can.

Don’t forget
the game
Apart from setting
the graphics card
options, you also
need to adjust each
game’s settings for
high performance.
This is usually found
in the game menu
under Options > Set-
tings > Graphics , or
something similar.
Set colour depths,
‘details’, and all
other such settings
to Low.

GAMING 
Now for some help with your fps... 

Using tools such as nVHardPage can
give you that performance boost you
require so badly
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Some of the smartest users we meet on the forum are long term Digit subscribers. Wait, is
there a pattern here?

Posted: Mon Jan 26, 2004 9:30 pm    Post subject: 

Posted: Mon Feb 23, 2004 10:01 am    Post subject: Re: My XP freeze

gauravsuneja wrote:

LOL! How can you expect XP to run properly with 128 MB of RAM? Time to upgrade to 384 or 512 MB. Deep

Posted: Mon Feb 23, 2004 3:36 pm    Post subject: 

BTW Deep, my comp ran beautifully on 128 MB. All I did was:
1) Changed the visual options
2) Disabled the worthless services
3) Made my page file 512 MB, spanning two hard drives
4) Used a RAM optimiser
5) Used Hare

My XP freezes so that I can’t press even [Ctrl] + [Alt] + [Del]. I have to cold reboot when this happens,
especially while using Photoshop.My configuration is XP Pro, 128 MB RAM, nVidia 64 MB graphics Cre-
ative sound, 40 GB hard drive. Any answers?

Deep
Digitized

Joined: 23 Jan 2004
Posts: 324
Location: Mumbai,
India

ice
Digitized!

Joined: 28 Dec 2003
Posts: 1635
Location: Mumbai

Tweaking UR OS:
1) Get XP antispy (freeware). Block all the worthless services. (It has a description for the services too)

2) Get System Mechanic... Run a registry check and a junk file remover check every week or so. Also, tweak the OS accord-
ing to your needs., eg, in the Optimization sub-menu, choose startup manager and remove stuff like kernel check and MS
Office. Btw, don’t delete the entries, just disable them, so that u can re-enable them later…In the Tweak Windows Set-
tings, you can change the options according to your needs. I’ve enabled Prefetching to monitor bootfile and application
launch

3) I use Tweak XP. It has a lot of cool options like cache optimization, hardware optimization—they are all depend-
ent on your RAM, hardware, etc. All you need to do is spend a good 30 minutes with the software.

4) Cable nut (for Net speed) Yes the name says cable, but it also works with dial-ups, ADSL, etc Install it (freeware )
choose Start > Programs > Cable nut > Css > your connection speed > your OS. For XP, choose Windows 2000 as the OS.

5) Install Naviscope. It will tell you about your network usage—what goes on between your PC and the Net, block
adds, etc. Thus it speeds up the Net and has options of optimizing MTU/RWIN Settings in Windows 9x. 

6) Install Hare, and change your kernel to 88-bit. If it isn’t stable, go back to 64-bit. BTW, never use Hare’s RAM opti-
mizer. It sucks! You can use Hare to change your GFX card options, Prefetching, etc.

7) If you want to decrease your boot up time, install Zoom. Enable boot file caching, and if you don’t change your
startup files regularly, enable Startup Snapshot, or whatever it’s called. It works! Also try BootVis, though I don’t guar-
antee it—it helped me, but didn’t help Dexter.

8) This is a big post. Do I get paid for this?

9) Yeah! Defragment! The most important thing is to defragment your drives regularly. Windows defragmenter is
slow, so try [Windows] + [R], type ‘cmd’ and press [Enter]. Now, type ‘diskeeper’ and press [Enter], choose the option
that best suits your needs and defragment. My comp defrags itself using this bat file every night at 3:
diskeeper c: -f 
diskeeper d: -f 
diskeeper e: -f 
diskeeper e: -f
My C: is FAT32, so it takes ’bout 20-30 minutes. The rest are NTFS, and take less than a minute each.

ice
Digitized!

Joined: 28 Dec 2003
Posts: 1635
Location: Mumbai
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XIII derives its name and base from a
famous French comic. You’re a
secret agent at the centre of a thick

Web of deception. You’ve lost your pre-
cious memory, which also happens to be
the catalyst of the plot. Steve Rowland, alias
XIII, is the code name of the agent who has
supposedly killed the President of the ‘Free
World’, and who himself is presumed dead. 

Almost everyone you meet, apart from
the core team you’re introduced to, is sur-
prised at your survival... XIII starts off with
you waking up on a desolate beach, with
Roman numerals tattooed on your collar-
bone. Soon, you realise that a mysterious
group, The Twenty, is after your blood.
Like fish that don’t smell too good, the
plot twists and twirls, sucking the very
marrow out of your bones.

With every little sensory message such
as the sound of an old General’s voice, etc,
you get flashbacks of your rather unfortu-
nate life. You remember eavesdropping on
conversations in grim, grey scenarios. This
convenient recollection is the sharp-edged
hook of the game. XIII is action-packed
from beginning to end, and has dramati-
cally executed cutscenes that glue mis-
sions together cohesively.

Loads of missions with enough play-

time keep your itchy trigger-fin-
ger ticking. The Unreal II engine
powers the cel-shaded delightful
graphics, making XIII the first-
ever FPS to have them. The AI
though is predictable and the
environment lacks enough inter-
activity. It’s only in the begin-
ning of the game, when your
hands are empty, that you feel
the need to pick up objects such
as a chair, a bottle or an ashtray
and knock some heads to gain
guns and other deadly items. 

XIII features visual sound, a special fea-
ture in comics. For example, a guard on
the other side of the wall is traversing an
area you need to pass. You can attach
yourself to the adjacent wall and watch as
a “Tap, Tap” text descends and ascends in
size and distance according to his location. 

Body animations are well drawn too,
from the sensual pose of a medical nurse
watching you flee for your life, to a mani-
acal doctor rampaging in rage towards you.

Whereas in other similarly themed
games, you’d have one final mission with
enough nightmare bots being thrown in
to cause a massive system meltdown and
enough stealth required to liquify bones,

XIII borrows from the ‘main boss’
concept. So, while in some cases you
have a mad doctor waving a screen-
bending drug in his hand, others are
heavily armed hardcore militarists
that require brawn and skill to
defeat. They have one thing in com-
mon though—all are monstrous
enough for you to replay and retry
till you succeed. 

The lead character’s voice, ren-
dered by David Duchovny, is rather
subdued, and goes down well, giv-
ing it more dimension and depth.

Rapper Eve plays Major Jones, and Adam
West gives life to General Carrington.
Sound effects develop tension at a steady
pace. The weapons themselves are staple
spy diet—you’ll get crossbows for stealth
missions, snipers, and an awful load of
shotguns, AKs and M4s. 

Load times, too, are a pain. The main
installation itself occupies a generous
chunk of space. And you need to juggle
four CDs as and when the game demands
them. The usual generic save system is
replaced by a cumbersome checkpoints
system that serve as starting points when
you restart your game or fail in a mission. 

The storyline draws inspiration from a
variety of real-life circumstances. The pres-
idential assassination scenario is all too
Kennedy-ish. There are similarities in style
and concept to other spy-thriller games
such as Splinter Cell. XIII tries to strike a
balance between being too brain-racking
and overtly simple. 

Like any half-baked product, XIII does
have its juicy parts. Unfortunately, this is
in no way a game that keeps you on the
floor, on your knees, fists clenched, a tear
rolling down your left cheek while doom
metal plays thoughts of complete submis-
sion... no, it’s not this one.

XIII
Say Your Numbers

Genre: Action n Developer: Ubisoft n  Publisher: Ubisoft n  Distributor: NA 
Phone: NA n E-mail: NA n  System Requirements: 600 MHz CPU, 128 MB RAM,16 MB 3D card n  Price: NA 
Web site: www.whoisxiii.com
Rating: HHH   I

How brown is my valley...

I

Walk straight and take the left to see Hell. You 
can’t miss it



arcade

MAY 2004157

AIRLINES2
Clipped Wings

The interface of Airlines2 is very
simple, with three main
screens sub-divided into sever-

al tabbed windows. The airports are
grouped under fifteen zones classi-
fied by geographical location. Play-
ers start out by selecting one region,
and then establishing routes and
connecting airports together. There
are several conditions such as pas-
senger demand, type of service
required, etc., that need to be met to
set up a profitable route. All this
information can be obtained by
researching airports, but this research only
remains accurate for a set amount of time,
thereby adding a good degree of realism to
the gameplay. Another nice feature is the
inclusion of real-world aircraft in the
game, despite their corrupted names, such
as the Concoard and the Boodwing 747.

As the game rolls on from its start date of
1960, planes are refreshed accordingly.

As the game progresses, the increasing
strain of micro-managing fifty-odd routes
really gets tiresome. Another disconcert-
ing fact is the number of crashes your
planes sustain mid-game, and the high

cost of replacing them. The game
does list the total flying time of the
aircraft, but it would have been more
useful to include a projected estimate
of its useful life. The game’s Finance
screen too appears a little simplistic—
if you need a loan, your bank will
allow you to set the interest rates.
Also, the competition’s progress is
reported only once every year. So in
the end, you find yourself just sitting
and waiting for any event to hap-
pen… and waiting, and waiting...

The in-game music though is a
different matter, with its horrendous tech-
no sounds in tow. Beyond the simple ani-
mations of airports and planes that play in
the right-hand corner, the game only looks
like a jazzed-up version of an Excel sheet.
Business-sim enthusiasts would be better
off buying Airport Tycoon 3.

Genre: Strategy n Developer: InterActive Vision n Publisher: Take2 Interactive n Distributor: Sujata Softech n Phone: (022) 22885096 / 46574
System requirements: 500 MHz CPU, 64 MB RAM, 32 MB 3D accelerator card, 350 MB hard disk space, DirectX 8.0a
Price: Rs 299 n  Web site: http://pc.iavgames.com/airlines2/
Rating: HHHHI

The World as seen from the eyes of an airplane

Vietnam Med Evac
Land, Puhleez!

Based on the Vietnam War,
Vietnam Med Evac gives you
command and control of the

UH1 Huey helicopter to go out into
the wild, rescue dying souls and
relieve their pain. Use the joystick
for better control over the Huey.
For hardcore FPS players, control-
ling the Huey will take some time.
Taking off is child’s play, but keep-
ing the Huey stable in the air and
landing it is what makes this game
real fun (or frustrating!). Landing is
the game’s most critical aspect. 

The game’s a tough nut to crack,
the reason being the patience and
willpower required to control the flight
paths and situations with controls pro-
vided. This is what makes up for the
average graphics and stupid AI (civilians
keep approaching you even when bul-

lets are fired at them). 
The sound effects bring to life the real

action around you. The instant feedback
you get due to over-pitching or rolling
makes you sit at the edge of your seat.

The Huey’s gun is hardly accu-
rate—it seems like something that’s
meant for random destruction.
Another grouse is its manual that
actually belongs to another game
in the Search And Rescue series—
Coastal Heroes. An AI pilot was also
sorely missed, as you need one to
fly the chopper if you decide to
man the gun if hostilities arise.

Graphics are poor. Mountains,
plateaus and even water seem
developed for a TNT-based system.
All said and done, this game is
good value for money, as it’ll take
at least a month to complete all

the missions. It’s loaded with around
100 missions, which is enough to make
the gamer clock enough flying time to
try the real Huey if the chance ever
comes by.

Genre: Simulation n Developer: InterActive Vision  n Publisher: Global Star Software  n Distributor: Sujata Softech
Phone: (022) 22885096 / 46574 n System requirements: (800 MHz CPU, 64 MB RAM, 1 GB hard disk space, DirectX 8.1, 32 MB 3D accelerator)
Price: Rs 299 n  Web site: http://pc.iavgames.com/vme
Rating: HHHH

Nocturnal missions can be a nightmare. Defeat the
darkness with a flare or two

I
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Photoshop is undoubtedly the most
popular tool for photo editing. If

you’ve seen the power of Photoshop, and
have been impressed by the magic it can
weave, but don’t know how to use it - this
is the book for you. The CD contains over
two hours of video training, as an add-on
to the images and other examples used
throughout the book. You can  get a fair
idea of how things are done in Photoshop
through the video tutorials, even without
reading the book at all.

The book is divided into 12 chapters,
and the CD contains 12 video lessons.
You’re supposed to first go through the
video lesson to get the basics of a chapter,
and then go through the chapter in the
book. The book is primarily meant for
newbies, and so, starts off with basics such
as how to open files, the Photoshop CS

interface, etc. and moves on through inter-
mediate topics to advanced ones. There are
over 600 full-colour photos and illustra-
tions, which make
learning fun, not to
mention the glossy
pages and very attrac-
tive design and layout.

The beauty of the
book lies in the fact that
you’re never lost, having
to look back at a previ-
ous chapter, or having to
look at the index. The
full-colour illustrations
amply augment the text.
There are screenshots of
windows as well, gener-
ously sprinkled across the pages, so help is
always at hand. And there are instructions

on what menu to open, what to click, and
so on, on virtually every page, with refer-
ences to the pictures on the page.

The text and chapters progress
naturally, from easy to advanced. You
can get through the chapter on, for
example, editing and healing, with-
out even knowing at the outset what
editing tools there are in Photoshop
CS. And at the end of the chapter,
you’ll honestly be able to say that you
can modify a photograph with skill.

Coverage of topics is more than
adequate. One niggle for intermediate
users is that the book may seem a little
too detailed, but newbies won’t have

that complaint. At the end, it’s the layout,
illustrations and methodology that make
Adobe Photoshop CS One-on-one a winner.

UPENDRA SINGHAI

Adobe Photoshop CS One-on-one
Beautiful, useful, comprehensive

Publisher: O’Reilly n Author: Deke McClelland n Distributor: Computer Bookshop (India) Pvt. Ltd.
n Phone: 2207 6356/0989/5631, 2207 7922/23/24  n E-mail: cbs@vsnl.com  n Web site: www.oreilly.com n Price: Rs 1,900
Rating: HHHHH

If you’ve already purchased the Red Hat
9 Bible, this book is not for you. The

Red Hat Linux 10 Bible has very lit-
tle to offer over the previous
Red Hat Bible.

That said, the book is a great
buy for anybody else. It does
not assume any prior Linux or
Unix knowledge, and has excel-
lent coverage of topics: the first
section starts off with installa-
tion and then explains simple
day-to-day tasks such as desktop
navigation, using the various
multimedia and simple net-
working features available in
Red Hat. The chapter on Linux
commands covers all the ones used com-
monly to speed up regular Linux usage.

The second segment is devoted to
Linux system administration and does a
good job at explaining such aspects as

controlling access by con-
figuring users, automating
and scheduling system
tasks. There’s also a chapter
comprising useful tips on
backup and restore. Apart
from a detailed explanation
of all the available tools, this
chapter also explains the
nuances of automating your
backups. Also included is a
section on backing up to DVD

drives using the ‘dvdrecord’
command line tool. However, it’s disap-
pointing to find no detail about configu-
ration issues with the tool.

Finally, the advanced section is for
those interested in setting up servers and
LANs using Red Hat Linux. It explains the
setting up of every form of server—be it
mail, Web or news. A small section on
wireless LAN setups is provided in the
chapter on LANs. This will be enough to
understand various issues involved in set-
ting up these servers and possibly help
you set-up a basic running server, but
they are in no way complete references
that will make you a guru of professional
server setups.

In all, if you need something that will
not only help you come to grips with
Red Hat, but also help you out with
advanced configuration issues, this is the
book for you.

PRAVEEN KURUP

Publisher: Wiley  n Author: Christopher Negus n Distributor: Wiley-Dreamtech India Pvt Ltd n Phone: 91-11-23260877
Fax: 91-11-23275895 n E-mail: wdt@vsnl.net n Web site: www.wileydreamtech.com   n Price: Rs 529
Rating: HHHHI

Red Hat Linux ver. (10) Bible
Need we say more…
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Saurabh ‘CD’ Kumar was sitting around
office one boring Wednesday evening,
waiting for the CD design team to fin-

ish their late tea-break, when he was struck
by a brilliant idea for an April Fools’ prank.
He dashed off to find Mexy ‘Flash’ Xavier,
and lay out his plan. Since no one seems to
go home on time here, he ended up with

three additional supporters—Prashant
‘Brandy’ Narekuli (Brand Manager, Digit)
Sachin ‘Deep Pockets’ Kalbag (Features Edi-
tor), and Gautami ‘Loudspeaker’ Chalke
(Test Centre). 

The next day, six eager ‘models’ from
within the company ranks were informed
of a photo shoot for the Digit Forum.

Early in the evening, the chosen six were
hustled out of their work places; the
women were dressed in saris and the men
in odd-fitting suits, and told to assemble
at the main entrance. The following is the
sequence of events that transpired.

Where April Fools Dare
An idle mind is indeed the devil’s workshop;

six Digit employees found out the hard way...on April 1

Time: 5:32 PM 
Scene: Depicting the various users on the
forum. Don’t miss Srinivasan trying to look
imposing, Garfield attempting to look
suave, and the ladies looking as elegant as
ever. As for Siddharth, he’s just being jolly!

Time: 5:32 pm
Scene: Help is always available on the forum
—sometimes it’s even forced upon you

Time: 5:36 PM
Scene: Take that! Don’t forget to wear your
helmets, lest you meet these women on the
street (The models were asked to depict the
verbal duels that the forum is famous for)

Here are the three pranksters
directing the models, serious
and professional to the core—
with scripts and everything. It
must have been really hard to
keep a straight face
(Left to right: Saurabh, Rohi-
ni, Gautami and Mexy)

“You call that a pose?; stop
chewing your hair; no, the
lollipop doesn’t go in your
nose; …”
All said and done, the
‘models’ took it sportingly,
in true Digit tradition. Who
said geeks live boring lives?

BEHIND THE SCENES
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a. Small-C 
b. Java 
c. The D language 
d. The C language

EGA stands for Enhanced
Graphics Adapter. What does
VGA stand for?
a. Video Graphics Adapter
b. Video Graphics Array
c. Visual GAmut 
d. Visual Graphical Appliance

What is the colour system
used by computer monitors?
a. HSV b. RGB 
c. CMYK d. CYAN

The Creative Audigy 2
sound card is plated with a
metal, a matchbox-size piece of
which could be flattened to the
size of a tennis court. What

metal are we talking about?
a. Gold b. Silver
c. Titanium d. Platinum

In July 1993, a fire
destroyed a Sumitomo 
Chemical Company plant in
Japan. How did this event affect
the computer industry?
a. Millions of ultra-high density
floppy disks, scheduled to debut
the next month, were destroyed.
Because of the delay, the format
never gained wide acceptance.
b.Memory prices skyrocketed
because a chemical called Cresol
was destroyed, which made up
60 per cent of the world’s supply
of memory casings.
c. Hard drives over 1 gigabyte
became scarce for several
months.
d. Updates to the v.34 modem
protocol were delayed by more
than a year.

Photoshop 8.0 is one of the
most popular image editing
applications around, and is
used for all kinds of purposes.
What is the code name of this
application?
a. Taconite
b. Dark Matter
c. ImageWiz
d. SwishSwash

How many
colours does a
monochrome 
monitor display? 
a. 256 b. 2
c. 1 d. 3

Calls on a mobile can now
be made at rates of less than a
rupee, but when commercial
telephone service was intro-
duced between New York and
London in 1927, about how
much did the first three minutes
of a call cost, in today’s rupees?
a. Around Rs. 4,000
b. Around Rs. 2,500
c. Around Rs. 1,000
d. Around Rs. 40,000

Global fast food giant
McDonald’s is now offering a
new item on its menu, aimed at
technology enthusiasts. What
McProduct is now being
offered for US$ 2.95?
a. Softserv Medium with 2 CDs
full of custom music
b. Combo Pack with a technology
newspaper
c. Wi-fi connectivity for two hours
d. Discounted Dell PCs

Atari designed a computer
to rival the Macintosh. 
The computer offered a 16-bit
microprocessor, a MIDI 
interface, high resolution and
more. What was the computer
called?
a. Commodore 64
b. Commodore Amiga
c. Atari 130XE 
d. Jackintosh
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This month’s theme: 
Personalities

Across
1. Creator of VisiCalc, the first

personal computer
spreadsheet

2. One of the fathers of the
concept of Object Oriented
Programming. Also, conceiver
of the laptop computer and
architect of the modern
windowing GUI

4. Created the revolutionary
Analytical Engine

6. Helped create phenomenal
products such as the iMac, Mac OS
X, iTunes, the Macintosh, and so on

7. The first female programmer

Down
1. Made operating systems easy to 

use for the average user
3.  The first person to interface a disk

system to a microcomputer and
create an operating system for it

5. Coined the term ‘Cyberspace’

n qubit

Dennis Ritchie created it in 1972, and Brian Kernighan popularised
it. Today, it is the root of some of  the most powerful and popular
programing languages. What are we talking about?

MAY 2004160

To crack a code encrypted 
with a 200-bit number, the
fastest computer of today
would taken more than 5 billion
years—as long as the age of the
universe

did you know

Got an interesting question? Send
it in with the correct answer to  
quiz@thinkdigit.com

numberette

Powered by

Nerve impulses to and from

the brain travel as fast as

274 Kilometres per hour

1 to 5 Way to go...

6 to 10 Good, if you like
being mediocre 

11to15 Your next job could
be with us!

QUOTIENT

Answers

Micheal Robertson of San Diego
based company recently announced
the release of Linspire, the new name
of their current product, changed
due to legal problems with Microsoft.
What was it originally called?

3

a. ELX c. KDE 
b. Knoppix d. Lindows

Dennis Ritchie
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